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本使用说明书的标记

i

本书中使用了如下的记号及标记方法进行说明。

 使用上的注意事项 : 表示在使用时敬请注意的事项。

 参 考 : 表示知道该项内容后易于理解。

: 表示参考的项目及页码。

①②③ :  表示操作的顺序或对图等进行相应说明的部分。

>> :  表示操作的结果及操作后机器的状态。

[Online]、[XX] : 表示 PC 画面上的窗口名称、菜单、按钮。

[Ctrl] ＋ [N] 键 :  表示 PC 键盘的键。

表示在按 [Ctrl] 键的同时，按 [N] 键。

请确认

您购买的 SLP-NX 构成如下。

产品开箱时，请确认以下事项。

1. 检查型号以确认与您订购的产品无差错

2. 检查外观确认产品有无破损

3. 检查附属品是否具全

附属品如下。

开箱后请注意不要遗失及损坏附属品。

万一有差错或异常时，请立即与销售店联系。

产品名称 型号 资料编号 数量 内　容

智能编程软件包
SLP-NX 安装 CD

— 2 日语版以及英语版

专用电缆 — 1 仅 SLP-NX-J70 或 SLP-NXJ70PRO
安装指南 CP-UM-5559JE 1 请在安装前阅读

使用说明书 CP-UM-5636 以 PDF 文件格式存放在 SLP-NX 安
装 CD 中 

软件使用许可协议
用户登记卡

CP-UM-5603JE 1 请在同意使用许可协议的内容后安
装本软件，安装结束后，在用户登
记卡上填写必要事项，并立即将此
卡返送回本公司。

 

安装指南
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本使用说明书的定位

计装网络模块NX相关的使用说明书共有12冊。请根据需要阅读相应的使用说明书。

如果您手中无相关的使用说明书时，请向本公司或代理店索取。

计装网络模块NX　调节器模块 NX-D15/25/35　设置篇

 资料编号CP-UM-5561JE
与NX-D15/25/35同包装。
请使用NX-D15/25/35进行装置的设计、制作的担当者务必阅读。本书对使
用NX-D15/25/35时的安全注意事项、安装、接线、主要规格进行说明。

计装网络模块NX　通讯BOX NX-CB1　设置篇

 资料编号CP-UM-5558JE
与NX-CB1同包装。
请使用NX-CB1进行装置的设计、制作的担当者务必阅读。本书对使用NX-CB1
时的安全注意事项、安装、接线、主要规格进行说明。

计装网络模块NX　数字输入 /脉冲输入模块NX-DX1/DX2　设置篇
 资料编号CP-UM-5560JE
与NX-DX1/DX2同包装。
请使用NX-DX1/DX2 进行装置的设计、制作的担当者务必阅读。本书对使
用NX-DX1/DX2时的安全注意事项、安装、接线、主要规格进行说明。

计装网络模块NX　管理员模块NX-S11/12/21使用说明书　设置篇
 资料编号CP-UM-5557JE
与NX-S11/12/21同包装。
请使用NX-S11/12/21进行装置设计、制作的担当者务必阅读。本书对使用
NX-S11/12/21时的安全注意事项、安装、接线、主要规格进行说明。

计装网络模块NX　数字输出模块NX-DY1/2　设置篇
 资料编号CP-UM-5564JE
与NX-DY1/2同包装。

请使用NX-DY1/2进行装置设计、制作的担当者务必阅读。本书对使用NX-DY1/2
时的安全注意事项、安装、接线、主要规格进行说明。

计装网络模块NX　调节器模块 NX-D15/25/35　功能说明篇
 资料编号CP-SP-1308C
初次使用NX-D15/25/35的人员、把NX-D15/25/35用于控制盘等的硬件设计
人员、维护人员务必阅读。
本书对产品的概略、与NX-D15/25/35能组合使用的产品群中的机种的概要、
为了安装在装置中所必要的设置、接线方法、维护检查、故障时的对应、硬
件的规格等进行说明。
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计装网络模块NX　数字输入／脉冲输入模块NX-DX1/DX2　功能说明篇
 资料编号CP-SP-1323C
初次使用NX-DX1/DX2的人员、把NX-DX1/DX2用于控制盘等的硬件设计人
员、维护人员务必阅读。
本书对产品的概略、与NX-DX1/DX2能组合使用的产品群中的机种的概要、
为了安装在装置中所必要的设置、接线方法、维护检查、故障时的对应、硬
件的规格等进行说明。

计装网络模块 NX 　管理员模块NX-S11/12/21　功能说明篇
 资料编号CP-SP-1324C
初次使用NX-S11/12/21的人员、把NX-S11/12/21用于控制盘等的硬件设计
人员、维护人员务必阅读。
本书对产品的概略、与NX-S11/12/21能组合使用的产品群中的机种的概要、
为了安装在装置中所必要的设置、接线方法、维护检查、故障时的对应、硬
件的规格等进行说明。

计装网络模块 NX　数字输出模块NX-DY1/2　功能说明篇
 资料编号CP-SP-1345C
初次使用NX-DY1/2的人员、把NX-DY1/2用于控制盘等的硬件设计人员、
维护人员务必阅读。
本书对产品的概略、与NX-DY1/2能组合使用的产品群中的机种的概要、为
了安装在装置中所必要的设置、接线方法、维护检查、故障时的对应、硬件
的规格等进行说明。

计装网络模块 NX　网络设计篇
 资料编号CP-SP-1313C

请计装网络模块NX的各模块的网络设计者务必阅读。
用连接例对网络的设计方法进行说明。

计装网络模块 NX　智能编程软件包SLP-NX　安装指南
 资料编号CP-UM-5559JE

与智能编程软件包SLP-NX同包装。
对安装到PC中的方法进行说明。

计装网络模块 NX　智能编程软件包SLP-NX
 资料编号CP-UM-5636C

本书
对使用了计装网络模块NX各种模块的装置的设计、设定人员务必阅读。
本书是使用PC对计装网络模块NX的各种模块进行设定的软件的说明书。
对向PC中的安装方法、PC的操作、各种功能及设定方法进行说明。
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本使用说明书的构成

本使用说明书的构成如下。

第1章 前　言

使用本编程器前请阅读本章。

本章对运行时必要的 PC 等环境、功能概要以及安装方法进行了说明。

第2章 编程器的启动、关闭

本编程器的启动、关闭方法的说明。

第3章 编程器的窗口构成

本编程器的窗口构成及其功能的说明。

第4章 作业流程

设定参数让模块正常运行的作业步骤的说明。

第5章 实际模块通讯设定

模块通讯时必要的地址设定、通讯设定的说明。

第6章 参数的设定

模块正常运行的参数设定等相关操作方法的说明。

第7章 综合监视

设定变更的操作方法、运行状态等监视画面相关的说明。

第8章 PID仿真

调整 PID 值用的支持软件 「PID 仿真器」的说明及对调整 PID 值的方法的说

明。

第9章 使用上的限制事项及注意事项

使用上的限制事项及注意事项的说明。

附 录 用语解说、ROM版本履历



v

目　录

本使用说明书的标记
请确认
本使用说明书的定位
本使用说明书的构成

第 1 章 前　言

1 - 1 概　要 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-1
■ 编程器的功能 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-1

1 - 2 正常运行时必备的系统环境 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-2
■ 系统环境 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-2
■ 与模块的连接 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-3

1 - 3 编程器的安装 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-4
■ 编程器的安装步骤 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••1-4

1 - 4 USB编程器电缆设备驱动程序的安装  •••••••••••••••••••••••••••••••••••••••••••••••••• 1-12
■ 设备驱动程序的安装 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 1-12
■ 设备驱动程序的卸载 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 1-16

1 - 5 USB密码狗的驱动程序的安装 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 1-17
■ 设备驱动程序的安装 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 1-17
■ 设备驱动程序的卸载 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 1-20

第 2 章 编程器的启动、关闭

2 - 1 编程器的启动 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••2-1
2 - 2 编程器的关闭 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••2-3

第 3 章 编程器的窗口构成

3 - 1 窗口构成和功能 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••3-1
■ 编程器的窗口构成和功能 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••3-1
■ 项目窗口的构成 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••3-2
■ 项目树结构•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••3-3
■ 项目窗口的菜单构成一览 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••3-9
■ 工具栏 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 3-10
■ 版本信息 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 3-11

第 4 章 作业流程

4 - 1 基本作业 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••4-1
4 - 2 使用模块存在时 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••4-2
4 - 3 使用模块不存在时 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••4-3
4 - 4 模块构成变更时 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••4-4



vi

第 5 章 实际模块通讯设定

5 - 1 实际模块构成窗口的显示 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-1
■ 启动实际模块构成窗口时 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-1
■ 实际模块构成窗口的显示 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-2
■ 实际模块构成窗口的菜单构成一览 ••••••••••••••••••••••••••••••••••••••••••••••••••••5-3
■ 工具栏 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-4
■ 实际模块构成树结构 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-4

5 - 2 IP地址以及节点地址的定义 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-7
■ 步　骤 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••5-7

5 - 3 通讯设定 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-12
■ 设定步骤 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-13

5 - 4 模块的LED灯亮 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-15
5 - 5 工作组映射的确认 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-16

■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-16
■ 信息一览 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-16
■ 典型的确认方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-22

5 - 6 其　他 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-29
■ 通讯路由 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-29
■ 网络配置 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-31
■ 通讯可选项••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 5-37

第 6 章 参数的设定

6 - 1 项目的制作 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••6-1
■ 概　要 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••6-1
■ 选择 「Single module configuration」 制作项目 ••••••••••••••••••••••••••••••••••••••6-2
■ 选择 「Multiple module configuration」 制作项目 ••••••••••••••••••••••••••••••••••••6-4
■ 选择 「Automatic configuration from actual module」 制作项目 ••••••••••••••••••6-6

6 - 2 模块构成的定义 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-11
■ 模块的追加••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-12
■ 删　除 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-14
■ 编　辑 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-14
■ 型号设定 ( 模块型号详细信息的确认、变更 ) ••••••••••••••••••••••••••••••••••••• 6-14
■ 初始化 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-15

6 - 3 参数的编辑 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-16
■ 显示级别 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-19
■ 复　制 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-20
■ 粘　贴 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-20
■ 编　辑 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-20
■ 模块间数据传送功能的设定 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-21
■ 模块间数据传送一览的显示 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-30
■ 逻辑运算窗口的显示 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-35
■ 折线图窗口的显示 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-36
■ 设定多回路协调控制的方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-37
■ 数据检查 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-38



vii

6 - 4 映　射 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-39
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-39
■ 映射的制作••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-39
■ 映射信息的编辑  •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-40
■ 通讯设定的编辑、管理 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-41
■ 用编辑的映射信息与实际模块的对应  •••••••••••••••••••••••••••••••••••••••••••••• 6-44

6 - 5 参数的写入 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-47
■ 工作组总括写入 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-47
■ 单一模块的写入 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-49

6 - 6 模块动作的监视 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-52
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-52
■ 操作方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-52

6 - 7 参数的读出 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-57
■ 概　要  ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-57
■ 工作组总括读出 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-57
■ 从单一模块读出 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-59

6 - 8 模块版本的管理 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-60
■ 模块版本照合 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-64
■ [Change version] 对话框 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-64

6 - 9 项目的保存 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-66
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-66
■ 操作方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-66

6 -10 打开项目 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-68
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-68
■ 操作方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-68

6 - 11 输出CSV文件 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-70
■ 概　要  ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-70
■ 操作方法  ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 6-70

第 7 章 综合监视

7 - 1 监视功能概要 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-1
■ 综合监视的流程 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-1

7 - 2 综合监视的启动 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-2
7 - 3 综合监视窗口 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-3

■ 菜单构成一览 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-4
■ 窗口构成的操作 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-6

7 - 4 监视的开始、停止 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-7
■ 开始监视 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-7
■ 停止监视 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-7

7 - 5 个别窗口的说明 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-9
■ 监视树窗口•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••7-9
■ 数值监视窗口 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-12
■ 趋势监视窗口 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-16
■ 趋势组窗口••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-20
■ 十字线数据窗口 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-23
■ 位显示监视窗口 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-24



viii

■ 逻辑运算监视窗口 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-25
■ 报警监视窗口 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-25
■ 状态栏 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-26
■ 版本信息 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-27

7 - 6 各种设定 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-28
■ 通讯目标 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-28
■ 监视设定 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-28
■ 趋势监视色设定 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-30
■ 选项 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-31
■ 其它的设定••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-32

7 - 7 用户监视 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-33
■ 用户监视编辑对话框 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-33
■ 数据选择对话框 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-37
■ 趋势列登录对话框 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-39

7 - 8 趋势备忘录 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-40
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-40
■ 登录趋势备忘录 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-40
■ 显示趋势备忘录 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-40
■ PID 参数的变更履历 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-41

7 - 9 离　线 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-42
■ 离线的概要••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-42
■ 日志文件转换 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-43
■ 综合监视离线窗口的显示 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-44
■ 各窗口的停驻功能 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-45
■ 状态栏 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-45
■ 综合监视离线窗口的菜单构成一览 •••••••••••••••••••••••••••••••••••••••••••••••••• 7-46
■ 读出趋势日志 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-47
■ 数值监视的显示 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-47
■ 监视设定对话框 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-48
■ 趋势组的显示 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-49
■ 位显示监视的显示 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-50
■ 十字线数据的显示 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 7-50

第 8 章 PID仿真器

8 - 1 PID仿真器的概要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-1
■ 特　长 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-1
■ 用 PID 仿真器进行调整的步骤 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-3

8 - 2 PID仿真器的启动 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-4
■ 启动画面 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-5

8 - 3 PID仿真器的画面 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-6
■ 菜单栏及工具栏 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-6
■ 仿真曲线的功能 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••8-8
■ PID 滑块 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-10
■ 参数选项卡••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-11

8 - 4 方便的功能 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-13
■ 自整定 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-13



ix

■ 备忘录 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-13
■ 仿真曲线的设定 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-15
■ 参数读出 / 写入 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-17

8 - 5 控制对象模型创建 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-18
■ 模型创建向导 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-18

8 - 6 趋势数据的收集方法 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-23
■ 概　要 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-23
■ 步骤 1　决定初始过程值及设定值••••••••••••••••••••••••••••••••••••••••••••••••••• 8-24
■ 步骤 2　使过程值、操作量稳定 ••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-25
■ 步骤 3　开始趋势数据收集 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-27
■ 步骤 4　开始步应答 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-28
■ 步骤 5　结束趋势数据收集 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-29
■ 步骤 6　保存收集的趋势数据 •••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-30
■ 步骤的归纳••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-31

8 - 7 错误信息 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-32
■ PID 控制仿真错误信息 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-32
■ 数据文件错误 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 8-32

第 9 章 使用上的限制事项及注意事项

■ PC 的电源管理 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-1
■ 红外线设备•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-1
■ 实际模块构成扫描使用时的限制 •••••••••••••••••••••••••••••••••••••••••••••••••••••••9-1
■ 实际模块构成扫描使用时的限制 (IP 地址 ) ••••••••••••••••••••••••••••••••••••••••••9-1
■ Windows 防火墙 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-1
■ 字体 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-1
■ 禁止使用压缩文件夹 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-2
■ 限制数一览•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-2
■ 禁止停止 SQL Server 的服务 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-3
■ 故障状态的模块在综合监视下的监视 •••••••••••••••••••••••••••••••••••••••••••••••••9-3
■ 与防病毒软件的并存 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-3
■ 串连接的环形通讯用通讯 BOX •••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-3
■ 使用保存的项目的实际模块通讯设定时的写入错误 ••••••••••••••••••••••••••••••••9-3
■ 在 PC 中存在多个具有管理者权限的用户 ID 的场合 •••••••••••••••••••••••••••••••9-4
■ PC 中存在多个同一类型的网络接口卡的场合 •••••••••••••••••••••••••••••••••••••••9-4
■ SLP-NX 启动中禁止网络设定变更 ••••••••••••••••••••••••••••••••••••••••••••••••••••9-4
■ 禁止向 SLP-NX 日志文件夹制作文件 •••••••••••••••••••••••••••••••••••••••••••••••••9-4
■ 安装目标文件夹的访问权 •••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-4
■ 模块间数据传送功能或多回路协调控制使用中变更模块的 IP 地址等 •••••••••••9-4
■ 模块更换等时的注意点 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-5
■ 综合监视的小数点位置 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-5
■ 多回路协调控制使用的调节器模块的回路数变更 •••••••••••••••••••••••••••••••••••9-5
■ 默认网关的设定相关的注意事项 •••••••••••••••••••••••••••••••••••••••••••••••••••••••9-5
■ 与网络切换软件的共享 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-6
■ Windows 7 的文字大小的设定相关的注意事项 •••••••••••••••••••••••••••••••••••••9-6



x

■ 有关使用多根 USB 编程器电缆 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••9-6
■ 专业版 (PID 仿真器 ) 安装在同一 PC 中 ••••••••••••••••••••••••••••••••••••••••••••••9-6

附　录

附 - 1 用语解说 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••附 -1
附 - 2 ROM版本履历•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••附 -2
附 - 3 模块版本与编程器的支持 ••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••附 -3



1-1

第 1 章 前　言
1 - 1 概　要

智能编程软件包SLP-NX(以下章节中简称为编程器 )是NX系列各种模块 (以下章节中简称为本机或者模块 )
的设定、运行状态监视用软件。

■ 编程器的功能

通过编程器，经由以太网或者连接到编程器插口，可以对模块进行以下主要

的操作。

•  IP 地址等通讯设定的确认、设定 
( 个别或者总括模块。对模块的总括操作只能经由以太网 )

•  参数的读出、写入 
( 个别或者总括模块。对模块的总括操作只能经由以太网 )

•  在线数据 (Online Data) 的监视、参数的变更、数据采集 
( 个别或者总括模块。对模块的总括操作只能经由以太网 )
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1 - 2 正常运行时必备的系统环境

使用编程器时必须具备以下的系统环境。

■ 系统环境

项　目 内　容

硬件 对象机器 具有Pentium以上CPU的PC/AT兼容机 
推荐：1.5GHz以上的Core2、最小 ：1GHz

操作系统 英语版 Windows XP SP3　32位版  注 )Home Edition除外
英语版 Windows 7 Professional/HomePremium 32/64位版SP1

内存 Windows XP 推荐 : 1.5GB以上、最小 : 512MB以上
Windows 7 推荐 : 4GB以上、最小 : 2GB以上

硬盘 Windows XP  推荐 : 40GB以上的空余容量、 
最小 : 20GB以上的空余容量

Windows 7  推荐 : 60GB以上的空余容量、 
最小 : 40GB以上的空余容量

显示 推荐1024×768像素以上、16位彩色以上

CD-ROM驱动器 1个驱动器

以太网端口 1个端口以上
(以太网电缆与各种NX模块连接的场合 )
注 ) USB以太网适配器除外

USB端口 1端口以上 (使用专用电缆连接NX各种模块时以及使用PID仿真时分
别需要1个端口 )
注 ) 对象只能是USB编程器电缆

定位设备 Windows对应的鼠标或者与鼠标同等的设备

其他 .NET  Framework 3.5 SP1
Windows Installer 4.5
SQL Server 2008 Express SP3*
注 ) 根据需要安装上述软件

 使用上的注意事项

• *   本编程器使用SQL Server 2008 Express，请卸载已安装的SQL Server 
2005或者SQL Server 2008 R2。  
如果安装了SQL Server 2005或者SQL Server 2008 R2，则不能保证编程

器正常运行。

另外，当存在使用SQL Server 2005或者SQL Server 2008 R2的应用软件

时，请向应用软件厂商咨询此应用软件可否在SQL Server 2008 Express
下正常运行。

另外，与SQL Server 2000等旧版本数据库管理系统软件共存时，SQL 
Server 2008 Express可能会出现运行不良的状况，请准备另外的PC。

•  请务必确认 [Control Panel] → [Regional Settings] → [Number] → [Decimal 
symbol]设定为 「.」 （半角小数点）。设定为其它文字时，SLP-NX将不能正

常动作。

例  
Windows XP的场合是 [Control Panel] → [Regional and Language Options] 
→ [Regional Options] → [Customize...] → [Decimal symbol]。Windows 7的
场合是 [Control Panel] → [Clock, Language, and Region] → [Region and 
Language]的 [Formats]选项卡上的 [Additional settings...] → [Decimal 
symbol]。
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■ 与模块的连接

 使用上的注意事项
• 多个SLP-NX不能同时连接到同一模块。

● 使用专用电缆连接

这种连接方法只限于由单一模块构成的项目。

 使用上的注意事项
•  使用管理员模块进行多回路协调控制时，由于同时执行多个模块的设

定，请勿使用这种连接方法。

● 经由以太网连接1　经由通讯适配器连接

 使用上的注意事项
• 这种连接方法只限于非环形通讯模块。

● 经由以太网连接2　经由通讯BOX连接

 使用上的注意事项
•  可以采用环形通讯、非环形通讯中任意一种方式连接，但是所有模块

请设定为相同类型。

• 在PC和通讯BOX之间可插入通用交换机进行连接。

•  以太网电缆请使用UTP电缆 (4P) Cat5e以上 (直连线 )(ANSI/TIA/EIA-
568-B)。

 参 考
• 有关详细内容请参阅

计装网络模块NX 使用说明书「网络设计篇」　CP-SP-1313C　2-5　与外部

设备的构成　■　SLP-NX。
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运行编程器的
     计算机

通讯适配器

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

C
A

本机
(所有模块都是
相同连接类型)

以太网电缆

运行编程器的
     计算机

通讯box

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK

NST

4321

PWR RUN MODCOM NST FAIL

LINK
/ ACT

NX-CB1N

4

3

2

1

NX-D25N

PWR RUN MODCOM NST FAIL

1ーP Vー 4 F0

F1 F9F5

1ーO Pー4

LOCK
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1 - 3 编程器的安装

请把编程器安装到 PC 的硬盘中。

安装完成后，请妥善保存 SLP-NX 安装 CD 以备用。

本章节对编程器安装到 PC 的方法进行说明。

以下画面及说明都是以 PC 的操作系统是 Windows XP 为例。

 使用上的注意事项
•  此CD-ROM中不包含PC的操作系统，不能在没有安装操作系统的PC上使

用。

•  安装SLP-NX时需要PC的管理员权限。请由Administrator执行或

Administrators组所属的用户执行。还需要在 「Local Security Policy」 的
「Debug programs」 策略中分配Administrators。(Windows默认是在 
「Debug programs」 策略中分配Administrators)

•  其他应用软件运行时，安装程序可能会不能正常运行，一旦发生这种情况，

请关闭其他应用软件后再启动安装程序。

另外，由于其他应用、驱动程序等的组合，编程器可能会不能正常运行。

关于Windows、PC的设定，请分别参阅Windows、PC附带的使用说明书。

• 编程器使用Microsoft SQL Server 2008 Express数据库管理系统软件。

PC中已经安装了Microsoft SQL Server 2005或者SQL Server 2008 R2等
Microsoft公司的SQL Server时，请将其卸载后安装编程器。

■ 编程器的安装步骤

● 开始安装

① 插入SLP-NX安装CD到PC的CD-ROM驱动器中，使用资源管理器打开。
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② -1 双击 [Setup.exe] 文件。

启动编程器的安装程序，显示版权页画面。

② -2 然后开始安装准备。

编程器必备软件已经安装时

切换到●编程器的安装　⑤ -1。
没有安装时

切换到●编程器正常运行必备软件的安装　③ -1。

● 编程器正常运行必备软件的安装

③ -1 安装准备完成后，显示编程器正常运行必备软件清单。

点击 [Install] 按钮。

③ -2 开始安装编程器正常运行必备软件。
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④ -1 安装操作中要求重新启动 PC 时，显示下面其中一种画面。

• 显示上面第 1 幅画面时请点击 [Yes] 按钮，重新启动 PC。

•  显示上面第 2 幅画面时请选择 [Yes，I want to restart my computer now.]，
点击 [OK] 按钮，重新启动 PC。

④ -2 重新启动后，编程器正常运行必备软件的安装没有结束时继续安装。

④ -3 点击 [Install] 按钮。

已安装 SLP-NX Ver.1.00.0 时切换到④ -4。
没有安装时，切换到⑤ -1。

④ -4 显示以下画面。

点击 [OK] 按钮。

第 1 章　前　言
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④ -5 卸载 WinPcap 时，点击 [Uninstall] 按钮。

≫开始卸载 WinPcap。

不卸载 WinPcap 时，请点击 [Cancel] 按钮继续⑤ -1 操作。

④ -6 WinPcap 卸载结束后，显示以下画面。

④ -7 点击 [Finish] 按钮。

≫ WinPcap 卸载完成。

● 编程器的安装

⑤ -1 安装准备及编程器正常运行必备软件安装结束后，显示编程器的安装启

动画面。
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⑤ -2 点击 [Next] 按钮。

≫显示以下画面。

⑤ -3  同意软件使用权许可协议的所有项目，安装编程器时点击 [Yes] 按钮。 
≫显示以下画面。

是否变更安装地点的场合的操作方法不同。

 不需变更安装地点的场合，请进入⑥ -1。
 需要变更安装地点的场合，请进入⑦ -1。
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< 不改变安装路径 >
⑥ -1 选择 [Complete]，点击 [Next] 按钮。

≫显示以下画面。

继续⑧ -1 操作。

< 改变安装路径 >
⑦ -1 选择 [Custom]，点击 [Next] 按钮。

≫显示以下画面。

⑦ -2 点击 [Change…]([ 更改目录 ]) 按钮指定安装目录，点击 [OK] 按钮。

 使用上的注意事项
• 指定安装目录中制作SLP-NX子目录。

• 不能把安装目录指定为桌面以及 [My Documents]等。
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⑦ -3 点击 [Next]按钮。

≫显示以下画面。

⑧ -1 点击 [Install]([安装 ])按钮。

≫开始安装编程器。
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≫显示安装完成画面。

 参 考
• PC中已经安装了SLP-NX Ver.1.00.0E的环境下，可能会显示以下

画面。

⑨ 点击 [Finish]([完成 ]按钮。

≫安装完成。
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1 - 4 USB 编程器电缆设备驱动程序的安装 
使用 USB 编程器电缆时必须安装设备驱动程序。

请按照以下步骤在 PC 上安装设备驱动程序。

■ 设备驱动程序的安装

 使用上的注意事项

•   请务必按照下面说明的步骤安装设备驱动程序。 
如果采用不同的安装步骤，可能会出现不能识别USB编程器电缆的情况。 
不能识别时请将其卸载，然后重新安装。

•   安装设备驱动程序时请务必将所使用的PC设定为管理员权限，使用

Administrator或属于Administrators组的用户。

USB编程器电缆对应Windows XP(32位版 )、Windows 7(32位版、64位版 )。

•   存在多个USB端口时，每次请把USB编程器电缆连接到相同端口，如果要

连接到其他端口，可能会要求重新安装驱动程序。

1. 安装 USB 编程器电缆驱动程序

≫ 使用资源管理器打开编程器安装目标的 USBLoaderCable 文件夹。

不改变安装路径时，安装路径为以下路径

  Windows XP、Windows 7 32 位版的场合 
C: ＼ Program Files ＼ SLP ＼ SLP-NX ＼ Drivers ＼ USBLoaderCable
  Windows 7 64 位版的场合 

C:＼Program Files(x86) ＼SLP＼SLP-NX＼Drivers＼USBLoaderCable。

①   Windows XP 的场合双击 [drvsetup.exe] 文件。 
Windows 7 32 位版的场合，右键点击 [drvsetup.exe] 时选择菜单的 [Run 
as administrator]。
Windows 7 64位版的场合，右键点击 [drvsetup64.exe]时选择菜单的 [Run 
as administrator]。
≫显示以下画面。
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 使用上的注意事项
• Windows 7显示以下画面的场合，请点击 [Install] 按钮。

② 点击 [Next>] 按钮。

≫显示以下画面。

③  同意软件使用权许可协议，安装时选择 [AGREE]，点击 [Next>] 按钮。

≫显示以下画面。

以下警告画面有不显示的情况。
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④ 点击 [Continue Anyway]([ 继续安装 ]) 按钮。

≫开始安装设备驱动程序，结束时显示以下画面。

⑤ 点击 [Finish]([ 完成 ]) 按钮完成安装操作。

2. 连接 USB 编程器电缆到 USB 端口

≫ �Windows 识别 USB 编程器电缆时，任务系统托盘处显示如下信息，并显

示驱动程序安装向导。

3. 安装设备驱动程序

①  Windows 识别到 USB 编程器电缆时显示以下窗口。( 根据 Windows 环境

不同可能会不显示 ) 选择 [No, not this time]，点击 [Next>] 按钮。

②  请选择安装设备驱动程序的检索路径为 [Install the software automatically
(Recommended)] ，点击 [Next>] 按钮。
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≫开始检索设备驱动程序。

≫检索到设备驱动程序时显示以下窗口。

③ 点击 [Continue Anyway] 按钮。

≫开始安装设备驱动程序。

≫设备驱动程序的安装结束时显示以下窗口。
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④ 点击 [Finish] 按钮。

≫�设备驱动程序的安装操作结束时任务系统托盘处显示如下信息，

Windows 正常识别到 USB 编程器电缆。

⑤  打开 [Control Panel] → [System] → [Hardware] → [Device Manager]，
确认 [Ports (COM 和 LPT)] 中 Yamatake USB Loader Comm.port 的编号。

⑥ 启动编程器，从 [Project] 窗口的菜单栏选择 [Online] → [Communications 
Path]，打开 [Communications path] 对话框，选择 [Loader jack]。
点击 [detailed settings]，打开 [Serial Communication] 对话框，按照⑤确

认通讯端口的设定，点击 [OK] 按钮。

■ 设备驱动程序的卸载

 使用上的注意事项
• 卸载后请重新启动PC。在关闭其他应用程序后执行卸载操作。

• 卸载驱动程序时请务必将所使用的PC设定为管理员权限，使用Administrator
或属于Administrators组的用户。

1. 卸载

①   选择 [Control Panel] 的 [Add or Remove Programs「Windows Driver 
Package -Yamatake(YCslp) USB(04/10/2008 2.0.2.8)」] 或点击 [Programs 
and Features] 选择 [Windows Driver Package- Prolific(Ser2pl64)
Ports(11/19/2009 2.0.13.130)]。然后点击 [Change/Remove] 按钮或者

[Uninstall or change a program] 按钮。

② 点击 [Yes] 按钮。

③ 重新启动 PC。
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1 - 5 USB 密码狗的驱动程序的安装

购买专业版的客户使用 PID 仿真器时，需要安装设备驱动程序。

请按以下的步骤在 PC 中安装设备驱动程序。

■ 设备驱动程序的安装

 使用上的注意事项
• 请务必按以下说明的步骤安装设备驱动程序。

步骤错误时，有可能不能识别USB密码狗。

当不能识别时，请重新安装或卸载后重新安装。

• 安装设备驱动程序时，需要具有PC的管理员权限。请使用Administrator 或
Administrators组所属的用户。

USB密码狗与Windows XP(32位版 )、Windows 7(32位版、64位版 )对应。

• 有多个USB端口的场合，请每次把USB密码连接在同以端口上。与别的端

口连接时，有需要重新安装驱动程序的情况。

1. 请安装USB密码狗驱动程序

》  用资源管理器打开编程器的安装目标的 Sentinel 文件夹。

安装目标未变更的场合是 C: ＼ Program Files ＼ SLP ＼ SLP-NX ＼ Drivers ＼

Sentinel。
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①   双击 [Sentinel System Driver Installer 7.5.1.exe]。 
》显示以下画面。

②   点击 [Next >] 按钮。 
》显示以下画面。

③   同意软件使用许可，要安装的场合选择 [I accept the terms in license 
agreement]，请点击 [Next >] 按钮。  
》显示以下画面。
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④   请点击 [Next >] 按钮。 
》显示以下画面。

⑤   请点击 [Install] 按钮。 
》开始安装 USB 密码狗的区段程序。 

 
》安装完成后显示以下的画面。

⑥  点击 [Finish] 按钮并完成安装。
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2. 把USB密码狗连接在USB端口上

》  Windows 识别到 USB 密码狗后，将在任务托盘处显示以下画面，USB 密

码狗可以使用。

■ 设备驱动程序的卸载

 使用上的注意事项
• 卸载后请重新启动PC。请关闭其它的应用程序后在执行卸载。

• 要卸载驱动程序时，需要具有PC的管理员权限。请使用Administrator 或
Administrators组所属的用户。

①  打开控制面板、点击 [Add or Remove Programs] 选择「Sentinel SystemDriver 
Installer 7.5.1」]、点击 [Delete] 按钮。

② 点击 [Yes] 按钮。

③ 请重新启动 PC。
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请选择开始菜单的 [SLP-NX]。
≫启动时显示如下所示 [Project] 窗口。

 使用上的注意事项
• 执行编程器时请务必将所使用的PC设定为管理员权限。使用Administrator

或属于Administrators组的用户。

 参 考
• 备有网络配置功能，实现在编程器启动中暂时变更与本机连接的PC的网络

设定的功能。 
■ 网络配置 (5-31页 ) 或者

■ 选择 「Auto configuration from actual module」 制作项目的④ (6-8页 )，
当已经建立了编程器使用的网络协议的场合，则启动时显示如下所示对话

框。

这种场合，按单选按钮选择 「Original profile」(当前网络设定 )或者编程器

上一次执行时使用的网络配置名称中的一个。

 

第 2 章 编程器的启动、关闭
2 - 1 编程器的启动
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选择了网络配置名称时，通过其网络配置值变更PC的网络设定，启动编

程器。

编程器启动后请按照与■ 网络配置 (5-31页 )相同的步骤变更网络配置。

• 编程器项目编辑中异常结束，再次启动时显示如下信息窗口。 
选择 [Yes]打开项目。

 使用上的注意事项

• 编程器执行中异常结束时，PC保持编程器执行中时的网络设定。 
请再次启动编程器，打开 [Network Profile]窗口，按照■ 网络配置 (5-31
页 )进行处理。

可以返回到上一次编程器启动前的网络设定。



2-3

第 2 章　编程器的启动、关闭

2 - 2 编程器的关闭

关闭编程器时，请选择 [Project] 窗口菜单栏的 [File] → [Exit]。

 参 考
• 使用网络配置功能变更了PC网络设定的场合 ,当关闭编程器时，将返回到

原来的网络设定。



MEMO
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3  -  1 窗口构成和功能

■ 编程器的窗口构成和功能

编程器有下面三种基本窗口。

• [Project] 窗口

• [Actual module configuration] 窗口

• [Universal Monitor] 窗口

以下是各个窗口的说明。

名称 功能 窗口图像

[Project]窗口 系统运行所必要的模块参数设定的
画面
详细内容请参阅

本章　及　第6章 参数的设定

[Actual module configuration]
窗口

模块与模块外部进行基本通讯时必
要设定的画面
关于各个菜单请参阅

5-1 实际模块构成窗口的显示

[Universal Monitor]窗口 模块动作监视画面
可以同时监视多个模块的动作
关于各个菜单请参阅

7-3 综合监视窗口
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■ 项目窗口的构成

● 标题栏

显示已打开的项目名、编程器名称、版本。

● 菜单栏

用于选择、执行各种操作。

可操作内容随着项目树、内容区域的显示内容变化。

● 工具栏

菜单项目中经常使用的操作以按钮形式配置在工具栏中。

● 项目树

用层级结构显示项目管理内容。

点击项目进行选择，内容区域中显示相应的设定画面。

项目树的详细内容在下述章节进行说明

■ 项目树结构　( 下一页 )。

 ●  内容区域 
显示项目树中选择项目的设定画面。

● 状态栏

显示选择参数的上位通讯地址、设定范围等。

状态栏 

标题栏 
菜单栏 
工具栏 

项目树 内容区域
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■ 项目树结构

项目树结构如下。

以下是选择项目树的各个层级时，内容区域的显示内容的说明。

● 项目显示

项目树的顶层是 [Project] 显示。

选择项目树的 [Project] 变为项目显示。

在内容区域进行工作组添加、删除等操作。

• [Project name]
设定项目名称

• [Comments]
定义注释

• [Edit] 按钮

项目树的当前工作组变成选择状态

• [Add] 按钮

添加工作组

• [Delete] 按钮

删除工作组

工作组显示

项目显示

模块构成显示

参数库显示

映射显示

个别映射名显示

3-3页

3-4页

3-7页

3-8页

3-5页

3-6页

 

[编辑]按钮 
[添加]按钮

[删除]按钮

项目名 注释
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 使用上的注意事项

•  项目名、位号名等的文字列中只能输入SHIFT JIS的文字列。 
例如，输入UNICODE等的SHIFT JIS的文字列以外时，CSV输出功

能等会产生乱码。

● 工作组显示

[Project] 显示的下一层是 [Workgroup] 显示。

在 [Workgroup] 显示中定义由一个以上模块构成的处理块。

内容区域的 [Operation list] 中列出了工作组全体对应的下述项目。

• [1:Module definition]
切换到模块构成显示

• [2:Module mapping]
切换到映射显示

• [3:Parameter writing]
把参数总括写入模块

• [4:Monitor]
启动综合监视

• [5:Parameter reading]
从模块总括读出参数

每个工作组可以定义 [Workgroup name]、[Comments]。

工作组名 注释 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

作业一览 
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● 模块构成显示

[Workgroup] 显示的下一层是 [Module configuration] 显示和 [Mapping] 显示。

项目树是 [Module configuration] 显示时，可以在内容区域进行工作组所属模

块的构成定义。

实际模块存在时，在 [Create new project] 中选择 [Automatic configuration 
from actualmodule]，无须手动进行模块定义操作，可以自动定义模块构成。

在 [Module configuration] 显示中可以进行以下设定。

• [Add] 按钮

添加模块

• [Add a copy] 按钮

使用已定义的模块参数设定内容，添加模块

• [Delete] 按钮

删除模块

• [ ↑ ] 按钮

将选择模块的定义顺序上移一位

• [ ↓ ] 按钮

将选择模块的定义顺序下移一位

• [Edit] 按钮

切换到项目树中选择模块的 [Parameter Bank] 显示

• [Set model number] 按钮

显示选择模块的 [Module model number setting] 对话框

• [Initialize] 按钮

将选择模块的参数内容还原为初始值

• [Type]
定义模块类型 ( 模块代表型号 )

• [Name]
定义模块名称

• [Model number]
手动输入模块型号

[添加]按钮 
[添加复制]按钮 
[删除]按钮 
[↑]按钮 
[↓]按钮 
[编辑]按钮 
[型号设定]按钮 
[初始化]按钮 

类型 名称  型号 
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● 参数库显示 

[Module configuration] 显示的下一层是 [The Parameter Bank] 显示。

[The Parameter Bank] 显示的项目树结构图上，每个模块具有其类型，按照层级

结构分类。 
关于各参数的含义和动作请参阅各模块的使用说明书。

• [Editor Grid]
在参数库中设定所属参数设定值

编辑格 
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● 映射显示

[Workgroup] 显示的下一层是 [Module configuration] 显示和 [Mapping] 显示。

项目树是 [Mapping] 显示时，可以在内容区域进行以下设定。

• [Add] 按钮

添加工作组所属各个模块到实际模块的映射

• [Delete] 按钮

删除工作组所属各个模块到实际模块的映射

• [Edit] 按钮

切换到选择映射的 [Individual Mapping Name] 显示

• [Set communication] 按钮

进行工作组内所有模块共通的通讯设定或 RS-485 通讯相关的每个模块的

设定

• [ ↑ ] [ ↓ ] 不支持这两个按钮功能 

[添加]按钮 

[删除]按钮 

[编辑]按钮 
[通讯设定]按钮 
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● 个别映射名显示

[Mapping] 显示的下一层是 [The Individual Mapping Name] 显示。[The 
Individual Mapping Name] 显示时，可以在内容区域变更各个模块到实际模

块的映射。

• [IP address]、[Node ID]、[Workgroup ID]
手动设定各个值

• [Mapping name]
可以变更映射的名称

• [Acquisition of actual module configuration] 按钮

用于建立扫描模块的映射

显示 [Actual module configuration] 窗口

• [Set communication] 按钮

显示 [Communication settings (module)] 对话框。

• [All unmap] 按钮

解除映射

实际模块构成内容区域中模块图案显示颜色变成灰色

• [Automatic numbering] 按钮

对 IP 地址和节点 ID 总括进行编号

 使用上的注意事项
•  模块间数据传送功能或者多回路协调控制使用中，变更模块的 IP地址、

节点 ID、工作组 ID的场合请参阅

■ 模块间数据传送功能或者多回路协调控制使用中模块 IP 地址等

的变更 (9-4 页 )。

[获取实际模块构成]按钮 
 
 
 
 
 
[通讯设定]按钮 

 
[全部解除]按钮 
[自动编号]按钮 

映射名          IP地址     节点ID 工作组ID 
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■ 项目窗口的菜单构成一览

菜单 子菜单1 子菜单2 内　容 快捷方式 补充内容

File New
—

新建项目 (离线、根据实际模块构成
制作 )

[Ctrl]＋ [N]

Open — 打开项目 [Ctrl]＋ [O]
Save — 保存项目 [Ctrl]＋ [S] 项目已经打开时

Save as — 项目用其他文件名保存 —

CSV output — 参数内容按CSV格式的文件输出 —

Exit — 退出编程器 — 综合监视运行中
的场合一起退出

Edit Cut — 剪切数据 [Ctrl]＋ [X] 选择了可剪切的
数据时有效

Copy — 复制数据 [Ctrl]＋ [C] 选择了可复制的
数据时有效

Paste — 粘贴数据 [Ctrl]＋ [V] 复制或剪切数据
后，选择了可粘
贴的数据时有效

Workgroup 
independent mode —

切换到工作组独立模式
—

不支持

Data check — 检查参数的设定内容 —

Display [Logical 
operation definition] 
window

— 显示 [Logical Operation Definition]
窗口

— 详细内容请参阅 
■ 逻辑运算
窗口的显示

(6-35页 )
Online Actual module 

configuration
— 显示 [Actual Module Configuration]

窗口
—

Write Parameters — 将参数写入模块 — 写入项目树中选
择的对象，详细
内容请参阅

6-5 参数的写
入 (6-47页 )

Monitor — 启动综合监视 — 详细内容请参阅
6-6 模块动作
的监视 (6-52

页 ) 以及第7章
Read Parameters — 从模块中读出参数 — 读出项目树中选

择的对象。详细
内容请参阅

6-7 参数的读
出 (6-57页 )

Communications 
path

— 切换到从PC到模块的通讯路由 — 详细内容请参阅
■ 通讯路由
(5-29页 ) 

Network Profile — 切换到PC的 IP地址等网络设定 — 详细内容请参阅
■ 网络配置
(5-31页 )

Communications 
options

— 编程器通讯的超时设定 — 详细内容请参阅
■通讯可选项
(5-37页 )
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菜　单 子菜单1 子菜单2 内　容 快捷方式 功　能

Online Compare module 
versions

— 项目与实际模块的模块版本的比较 — 详细内容请参阅
■ 模块比较

（6-60页）

View go Back 移动到项目树的前一个位置 [Alt]＋Left 项目已经打开时

Forward 移动到项目树的后一个位置 [Alt]＋Right
Up 移动到项目树的上一层

Home 移动到当前项目树位置所属的工作
组层

[Alt]＋ [home]

Display line 
graph

— 显示 [line graph]窗口 — 详细内容请参阅
■ 折线图窗口

的显示 (6-36页 )
Display the 
list of data 
transfer between 
modules

— 显示 [List for data transfer 
between modules] 窗口

— 详细内容请参阅
■ 模块间数

据传送一览显示
(6-30页 )

Set user level — 变更参数的显示级别 — 详细内容请参阅
■ 显示级别

(6-19页 )
Help Help — 显示帮助功能 — 不支持

About SLP-NX — 显示版本、许可证信息 —

■ 工具栏
图标名 图　标 功　能 备　注

返回 移动到项目树的前一个位置 项目已经打开时

前进 移动到项目树的后一个位置

上一层 移动到项目树的上一层

主页 移动到当前项目树位置所属的工作组层

制作 新建项目 ( 离线、根据实际模块构成制作 )

打开 打开项目

保存 保存项目 项目已经打开时

展开 展开项目树 项目已经打开时

[ 实际模块构成 ] 
窗口

显示 [Actual Module Configuration] 窗口

读出
 

从模块读出参数 从项目树中选择的机器中读出参数。详细内
容请参阅 6-7 参数的读出 (6-57 页 )

写入
 

将参数写入模块 将参数写入从项目树中选择的机器。详细内
容请参阅 6-5 参数的写入 (6-47 页 )

监视 启动综合监视 详细内容请参阅
6-6 模块动作的监视 (6-52 页 )

* : 经由 USB 编程器电缆连接时，图标显示为 ( 读出 )、 ( 写入 )
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■ 版本信息

请选择 [Project] 窗口菜单栏的 [Help] → [About SLP-NX]。
≫显示如下编程器的版本信息、许可证信息。



MEMO
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第 4 章 作业流程
4  -  1 基本作业

本章节是对模块进行参数设定或对实际模块进行通讯设定，使其正常动作的基本步骤的说明。

1. 使实际模块可以通讯 

2. 决定所处理模块的构成 

3. 设定参数让模块动作 

4. 确认模块的动作 
 

5. 确认、保存模块中设定的内容 

操作窗口 作业内容 参考页 

主 [Actual module configuration]
窗口

 准备实际模块，进行实际模块通

讯设定 
5-2 IP地址以及节点地址的定义 

(5-7页) 
 
5-3 通讯设定(5-12页)  

[Project] 窗口 离线模式(Offline)下 新建模块

构成 
或者 
在线模式(Online)下自动构建模

块构成 

6-1 项目的制作 (6-1页) 
 
 
6-2 模块构成的定义(6-11页)  

[Project] 窗口 编辑参数 
 
指定写入对象模块 
 
写入参数 

6-3 参数的编辑(6-16页) 
 
6-4 映射(6-39页) 
 
6-5 参数的写入(6-47页)  

[Universal monitor] 窗口 通过综合监视功能确认模块动作 6-6 模块动作的监视(6-52页)  

[Project] 窗口 从模块读出参数 
 
用CSV文件形式输出设定内容 
 
保存项目 

6-7  参数的读出(6-57页) 
 
6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存(6-66页)  

 
打开保存的项目 6-10项目的打开(6-68页)  
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4 - 2 使用模块存在时

可以使用模块时 , 按照以下步骤设定参数及映射使其正常动作。

 
 
 

1. 把实际模块置为通讯状态 
 

 
 
 

2. 决定所处理模块的构成 
 
 
 

3. 设定参数使模块动作 
 
 
 
 

4. 确认模块的动作 
 
 
 
 

5. 确认、保存模块中设定的内容 

操作窗口 作业内容 参照页 

主 [Actual module configuration]
窗口

 准备实际模块，进行实际模块通

讯设定 
5-2   IP地址以及节点地址的定义 

(5-7页) 
 
5-3 通讯设定(5-12页)  

[Project] 窗口 在线模式下自动构建模块构成 6-1 项目的制作 ( 6-1页)  

[Project] 窗口 编辑参数 
 
写入参数 

6-3 参数的编辑(6-16页) 
 
6-5  参数的写入(6-47页)  

[Universal monitor] 窗口 通过综合监视功能确认模块动作 6-6 模块动作的监视(6-52页)  

[Project] 窗口 从模块读出参数 
 
用CSV文件形式输出设定内容 
 
保存项目 

6-7  参数的读出(6-57页) 
 
6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存( 6-66页)  

 打开保存的项目 6-10 项目的打开(6-68页) 
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4  -  3 使用模块不存在时

最初不能使用模块时，按照以下步骤设定参数及映射使其正常动作。

 
 
 

1. 决定所处理模块的构成 
 
 
 

2. 设定参数 
 
 
 
 

3. 确认、保存模块中设定的内容 
 
 
 
 

4. 在取得模块后，再次打开保存的 
项目 

 
 
 

5. 使实际模块可以通讯 
 
 
 
 

6. 设定参数让模块动作 
 
 
 
 

7. 确认模块的动作 
 

 
 
 

8. 确认、保存模块中设定的内容 

操作窗口 作业内容 参照页 

[Project] 窗口 离线模式下建立模块构成 6-1 项目的制作(6-1页) 
 
 
6-2 模块构成的定义(6-11页)  

[Project] 窗口 编辑参数 
 
 
定义映射信息 

6-3 参数的编辑(6-16页) 
 
 
6-4 映射(6-39页)  

[Project] 窗口 用CSV文件形式输出设定内容 
 
保存项目 

6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存(6-66页)  

[Project] 窗口 打开保存的项目 6-10 项目的打开(6-68页) 

[Project] 窗口 
[Actual module configuration] 窗口 

准备好实际的模块，使用映射信

息，将实际模块通讯设定设定到

模块 
6-4 映射(6-39页) 
 
 
 
5-3 通讯设定(5-12页)  

[Project] 窗口 写入参数 6-5 参数的写入(6-47页)  

[Universal monitor] 窗口 通过综合监视功能确认模块动作 6-6 模块动作的监视(6-52页)  

[Project]窗口 从模块读出参数 
 
用CSV文件形式输出设定内容 
 
保存项目 

6-7  参数的读出(6-57页) 
 
6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存( 6-66页)  

 打开保存的项目 6-10 项目的打开(6-68页) 
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4 - 4 模块构成变更时

按照以下步骤，在处理模块构成后对模块进行变更，重新设定参数、实际模块通讯设定使其正常动作。

 
 

1. 变更处理模块的构成 
 
 
 
 

2. 设定参数 
 
 
 
 
 

3. 确认、保存设定的内容 
 
 
 

4. 在取得模块后，再次打开保存的 
项目 

 
 
 

5. 使实际模块可以通讯 
 
 
 
 

6. 设定参数让模块动作 
 
 
 
 

7. 确认模块的动作 
 
 
 
 

8. 确认、保存模块中设定的内容 

操作窗口 作业内容 参照页 
[Project] 窗口 打开保存的项目 

 
离线模式下变更模块构成 

6-10 项目的打开(6-68页) 
 
6-2 模块构成的定义(6-11页)  

[Project] 窗口 编辑参数 
 
定义映射信息 

6-3 参数的编辑(6-16页) 
 
6-4 映射(6-39页)  

[Project] 窗口 用CSV文件形式输出设定内容 
 
保存项目 

6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存(6-66页)  

[Project] 窗口 打开保存的项目 6-10 项目的打开(6-68页) 

[Project] 窗口 
[Actual module configuration]
窗口

 
准备实际模块，使用映射信息 
 
对模块进行实际模块通讯设定 

6-4 映射(6-39页) 
 
5-3 通讯设定(5-12页)  

[Project] 窗口 写入参数 6-5 参数的写入(6-47页)  

[Universal monitor] 窗口 通过综合监视功能确认模块动作 6-6 模块动作的监视(6-52页)  

[Project] 窗口 从模块读出参数 
 
用CSV文件形式输出设定内容 
 
保存项目 

6-7  参数的读出(6-57页) 
 
6-11 输出到CSV文件(6-70页) 
 
6-9 项目的保存( 6-66页)  

 打开保存的项目 6-10项目的打开(6-68页) 
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使用本机前请设定 IP 地址、节点地址 ( 工作组 ID 和节点 ID) 的编号。

另外，请根据需要进行其他通讯设定。

在 [Actual module configuration] 窗口中进行 IP 地址、节点地址等模块的通讯设定。

■ 启动实际模块构成窗口时

单击 [Project] 窗口中的 ([Actual module configuration] 窗口 ) 图标或者

选择 [Project] 窗口菜单栏的 [Online] → [Actual module configuration]。

≫显示 [Actual module configuration] 窗口。

第 5 章 实际模块通讯设定
5  -  1 实际模块构成窗口的显示



5-2

第 5 章　实际模块通讯设定

■ 实际模块构成窗口的显示

[Actual module configuration] 窗口的显示如下。

以下是窗口各部分的名称及功能。

● 标题栏

显示 [Actual module configuration] 窗口。

● 菜单栏

用于选择或执行各种操作，可操作的内容随实际模块构成树、内容区域的显

示内容变化。

● 工具栏

菜单项目中的常用操作以按钮形式配置在工具栏上。

● 实际模块构成树

以串为单位显示实际模块构成，在内容区域显示所选择部分对应的设定画面。

实际模块构成树的详细内容请参阅

■实际模块构成树结构 (5-4 页 ) 中说明。

● 内容区域

显示实际模块构成树中所选择项目对应的画面。

 

 

菜单栏 
标题栏 

工具栏 

实际模块构成树 内容区域
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■ 实际模块构成窗口的菜单构成一览

菜单 图标 子菜单1 子菜单2 内　容 快捷方式

File — Close — 关闭 [Actual module configuration]窗口 —

Edit — Cut — 剪切数据 [Ctrl]＋ [X]

— Copy — 复制数据 [Ctrl]＋ [C]

— Paste — 粘贴数据 [Ctrl]＋ [V]

Online — Workgroup independent 
mode

— 不支持 —

— Communications path — 切换到从PC到模块的通讯路由设定画面
详细内容请参阅

■通讯路由 (5-29页 )

—

— Network profile — 切换到PCIP地址设定画面
详细内容请参阅

■网络配置 (5-31页 )

—

— Communications options — 编程器通讯超时设定
详细内容请参阅

■通讯可选项 (5-37页 )

—

— Sensitive to ring 
disconnection error

— 环形切断状态检测 /不检测的切换 —

View Go Back 移动到实际模块构成树中的前一个位置
项目打开着时有效

[Alt]＋ [Left]

Forward 移动到实际模块构成树中的后一个位置
项目打开着时有效

[Alt]＋ [Right]

Up 移动到实际模块构成树中的上一层
项目打开着时有效

—

Home 移动到实际模块构成树的最高层 (全体 ) [Alt]＋ [home]

— [Workgroup] screen — 移动到所选择模块对应的 [Project]窗口的
工作组显示
[Actual module configuration]窗口中选择
了模块时有效

—

— Return to [Project ]    
window

— 把光标返回到 [Project]窗口 —

— Error display — 显示模块的错误
[Actual module configuration]窗口中所选
择的模块发生错误时显示

—

— Set user level — 变更显示级别 —
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■ 工具栏
图标名 图标 功  能

后退 移动到实际模块构成树中的前一个位置

前进 移动到实际模块构成树中的后一个位置

上移 移动到实际模块构成树中的上一层

主页 移动到实际模块构成树的最高层 ( 全体 )

展开 展开实际模块构成树

■ 实际模块构成树结构

实际模块构成分为以下层级。

● 全 体
实际模块构成树的顶层称为 [All]。
可以扫描实际模块构成或者设定所有模块共通的通讯等。

• [Execute] 按钮

扫描实际模块构成

• [Edit] 按钮

显示所选择串连接的模块一览

• [Set communication] 按钮

显示 [Communication settings (all)] 对话框

• [Return] 按钮

光标返回到 [Project] 窗口

全 体 5-4页 

串名称 5-5页 

   模块名称   5-6页 

   [执行]按钮 

[通讯设定]按钮 
[返回]按钮 

 

[编辑]按钮  
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● 串名称

[All] 的下一层是 [Chain Name]。
设定每个模块的 IP 地址、节点 ID 等。

另外，点击 [Write] 按钮可以将实际模块通讯设定写入模块。

以下是串名称表的各项说明。

• [Chain ID]
可以设定串 ID

• [Chain name]
可以设定串名称

• [Target] 复选框

选择 LED 灯亮、写入、以及自动编号的对象时勾选

• [Work group ID]
显示工作组 ID( 显示与串 ID 相同的值 )

• [IP address]
可以设定 IP 地址

• [Node ID]
可以设定节点 ID

• [Details] 按钮

显示所选择模块的模块信息

• [Set communication] 按钮

可以设定所选择模块个别的通讯设定

• [Lit LED] 按钮

[Target] 复选框中所选择模块的 LED 灯亮

• [Automatic numbering] 按钮

可以自动设定 IP 地址以及节点 ID

• [Write] 按钮

将变更的实际模块通讯设定写入 [Target] 复选框中所选择的模块

[实际模块构成树] [一览] [串名] 

[串ID] 

 [对象] 

 
[详细内容]按钮 
[通讯设定]按钮 
 
 
 
[LED灯亮]按钮 
[自动编号]按钮 
[写入]按钮 

[工作组ID] [IP地址]    [节点ID]  
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 参 考
•  从实际模块获取的模块名与项目设定的模块名不同的场合，在实际模

块构成窗口的实际模块构成树及内容区域上显示的模块名之前用附加

了 "*" 的名称显示。

● 模块名称

[Chain Name] 的下一层是 [Module Name]。
显示通过执行实际模块构成扫描而获取的模块信息。

• [Item name]
所获取信息的名称

• [Setting value]
[ 实际模块构成 ] 窗口内编辑中的设定值

• [Read value]
执行实际模块构成扫描所获取模块的值

 参 考
•  在设定值的列处，除显示来自 SLP-NX 4.00 的编辑中的值外、还显

示前次成功扫描读入的结果。

 

[项目名]                 [设定值] [读入值] 
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5  -  2 IP 地址以及节点地址的定义

在 [Actual module configuration] 窗口中输入地址编号。

没有所使用的模块时，可按照 6-4 映射 (6-39 页 ) 事先进行设定。

 使用上的注意事项
•  环形异常时，要从实际的模块构成新建项目的场合，请在 [Actual module 

configuration] 窗口的菜单上取消 [Online] → [Sensitive to _ring disconnection 
error] 的复选框后，进行实际模块构成扫描。SLP-NX Ver 3.02.2 之前，在发

生环形异常的状态下，从编程器上扫描实际模块构成，而不新建项目。这种

场合，请解除环形异常或离线创建项目。

■ 步 骤
① 在 [Actual module configuration]窗口的 [All]选项卡上点击 [Execute]按钮。

≫显示 [Confirmation of module startup] 信息窗口。

②   请接通要进行地址设定的模块的电源，把由通讯路由选择的电缆与运行编

程器的 PC 连接。

 参 考
•  模块处于连接状态、通讯路由是以太网的场合，可以同总括设定多个

模块的地址。

③ 确认连接，点击 [OK] 按钮。

≫显示 [Progress] 对话框。
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 参 考
• 请确认编程器与模块是否正确连接。

请参阅■ 通讯路由 (5-29 页 )、■ 网络配置 (5-31 页 )。

其后，根据模块的状态显示相应的信息窗口。

④ -1 实际模块构成扫描中发生错误时

显示与错误内容对应的信息窗口。

请确认内容，选择恰当的处理方法。

 参 考
• 有关错误的详细内容及处理方法请参阅 

■ 信息一览 (5-16 页 )。

④ -2 实际模块构成扫描没有错误，[Project] 窗口中没有打开的项目时

显示以下信息窗口。要进行地址编号等模块通讯设定时，请点击 [No]
按钮。

 参 考
•  选择上面的信息窗口中的 [Yes] 按钮时  
与 6-1 项目的制作 ●「从实际模块自动构成」制作，与 (6-1 页 ) 的处

理相同

④ -3 实际模块构成扫描没有错误，[Project] 窗口上工作组编辑中时

显示以下信息窗口。要进行地址编号等模块通讯设定时，请点击 [No]
按钮。
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⑤ 扫描结果用串为单位的画面显示。

 参 考
• 发生错误时

发生扫描错误的模块显示闪烁的异常图标  ，将鼠标放置在有闪

烁异常图标的模块上，通过点右键→ [Error display] 的操作，可以

显示错误内容。

⑥ 以串为单位设定模块的地址 (IP 地址、节点 ID、工作组 ID)。
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 使用上的注意事项

•  节点 ID 是模块间数据传送功能以及多回路协调控制中必要的设定项。

不使用模块间数据传送功能或者多回路协调控制时，不必变更节点 ID。

•  变更模块间数据传送功能或者多回路协调控制使用中的模块的 IP 地

址、节点 ID、工作组 ID 时

请参阅■ 模块间数据传送功能或者多回路协调控制使用中模块 IP
地址等的变更 (9-4 页 )。

•  画面上显示的工作组 ID，是 [Project] 窗口中模块分组的工作组标识符。

工作组 ID 与串 ID 是连动的，因此不能编辑。

⑥ -1 手动设定时，请点击对象模块所在的行，在编辑框中直接设定。

⑥ -2 自动设定 ( 连续编号 ) 时，请点击 [Automatic numbering] 按钮。

≫显示 [Automatic module numbering] 对话框。

 参 考
•    存在不需要自动编号的模块时，请在模块一览中取消 [Target] 复选框

的勾选 ( √ )。 
请确认允许使用的 IP 地址范围，然后指定需要设定的模块的起始 IP
地址和节点 ID，点击 [OK] 按钮。
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⑦ IP 地址、节点 ID、工作组 ID 设定完毕后，点击 [Module list] 画面上的 [Write]
按钮，写入实际模块通讯设定。

≫显示通讯设定写入信息窗口。

 使用上的注意事项

• 写入结束后重新启动模块。请在确认运行状态后再进行操作。

 参 考
• 以串为单位将实际模块通讯设定写入模块。

•  存在多个串时，虽然每个串有不同的串 ID，但如果再设定恰当的串名，

就可以简便地与实际的串进行对比管理。

• 只写入勾选了 [Target] 复选框的模块。

• 写入前要确认与写入对象模块的对应的场合，请参阅

5-4 模块的 LED灯亮 (5-15页 )的步骤使模块的 LED灯亮并确认。

⑧   点击 [Writing of communication settings.] 信息窗口的 [Yes] 按钮。  
≫显示 [Progress] 对话框。

⑨ 自动从模块获取实际模块的构成信息。
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5 - 3 通讯设定

模块的 IP 地址、节点地址以外的通讯设定是由 [Actual module configuration] 窗口的 [Set communication ]
进行的。可设定的内容如下。

没有使用模块的场合，可按 6-4 映射 (6-39 页 ) 事前进行设定。

设　定 设定画面

分　类 设定名称 内　容 全体
(5-13页 )

串名称
(5-14页 )

模块 
基本设定

全模块中设定下一个值 对全模块执行禁止地址自动编号功能时请
勾选

○ —

禁止地址自动编号 取消地址自动编号功能的对象 
(取消模块一览的对象列的勾选 )

○ ○

IP设定 网络地址掩码 IP网络地址掩码 ○ —

缺省网关 IP缺省网关 ○ —

端口设定 全模块中设定下一个值 把端口设定的内容适用于全模块的场合，
勾选。

○ —

专用通讯端口编号 不可变更 ○ ○

MODBUS 通讯端口编号 MODBUS/TCP功能的端口编号 ○ ○

CPL/TCP端口编号 CPL/TCP通讯功能的端口编号 ○ ○

RS-485 
详细设定

全模块中设定下一个值 把RS-485设定的变更适用于全模块的场
合，勾选。

○ —

RS-485机器地址 上位通讯 (RS-485)中使用的机器地址 — ○

RS-485协议 上位通讯 (RS-485)的协议选择 ○ ○

RS-485传输速度 上位通讯 (RS-485)中使用的传输速度 ○ ○

RS-485位长 上位通讯 (RS-485)中使用的位长 ○ ○

RS-485有无奇偶校验 上位通讯 (RS-485)中有无使用奇偶校验 ○ ○

RS-485停止位 上位通讯 (RS-485)中使用的停止位 ○ ○

RS-485最小应答时间 上位通讯 (RS-485)中使用的最小应答时间 ○ ○
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■ 设定步骤

对设定步骤进行说明。

•全模块共通设定的场合

在实际模块构成树上选择 [All]，然后选择 [All] 选项卡的内容区域，点击

[Communication setting] 按钮。

≫显示 [Communication settings (all)] 对话框。

请设定必要的项目，点击 [OK] 按钮。
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•每个模块单独设定的场合

在实际模块构成树上选择 [Chain Name]，然后选择由内容区域 [List] 选项卡

设定的模块的行 ( 点击对象模块行后背景为灰色显示 )，点击 [Communication 
setting ] 按钮。

≫显示如下的对话框。

请设定必要的项目，点击 [OK] 按钮。

 参 考
•  实际模块通讯设定 (IP 地址 / 节点地址及通讯设定 ) 同时被变更，可写入模

块中。
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5  -  4 模块的 LED 灯亮

模块的 LED 灯亮功能是在对模块进行 IP 地址进行编号等时，画面上的模块对应哪个实际的模块时确认用

的功能。

① 从 [Actual module configuration] 窗口的实际模块构成树选择 [Chain Name]，
内容区域的 [List] 选项卡上勾选要使其灯亮的模块的 [Target]，点击 [Lit LED]
按钮。

≫显示 [Lit module LED] 对话框。

② 请设定 [Lighting indication]，点击 [OK] 按钮。

在灯显示中，灯亮种类可选择定时器、[ON]( 保持 )、[OFF]( 保持解除 )。
定时器的场合，在 1 ～ 255 秒的时间范围内可显示。

≫作为对象的模块，最上部的全部 LED 将低速闪烁。
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5 - 5 工作组映射的确认

■ 概　要

在离线时制作项目，用手动编辑过模块构成的场合或从实际模块的自动构成

制作项目时，如果对模块构成有追加或变更了型号的场合，则需要把工作组

的信息与实际模块构成的信息保持一致。

请用实际模块构成扫描功能等进行确认。

■ 信息一览

在确认与工作组的映射作业时，显示如下的信息。

No. 显示内容 原因及处理方法

1

实际模块构成的扫描发现错误。 
xxx ：IP 地址重复。需要进行 IP 地址的设定。 
请设定 / 确认正确值 , 执行写入。

【Module Error】
模块的 IP 地址重复

请在 [Actual module configuration] 窗口上设

定不重复的 IP 地址，点击 [Write] 按钮写入模

块中。

2

实际模块构成的扫描发现错误。 
xxx ：串 ID 重复。 
请设定 / 确认正确值 , 执行写入。

【Module Error】
模块的串 ID 重复

请在 [Actual module configuration] 窗口上对

各串设定不重复的串 ID，点击 [Write] 按钮写

入模块中。

3

实际模块构成的扫描发现错误。 
xxx ：底板的 IP 地址与本体不同。 
请设定 / 确认正确值 , 执行写入。

【Module Error】
模块本体与底板的组合有变更。 
请把模块本体与底板恢复原样或在 [Actual 
module configuration] 窗口上点击 [Write] 按
钮写入模块中。

通过该操作，把向模块写入的 IP 地址等信息

也写入底板中，解消了模块本体与底板的差

异。

4

在所选择的通讯路由上未找到模块。

【Module Error】 
扫描时未找到模块

请确认以下内容

• 模块的电源正确接入

• 模块与 PC 正确连接

• [Communications path settings] 正确设定
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No. 显示内容 原因及处理方法

5

实际模块构成的扫描发现错误。
xxx ：串 ID 与最初的模块不同。

•　•　• 
需要从实际模块构成窗口进行写入。 
请设定 / 确认正确值 , 执行写入。

【Module Error】
同一串内有不同串 ID 的模块存在

在 [Actual module configuration] 窗口上确认串
ID，为使串内全部模块的串 ID 相同，请点击
[Write] 按钮向模块写入。

6

发生了错误。 
项目中定义的模块与扫描获取的模块的型号有不一致的模
块。

•　•　•

【Project and Module Error】
由项目定义的模块与扫描获取的模块的型号
不同。

按 [OK] 按钮后，显示 [No.8] 的信息框，再次
显示该信息框。 
这种场合，请确认 [Project] 窗口的 [Module 
configuration]，匹配模块的型号。

7

发生了错误。 
项目中定义的模块与扫描获取的模块的模块构成差异大。
(28)

发生了错误。 
项目中定义的模块与扫描获取的模块的类型、位置、IP 地址、
节点 ID、工作组 ID 不一致。(26) 
项目中定义的模块与扫描获取的模块的模块构成差异大。(28)

【Project and Module Error】
由于项目定义的模块与扫描获取的模块的类
型、位置、IP 地址、节点 ID、工作组 ID 不致，
所以映射处理时会产生错误。

点击 [OK] 按钮后显示 [No.8] 的信息框。 
显示 [No.8] 的信息窗口之后，当不能映射的场
合，会再次显示该信息。此时，请确认项目的
模块的设定。
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No. 显示内容 原因及处理方法

8

用扫描获取的信息覆盖项目中定义的模块的 IP 地址、节 
点 ID ？
(1 串、工作组联动模式下，工作组 ID 也覆盖 )

【Confirmation of Mapping Retry】
当项目的设定与模块的差异大的场合，在错误
信息只后显示。

选择 [Yes] 时，把扫描获取的模块的 IP 地址、
节点 ID 反映到项目中，执行映射。 
另外，只有一个串时，工作组联动模式的场合，
把扫描获取的工作 ID反映到项目中，执行映射。 
选择 [No] 时，项目的设定不会变更，也不执行
映射。

另外，要把项目的设定写入实际模块的场合，
请选择 [No]，终止映射，在 [Project] 窗口的
[Mapping] 画面上通过拖放操作执行映射后，点
击 [Actual module configuration] 窗口的 [Write]
按钮，写入模块中。

9

项目定义的模块中，未设定 IP 地址。
点击「YES」时，执行由扫描获取的 IP 地址、节点 ID 反映
到项目中的映射。 
处理继续？

【Confirmation of Mapping Continuation】
项目中定义的模块没有设定 IP 地址。

选择 [Yes] 时，把扫描获取的模块的 IP 地址、
节点 ID 反映到项目中，执行映射。
选择 [No] 时，项目的设定不会变更，也不
执行映射。

10

项目中定义的一部分模块未找到。
点击「YES」时，只对找到的模块进行映射。
处理继续？

【Confirmation of Mapping Continuation】
扫描时未找到一部分项目中定义的模块。

点击 [Yes] 时，只对项目中定义的模块与扫描获
取的模块一致的模块进行映射。 
点击 [No] 时，不执行映射。

11

找到了项目中未定义的模块。
•　•　•
点击「YES」时，对上述以外的模块执行映射。
处理继续？

【Confirmation of Mapping Continuation】
扫描时未找到项目中定义的模块。

选择 [Yes] 时，只对项目中定义的模块与扫描获
取的模块一致的模块进行映射。 
点击 [No] 时，不执行映射。
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No. 显示内容 原因及处理方法

12

获取了串数 (x)、模块数 (y) 的构成信息。 
以该信息为基础构建项目。 
继续读出模块的设定参数？

【Build Project】
用 [Automatic configuration from actual 
module] 制作新项目，显示模块的扫描正常执
行。

选择 [Yes] 时，读出模块的参数，反映到项目中。

选择 [No] 时，虽然项目被制作，但不执行参数

的读出。 
选择 [Cancel] 时，不制作项目。

13

用扫描的信息构建项目？

【Project Construction】
在无项目的状态下，执行实际模块构成的扫
描，显示扫描正常执行。

选择 [Yes] 时，制作项目。 
选择 [No] 时，不制作项目。

14

移动实际模块构成窗口？

【Confirmation of Transition to the Actual 
Module Configuration Window】

用 [Automatic configuration from actual 
module] 制作新项目，模块的扫描有错误的场
合才显示。

选择 [Yes] 时，显示 [Actual module 
configuration] 窗口，可确认模块的状态。
选择 [No] 时，[Actual module configuration] 窗
口回到空的状态。

15

实际模块的通讯设定覆盖项目的映射信息？

【Confirmation of communication setting
overwriting】

模块的扫描与映射正常处理的场合显示。

选择 [Yes] 时，扫描的模块的实际模块通讯设
定反映到项目的映射信息上。 
选择 [No] 时，项目的映射保持设定的映射信息。

16

扫描的模块的通讯设定与项目的通讯设定不同。 
请在实际模块构成窗口上确认。

【Communication Setting Differences】
在 [No.15] 的信息窗口上选择 [No]，项目的通
讯设定与扫描模块获取的通讯设定有差异的场
合才显示。

在 [Actual module configuration] 窗口上，请确
认通讯设定
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No. 显示内容 原因及处理方法

17

读出模块的设定参数，已经反映到项目中？

【Parameter Reading】
在 [No.15]的信息窗口上选择 [Yes]后显示

选择 [Yes]时，读出模块的参数，反映到项目中
选择 [No]时，不读出参数

18

实际模块构成的扫描完成。

【Scanning Complete】
显示实际模块构成的扫描正常执行

19

参数收信完成。

【Setting Parameter Reading Complete】
显示模块的参数的读出完成

20

执行串信息、地址信息、通讯设定的写入。
写入后重新启动模块。 
要执行吗？

【Write Confirmation】
在 [Actual module configuration]窗口上点击 [Write]按
钮后显示

选择 [Yes]时，开始向模块写入实际模块通讯设定。 
另外，向模块写入时，模块重新启动 
选择 [No]时，不向模块写入

21

写入后的扫描时发现错误。
xxx ：IP地址重复。需要重新设定 IP地址。 
设定正确的值并确认后，请再次写入。(729)

【Error After Writing】
虽向模块的写入成功，但其后的扫描发现了模块的 IP
地址重复

在 [Actual module configuration]上确认模块的 IP地址
并再次点击 [Write]按钮
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No. 显示内容 原因及处理方法

22

向模块写入失败或有未写入的数据。
xxx ：有未写入的串信息、地址信息、通讯设定。 
请对未写入的串写入串信息、地址信息、通讯设定。

【Error After Writing】
[Actual module configuration]窗口上有未写入的
模块

确认 [Actual module configuration]窗口的模块一
览的 [Modification]列处于“ * ”的模块，根据需要
用 [Write]按钮向模块写入实际模块通讯设定的写
入。

23

向模块写入失败或有未写入的数据。
xxx ：实际模块构成有变更。 
请清除以前的构成后再次执行。

【Error After Writing】
向模块写入时，项目的模块构成与扫描获取的模
块构成有差异

点击 [Actual module configuration]的 [Execute]按
钮，重新获取实际的模块构成后再次点击 [Write]
按钮执行向模块的写入

24

向模块写入失败或有未写入的数据。
xxx ：串 ID与最初的模块不同。
•　•　•
请对未写入的某个串写入串信息、地址信息、通讯设定。

【Error After Writing】
向模块写入时，同一串内有不同串 ID的模块存在

在 [Actual module configuration]窗口上确认串
ID，串内全部的模块的串 ID相同后，点击 [Write]
按钮向模块执行写入

25

模块的写入完成。

【Writing Modules Completed】
显示模块的写入完成
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■ 典型的确认方法

确认工作组与实际模块构成的映射的典型的方法有如下三种。

1. 新模块中进行实际模块通讯设定的方法

2. 事前准备的参数适用于实际模块的方法

3. 从动作中的模块中读出参数进行设定变更的方法

以下对各个步骤进行说明。

● 新模块中进行实际模块通讯设定的方法

启动编程器，从新建项目获取实际模块构成。

①  点击 [Project] 窗口  图标或选择 [Project] 窗口菜单栏的 [File] → [New]。
≫显示 [Create new project] 对话框。

② 选择 [Automatic configuration from actual module]，点击 [OK] 按钮。

③ 显示 [Confirmation of module startup] 信息窗口。

请点击 [OK] 按钮。

≫开始采集模块的信息，显示 [Progress] 对话框。

④   由于 IP 地址重复，显示信息窗口。 
请点击 [OK] 按钮。

⑤   显示 [Confirmation of transition to the actual module configuration window]
信息窗口，点击 [Yes] 按钮。
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⑥ -1 在 [Actual module configuration] 窗口上，IP 地址与节点 ID 处于重复

的状态。

⑥ -2  点击 [Automatic numbering] 按钮，[Automatic module numbering]
对话框的全部模块的 IP 地址与节点 ID 连号设定或用 [Actual module 
configuration] 窗口的内容区域的 IP 地址与节点 ID 的文本框个别输入。

（下例中显示 [Automatic module numbering] 对话框）

⑥ -3 IP 地址与节点 ID 被变更时，变更栏中带 * 号显示。请点击 [Write] 按钮，

向模块中写入实际模块通讯设定。
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⑦   显示 [Writing of chain information, address information, and communication 
settings] 信息窗口，请点击 [Yes] 按钮。

≫显示写入的 [Progress] 对话框。

⑧   显示 [Project construction] 信息窗口。 
请点击 [Yes] 按钮。

⑨   显示读出参数的信息窗口。 
请点击 [Yes] 按钮。 
反映到项目中。

≫显示读出的 [Progress] 对话框。

⑩   显示 [Parameters received] 信息窗口。 
请点击 [OK] 按钮。

请选择 [Project] 窗口的菜单 [File] → [Save as]，给项目取恰当的名称后保

存。
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● 事前准备的参数适用于实际模块的方法

①   启动编程器，打开事前准备的项目。 
打开 [Actual module configuration] 窗口，请点击 [Scanning of actual module 
configuration] 的 [Execute] 按钮。

②   显示 [Confirmation of module startup] 信息窗口。 
请点击 [OK] 按钮。

≫显示 [Progress] 对话框。

③   请确认 [Scanning of actual module configuration] 未发生错误。

•   显示由错误的场合，请参考 ■ 信息一览 (5-16 页 ) 的显示内容、原因

及处理方法，进行恰当的处理后再次从步骤①开始执行。

•未显示错误的场合，请按步骤④以后执行。

④   显示 [Confirmation of communication setting overwriting] 信息窗口。 
请点击 [No] 按钮。

⑤   显示 [Build project] 信息窗口。 
请点击 [No] 按钮。
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⑥   显示 [Scanning of actual module configuration complete] 信息窗口。 
请点击 [OK] 按钮

⑦ 从 [Project] 窗口选择工作组，用以下方法之一向模块写入。

•选择工作组显示的内容区域的 [Operation list] 的 [3:Parameter writing]
•选择 [Project] 窗口菜单栏的 [Online] → [Write Parameters]

•选择 [Project] 窗口工具栏的  图标

⑧   显示 [Confirmation of parameter write] 信息窗口。 
请点击 [Yes] 按钮。 
≫开始写入，显示 [Progress] 对话框。

⑨   显示 [Parameter sending complete] 信息窗口。 
请点击 [OK] 按钮。
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● 从动作中的模块读出参数进行设定变更的方法

启动编程器，从新建项目获取实际模块构成。

① 点击 [Project] 窗口  图标或选择 [Project] 窗口菜单的 [File] → [New]。
≫显示 [Create new project] 对话框。

② 选择 [Automatic configuration from actual module]，点击 [OK] 按钮。

 ③   显示 [Confirmation of module startup] 信息窗口。 
请点击 [OK] 按钮。

≫开始采集模块的信息，显示 [Progress] 对话框。

④   显示 [Build project] 信息窗口。 
读出模块的设定参数后实施变更，请点击 [Yes] 按钮。

⑤ 显示读出的 [Progress] 对话框。
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⑥   显示 [Parameters received] 信息窗口。 
请点击 [OK] 按钮。

⑦   要变更实际模块通讯设定的场合时，从 [Actual module configuration] 窗
口变更设定，执行写入。 
变更参数的场合时，从 [Project] 窗口变更设定后，执行参数写入。

⑧ 根据需要，请把项目用别的名称保存。
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5  -  6 其他

■ 通讯路由

通讯路由是选择连接模块及编程器的方法 ( 以太网、USB 编程器电缆 )。
另外，以太网连接的场合，指定使用编程器的 PC 的网络接口。

选择 [Actual module configuration] 窗口或 [Project] 窗口菜单栏的 [Online] 
→ [Communications path]。
≫显示 [Communications path] 对话框。

 参 考
• 选择 USB 编程器电缆时，需要满足如下的条件。

• USB 编程器电缆连接到 PC 上并能识别

• 项目的模块构成中登录的模块为 1 台

● USB编程器电缆的连接

由单一模块构成的项目的场合，可选择 USB 编程器电缆连接。

① 请在 [Communications path] 对话框的组合框上选择 [Loader jack]。

②   请点击 [configuration Communications path] 按钮，选择 USB 编程器电

缆连接的串行端口。 
通常已经选择了 USB 编程器电缆连接的串行端口，不需变更。
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● 以太网的连接

以太网连接可与由单一或者多个模块构成的项目连接。

① 请在 [Communications path] 对话框的组合框上选择 [Ethernet]。

② 请单击 [configuration Communications path] 按钮。

③ 请指定与模块连接的 PC 的网络接口。
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■ 网络配置

用 [Network Profile Explorer]对话框可对编程器使用的网络设定 (IP地址、

缺省网关、网络地址掩码 ) 进行设定及变更。

在编程器启动状态下，此处选择的 [Activate] 的网络设定作为该 PC 的网

络设定。编程器下次及以后启动时，可由 [Network profile initialization 
process] 对话框选择哪个网络配置。

另外，退出编程器时，自动返回编程器启动前的网络设定 ( 在 [Network 
profile] 窗口上显示为 [Original])。

请选择 [Actual module configuration]窗口或 [Project]窗口菜单栏的 [Online] 
→ [Network profile]。
≫显示 [Network Profile Explorer] 对话框。

 使用上的注意事项
•  编程器异常退出的场合，网络配置保持编程器使用中的设定。要返回编程

器启动前的 PC 的网络设定时，再次启动编程器后退出，退出时显示 [Select 
profile] 窗口。通过选择窗口内显示的 [Original]，可返回编程器启动前的网

络设定。

•  变更使用网络配置功能的 PC 的网络设定时，请勿拔插以太网电缆，否则

网络设定的变更会有不正常执行的情况。
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● 新建

在 [Network Profile Explorer] 对话框的工具条上选择 [New]。
≫制作新的网络配置。

现在使用中的网络设定的内容被复制，请根据需要进行变更。

有关变更方法，请参阅

● 编 辑 (5-36 页 )。
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● 使用 
在 [Network Profile Explorer] 对话框的树一览上，选择配置名称 ( 附有

文件夹图标 )，点击工具栏的 图标或右键菜单的 [Activate]。
≫�选择的网络配置作为编程器启动中的 PC 网络设定，编程器下次启

动时，该网络配置作为编程器启动时的初始值被选择。

选择 [Activate] 的场合

≫当该网络配置作为 PC 的网络设定有効时，在树一览的配置名上

「In use」的配置有勾选号。
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● 删 除
可删除「In use」的配置或「Original」配置以外的配置。

在 [Network Profile Explorer] 对话框的树一览上，选择配置名称 ( 带有文件

夹图标 )，点击工具栏的  图标或右键菜单的 [Delete]。
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● 配置名编辑

「In use」的配置或「Original」配置以外的配置名可变更。

在 [Network Profile Explorer] 对话框的树一览上，选择配置名称 ( 附有文件

夹图标 )，直接修改树一览的名称或用配置名编辑窗格的文本框进行变更。

● 网络设备信息

要查看配置的各网络接口的 IP 地址、子网掩码、缺省网关的信息时，请选

择树一览的配置名下的网络接口名。

≫显示在右侧的网络设备信息窗格中。
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● 编 辑
可编辑除 「Original」 以外的配置的各网络接口的 IP 地址、子网掩码、缺省网

关。选择树一览配置下的网络接口名，点击工具栏或网络设备信息窗格上 [Edit]
按钮。

● 关 闭
关闭 [Network Profile Explorer] 对话框。

请点击菜单栏的 [File] → [Exit] 或对话框右下的 [Exit] 按钮。
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■ 通讯可选项

通过编程器电缆连接，设定与模块通讯时的信息的超时等。

通常不需要变更。

请选择 [Actual module configuration] 窗口或 [Project] 窗口菜单栏的 [Online] 
→ [Communications options]。
≫显示 [Communications options] 对话框。

● 最小通讯间隔 (ms)
从收到对请求信息的应答后开始到发送下一个信息为止的间隔时间。值不可

变更。

● 超时 (ms)
指定对请求信息的应答的容许时间。

在超时时间范围内没有应答时，当再送次数大于 1 的场合，则只按该次数发

送请求。

● 再送 (次 )
指定对请求信息的应答发生超时时的再送次数。



MEMO
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6  -  1 项目的制作

■ 概　要

把模块的参数设定等编程器使用的单位称为项目。在此对项目的制作方法进

行说明。

选择 [Project] 窗口菜单工具的 [File] → [New] 或点击 图标。

≫显示 [Create new project] 对话框。

[Module configuration selection] 单选按钮的处理的说明如下。

● 选择 「Single module configuration」 并制作

选择单选按钮的 [Single module configuration] 制作项目的场合，制作项目模

块构成按 1 台登录。

登录的模块的型号为 NX-D15NT4T00。
项目制作后，也可进行型号的变更或模块的追加。详见

选择 ■「Single module configuration」制作项目 (6-2 页 )。

 使用上的注意事项

  使用管理员模块进行多回路协调控制的场合，由于是同时实施多个模

块的设定，请勿按本连接方法执行。

● 选择 「Multiple module configuration」 制作

选择单选按钮的 [Multiple module configuration] 制作项目的场合，虽可制作

项目，但模块处于不登录的状态。

项目作成后进行模块构成定义。详见

选择■「Multiple module configuration」制作项目 (6-4 页 )。

● 选择 「Automatic configuration from actual module」 制作

选择单选按钮的 [Automatic configuration from actual module] 制作项目的场

合，执行实际的模块构成扫描，制作基于检出的信息进行模块的定义及对实

际模块进行通讯设定的项目。

详见

选择■「Automatic configuration from actual module」制作项目 (6-6 页 )。
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■ 选择 「Single module configuration」 制作项目

对在制作项目的同时把模块构成设为 1 台时的登录方法进行说明。

登录的模块的型号为 NX-D15NT4T00。

① 点击 [Project] 窗口菜单工具的 [File] → [New] 或 图标。

≫显示 [Create new project] 对话框。

② 选择 [Single module configuration]、点击 [OK] 按钮。

 参 考
•  在打开项目的状态下新建的场合，显示 [Confirmation of new creation]

信息框。

终止打开的项目进行新建的场合，请点击 [Yes]按钮继续作业。

不终止打开的项目的场合，请点击 [No]按钮。
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③ 项目制作完成后显示 [New project] 信息框，请点击 [OK] 按钮。

≫显示项目树层级的工作组。

④ 请选择工作组显示的内容区域的 [1:Module definition]。
≫可确认模块构成中登录了 1 台 NX-D15NT4T00。

 参 考
  通过变更模块类型、型号，可变更为NX-D15NT4T00以外的型号。另

外还可追加模块。



6-4

第 6 章　参数的设定

■ 选择 「Multiple module configuration」 制作项目

对未登录的模块制作项目的方法进行说明。

①点击 [Project] 窗口菜单工具的 [File] → [New] 或点击 按钮。

≫显示 [Create new project] 对话框。

②请选择 [Multiple module configuration] 点击 [OK] 按钮。

 参 考
•  在项目打开的状态下新建的场合，显示 [Confirmation of new creation]
信息。 
终止打开项目的作业，进行新建的场合 ,请点击 [Yes]按钮继续作业。 
不终止打开项目作业的场合，请点击 [No]按钮
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③ 项目制作完成后，显示 [New project] 信息框，请点击 [OK] 按钮。

≫显示项目树层级的工作组。

④请选择工作组显示的内容区域的 [1:Module definition]。
 ≫可确认模块构成中 1 台也没有登录。

 参 考
•    有关模块构成的设定，请参阅 

6-2 模块构成的定义 (6-11页 )。
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■ 选择 「Automatic configuration from actual module」 制作项目

使用实际模块构成，对在制作项目的同时获取实际模块通讯设定的方法进行

说明。

 使用上的注意事项
• 环形异常时，要从实际的模块构成新建项目的场合，请在 [Actual module 

configuration] 窗口的菜单上取消 [Online] → [Sensitive to _ring disconnection 
error] 的复选框后，选择「Auto configuration from actual module」进行项

目的制作 。SLP-NX Ver 3.02.2 之前，在发生环形异常的状态下，从编程器

上扫描实际模块构成，而不新建项目。这种场合，请解除环形异常或离线创

建项目。

•  按已经对模块实施了实际模块通讯设定。 
未进行实际模块通讯设定的场合，请在参阅 

5-2 IP地址及节点地址的定义 (5-7页 ) 资料的基础上向模块分配 IP地址

等。

① 请点击 [Project] 窗口菜单工具的 [File] → [New] 或 图标。

≫显示 [Create new project] 对话框。

② 请选择 [Automatic configuration from actual module]，点击 [OK] 按钮。
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 参 考
•  在项目打开的状态下新建的场合，显示 [Confirmation of new creation]
信息框。 
终止打开项目的作业，要执行新建的场合请点击 [Yes]按钮继续作业。 
不终止打开项目的作业的场合，请点击 [No]按钮。

③ 显示 [Confirmation of module startup] 信息框，点击 [OK] 按钮，开始执

行实际模块构扫描。

≫显示 [Progress] 对话框。

根据实际模块构成扫描的结果，如下所示，作业内容不同。

③ -1 没有错误的场合

≫显示 [Build project] 信息框。

要同时读出参数时，请点击 [Build project] 信息框的 [Yes] 按钮，进入

步骤④。

不需读出参数时，请点击 [Build project] 信息框的 [No] 按钮，进入步

骤⑦。

要终止实际模块构成扫描时，请点击 [Build project] 信息框的 [Cancel]
按钮。

③ -2 有错误的场合

≫显示 [Error in scanning of actual module configuration] 信息框。

 参 考
• 详见

■ 信息一览 (5-16页 )。
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请点击 [Error in scanning of actual module configuration] 信息框的

[OK] 按钮。

≫显示 [Confirmation of transition to the actual module configuration]
信息框。

点击 [Confirmation of transition to the actual module configuration 
window] 信息框的 [Yes] 按钮，与 5-2 IP 地址及节点地址的定义 (5-7 页 )
的步骤⑤相同，显示 [Actual module configuration] 窗口显示。

点击 [No] 按钮后，结束处理。请先对显示错误进行回避作业。

④  PC 的网络设定不能与连接的模块直接进行通讯设定的场合，如下所示，

显示 [Network profile search] 对话框。

PC 的网络设定与连接的模块能直接进行通讯设定的场合，将执行参数的

收信处理。

请进入步骤⑤。

④ -1  登录的配置中有恰当内容存在的场合，显示是否使用找到的配置的

确认对话框。

< 使用显示的已登录的配置的场合 >
请按 [OK] 按钮 , 进入步骤⑤。

< 不使用显示的配置的场合 >
请点击 [Cancel] 按钮。

注 )  显示 [Confirmation of continuation] 信息框，当终止通讯的

场合，请点击 [Cancel] 按钮。

点击 [Confirmation of continuation] 信息框的 [OK] 按钮后，

进入步骤⑤的处理，当通讯失败时，会显示显示 [Process 
failure] 的信息框。请重新进行模块及 PC 的网络设定后，再

进行处理。
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④ -2 登录的配置中没有恰当内容的场合，显示是否制作新配置的确认对话框。

< 新建配置的场合 >
点击 [OK] 按钮后制作恰当的配置，显示是否使用的确认对话框。

请再次点击 [OK] 按钮，切换成新建配置的内容。进入步骤⑤。

不使用新建的配置的场合，请点击 [Cancel] 按钮。

注 )   显示 [Confirmation of continuation] 信息框，要终止通讯的场合，

请点击 [Cancel] 按钮。

点击 [Confirmation of continuation] 信息框的 [OK] 按钮后，进

入步骤⑤的处理，但当通讯失败时，会显示 [Process failure] 的
信息框。请重新进行模块及 PC 的网络设定后，再进行处理。

< 不新建配置的场合 >
请点击 [Cancel] 按钮。

注 )    显示 [Confirmation of continuation] 信息框，要终止通讯的场合，

请点击 [Cancel] 按钮。

点击 [Confirmation of continuation] 信息框的 [OK] 按钮后，进

入步骤⑤的处理，但当通讯失败时，会显示 [Process failure] 的
信息框。请重新进行模块及 PC 的网络设定后，再进行处理。

⑤ 在参数的文件收信中，显示 [Progress] 对话框。
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⑥ 收信完成后，显示 [Parameters received] 信息框。请点击 [OK] 按钮。

请进入步骤⑧。

⑦ 项目制作完成后，显示 [New project] 信息框。请点击 [OK] 按钮。

⑧ 显示项目树层级的工作组。

⑨ 请选择工作组显示的内容区域的 [1:Module definition]。
可在模块构成显示中通过从网络上的模块取得的信息确认模块构成设定

是否已经登录。
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6  -  2 模块构成的定义

在 [Project] 窗口 → [Workgroup] 显示的内容区域上选择 [1:Module definition] 时，显示工作组所属的模块

构成。

 参 考
• 实际模块构成的串是工作组。

请在 [Workgroup] 显示的内容区域上选择 [1:Module definition]。

≫显示 [Module configuration] 画面。
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[Workgroup] 显示的 [Module configuration] 画面上以一览方式显示工作组所属的模块的类型 ( 基本型号 )、
名称 ( 获取信息的模块的名称为空的场合，编程器会自动添加名称 )、型号。

 使用上的注意事项
•  在一览显示上变更类型时，显示 [Confirmation of module type modification]

信息框。执行类型 变更后，该模块的参数全部被初始化。

■ 模块的追加

要把模块追加到工作组的模块构成中，可点击 [Add] 按钮或点击 [Add a 
copy] 按钮。

● 选择 [Add]按钮的追加

模块构成中追加一台 NX-D15NT4T00。



6-13

第 6 章　参数的设定

● 选择 [Add a copy]按钮的追加

在模块一览上，请在被复制的模块的行处于选择状态下点击 [Add a copy] 按
钮。

≫显示 [Add copy confirmation] 对话框。

该功能是复制所选择的复制源模块的参数。

请设定复制的条件 ( 复制数 )，点击 [OK] 按钮。

点击 [Cancel] 按钮时将终止处理。

设定复制数点击 [OK] 按钮后，显示 [Add copy completed] 信息框，指定

数量的模块的复制被追加。



6-14

第 6 章　参数的设定

■ 删 除
当模块一览上要删除的模块处于选择状态下，请点击 [Delete] 按钮。显示

[Delete confirmation] 信息框，请点击 [Yes] 按钮。

≫选择的模块被删除。

■ 编 辑
当模块一览上要编辑的模块的行处于选择状态下，请点击 [Edit] 按钮。

≫选择的模块由项目树选择。

该状态下选择工具栏的  图标或双击项目树一览上的所选位置处，选

择的模块的参数将展开在项目树上。

参数的编辑方法请参阅

6-3 参数的编辑 (6-16 页 )。

 参 考
•  展开的参数因显示级别而异。 

有关显示级别请参阅 
■ 显示级别 (6-19页 )。

■ 型号设定 (模块型号详细信息的确认、变更 )
① 由实际模块构成扫描功能获取信息的场合，通常不需变更详细型号。请

确认模块的详细型号的内容，需变更时，在模块一览上显示的模块的行

处于选择状态时选择 [Set model number]。
≫显示 [Module model number setting] 对话框。

② 选择要变更型号的单选按钮，请点击 [OK] 按钮。变更为选择中的型号。

 参 考
•  事先知道型号的场合，也可在 [Model number]文本框中直接输入型号

进行变更。(基本型号的类型以外 )

•  手动设定型号的场合或由实际模块构成扫描功能制作项目后有变更的

场合等，当写入参数时，会产生与实际模块型号不一致的写入错误。

•  请根据需要进行初始化、版本的变更。关于初始化请参阅 
■初始化　(6-15页 )。

•  关于 [Change version]按钮，请参阅 
■ [Change version]对话框　(6-64页 )。
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■ 初始化

当模块一览上要执行参数初始化的模块的行处于选择状态时，请点击 [Initialize]
按钮。

≫选择模块的参数初始化开始执行。

 使用上的注意事项
•  初始化参数后，转换成编程器识别的最新的模块版本。

•  模块版本的详细内容，请参阅 
6-8 模块版本的处理　(6-60 页 )。
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6 - 3 参数的编辑

每个参数的编辑按如下步骤进行。

① 在模块构成显示的模块一览上，当要编辑的模块的行处于选择状态下，

请点击 [Edit] 按钮。

≫选择的模块由项目树选择。
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② 请点击模块名称节点左侧的 [+] 符号。

≫显示类别。

③ 请点击任一类别名称左侧的 [+] 符号。

≫显示参数库。
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④ 请点击参数库名称。

≫在内容区域上显示该参数库的编辑格。

•基本 / 设定的场合

•基本 / 回路控制 ( 扩展设定 ) 的场合
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⑤ 直接输入数据值或由组合框的选择项变更参数。

•组合框的场合

■ 显示级别

编程器显示的参数因显示级别而异。

显示级别有如下 3 种。

•简单 : 只显示基本的设定

•标准 : 显示标准功能

•多功能 : 显示高功能

详见

各模块的使用说明书。

① 要变更显示级别时，在项目打开的状态或从 [Actual module configuration]
窗口的菜单工具选择 [View] → [Display level setting]。
≫显示 [Display level setting] 对话框。

② 在组合框中选择要变更的级别，点击 [OK] 按钮。

 参 考
•  对Windows的同一用户，编程器下次启动时的显示级别与前次关闭编

程时的显示级别相同。
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■ 复制

选择单一参数设定值单元、列编号 ( 列总括选择 ) 或行编号 ( 行总括选择 )，
鼠标右键选择 [Copy]( 或用 Ctrl+C)，可把选择区域的数据复制到复制缓存中。

■ 粘贴

选择单一参数设定值单元、列编号 ( 列总括选择 ) 或行编号 ( 行总括选择 )，
鼠标右键选择 [Paste]( 或 Ctrl+V)，复制缓存内被复制的数据值被粘贴。但

列总括选择及行总括选择的场合，为同一参数库内的粘贴范围。

另外，粘贴时的范围按被粘贴侧的数据设定范围。

■ 编辑

选择单一的参数设定值单元，点击右键选择 [Edit], 可直接输入变更。( 通
常也可使用由组合框输入的参数 )

 使用上的注意事项
  项目名、位号名等文字列中只能输入SHIFT JIS的文字列。 
例如，输入了UNICODE等SHIFT JIS的文字列时，CSV输出功能等会产

生乱码。
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■ 模块间数据传送功能的设定

经由本模块的用户定义位或用户定义数值，可把其它模块的监视数据或参

数作为本模块的参数使用的功能。

 参 考
•  利用远程数据时，根据所使用的远程数据的参数，可各使用一个用户定义

位或用户定义数值。

有关可使用的模块间数据传送功能参数，请参阅

计装网络模块 NX 使用说明书「网络设计篇」CP-SP-1313C。

 使用上的注意事项
•   根据模块的型号，有不能对应模块间数据传送功能的模块。 
例 : NX-D15不对应模块间数据传送功能。

• 使用模块间数据传送功能的模块在同一工作组内要设定为不同的节点 ID。

•   设定模块间数据传送功能后，本模块与其它模块的两者中都需要进行6-5参
数的写入 (6-47页 )。
请对两者的模块或工作组总括写入参数。

• 请勿对使用多回路协调控制功能的模块进行模块间数据传送功能的设定。

以下对步骤进行说明。
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● 基本步骤

以下是在逻辑运算功能的输入分配 A 的数据中使用其它模块的 DI 输入端子

的状态的例。

要使用逻辑运算功能时需要把显示级别设定为 [Standard] 或 [Multi-function]。

① 在 [Logical operation] 参数库的 [Input assignmentA] 参数设定值处，点击

组合框的下箭头。

②   组合框处于第 2 级别。选择第 1 级别的用户定义位，从第 2 级别选择未

被其它用途使用的编号。

 参 考
• 已被使用的场合，显示远程数据名称 (取代用户定义位 )。

③ 在 [Remote data confirmation] 信息框上请点击 [Yes] 按钮。

 参 考
• 点击 [No]按钮后，选择中的编号的用户定义位编号变为可分配状态。
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④ 显示 [Remote data selection] 对话框。

请选择必要的数据，选择对象模块的「Standard bit」库的「DI1terminal 
status」。

 参 考
•  最右侧的窗格是按通道或组分类时的数据编号。一个也没有的场合将

自动被选择。

⑤ 点击 [OK] 按钮确定，关闭 [Remote data selection] 对话框后，如下所示

确认参数设定值中选择有其它模块的数据。

在 [Remote data selection] 对话框上点击 [Cancel] 按钮后，不是远程数

据而是指定的用户定义位编号被登录。
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● 同一远程数据作为多个参数设定值使用的步骤

同一模块的別的参数设定值也可利用由其它参数使用的远程数据，以下对步

骤进行说明。

与基本步骤相同，也可把其它模块的 DI 输入端子状态登录到逻辑运算功能

的 2( 输入 ) 的输入分配 A 中，以下举例说明。

① 按基本步骤的作业已经完成的状态。

其它的参数设定值也要使用同一远程数据时，与基本步骤相同，点击逻

辑运算功能的 2( 输入 ) 的输入分配 A 的组合框下箭头。

② 从组合框的第 1 级别选择用户定义位，在第 2 级别中的已被基本步骤使

用的用户定义编号中，显示远程数据的名称，请选择此项。( 下述的例中

是 D25_2 的 DI1 端子的状态 )

 参 考
• 已被使用的场合，显示远程数据名称 (取代用户定义位的数据名称 )。
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③ 在 [Remote data confirmation] 信息框上点击 [Yes] 按钮。

 参 考
•  点击 [No]按钮后，选择中的用户定义位编号变为可分配状态。由基本

步骤设定的参数也变为用户定义位编号。

④ 当数据处于被选择状态时显示 [Remote data selection] 对话框。请点击

[OK] 按钮或 [Cancel] 按钮。

⑤ 可确认对不同的参数设定值也可使用同一远程数据的设定。
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● 多个参数设定值使用同一远程数据、停止1个参数设定值使用时的步骤

多个参数设定值使用的远程数据中只停止 1 个参数时的步骤的说明。例如，

与同一远程数据被多个参数设定值使用的步骤相同，逻辑运算功能的 1(输入 )
及 2( 输入 ) 的输入分配 A 中，使用同一远程数据。

①   经过了 ●同一远程数据作为多个参数设定值使用的步骤的作业，当作同

一远程数据被选择。只对一侧的参数设定值终止使用远程数据时，可点击

其它参数设定值的组合框的下箭头。

② 在组合框上可确认远程数据被选择。

③   组合框上把远程数据设为未分配编号的用户定义位或变更为用户定义位

以外的选择，只把参数的使用变更为本地数据。( 下述的例中，ON/OFF
总选择为 0(Off))
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④ 可确认仅一侧的参数设定值的使用数据设定为本地数据。
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● 同一远程数据被多个参数设定值使用时清除全部远程数据的步骤

清除由一个以上的参数设定值使用的全部远程数据的步骤的说明。

与基本步骤相同，逻辑运算功能的输入分配 A 中使用同一远程数据的例。

①   经过了 ●同一远程数据作为多个参数设定值使用的步骤的作业，当作同

一远程数据被选择。只对一侧的参数设定值终止使用远程数据时，可点击

其它参数设定值的组合框的下箭头。

② 在组合框上可确认远程数据被选择。

③   上记②的状态下，清除第 2 级别的选择状态的名称 ( 上记例中 D25_2 的

DI1 端子的状态 )。

③ -1 在 [Remote data confirmation] 信息框上点击 [Yes] 按钮。 

③ -2 在 [Remote data selection] 对话框上点击 [Clear] 按钮。
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④ 从所有的参数设定值上可确认远程数据的分配被清除。

 参 考
•  使用不同编号的用户定义位 /用户定义数值，如果使用了同一远程数

据的场合，请对各项进行清除处理。

•  清除处理后，参数设定值与所使用的同一编号的用户定义位 /用户定

义数值相同。该用户定义位 /用户定义数值中分配不同的远程数据时，

使用了同一编号的用户定义位 /用户定义数值的全部参数设定值可使

用该远程数据。

● 从 [Remote data selection]组合框清除远程数据的使用的步骤

•由组合框的第 2 级别选择要清除的编号后右键→执行清除。
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■ 模块间数据传送一览的显示

是模块间数据传送的设定内容用一览方式显示的功能。

 参 考
•  模块间数据传送功能的详细内容请参阅 

 计装网络模块NX 使用说明书　网络设计篇CP-SP-1313C第5章　模

块间数据传送功能。

 使用上的注意事项
  模块间数据传送一览是设定内容可用一览方式确认的画面。进行设定的变

更的场合，请参阅  ■模块间数据传送功能的设定 (6-21页 )。

①  在 [Project]窗口的项目树上选择作为对象的 [workgroup]的下面的层。

②  选择 [Project]窗口菜单的 [View] → [Display the list of data transfer between 
modules]。

③  [List for data transfer between modules] 对话框上显示工作组内的模块间

数据传送的设定内容。
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[List for data transfer between modules] 对话框

● Title Bar
表示组名。

● Module name (No.)
表示模块名称及模块构成画面的编号。

● Connections
表示模块的收信连接数及送信连接数的合计。

● Connections (reception settings)
表示模块的收信连接数。

● Bits
表示模块收信的用户定义位的总数。

● Numbers
表示模块收信的用户定义数值的总数。

● Connections (transmission settings)
表示模块的送信连接数。

● Records
模块送信的参数的总数。

● [Detailed reception settings]按钮

表示选择的模块的 [Detailed reception settings] 对话框。收信连接数为 0 的

场合无效。

● [Detailed transmission settings]按钮

表示选择的模块的 [Detailed transmission settings] 对话框。送信连接数为 0
的场合无效。

● [To clipboard]按钮

把显示的内容复制到剪贴板上。

● [Close]按钮

关闭 [List for data transfer between modules] 对话框。
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[Detailed reception settings] 对话框

[Detailed reception settings] 对话框是可变更大小的对话框。显示宽度不足

等的场合，可变更大小。

● Title bar
表示模块名。

● Reception parameter name
表示收信侧模块接收数据的写入目标的参数名。

● Receiving bit/number
表示引入收信侧模块接收到的数据的用户定义数值、用户定义位。此处引入

的数据写入由「Reception parameter name」所示的参数中。

● Transmitting module name (No.)
表示送信侧模块的模块名及模块编号。

● Transmission parameter name
表示从送信侧模块发送的参数名。

● Group title
表示由送信源模块单位把数据组化、送信源模块名及收信数据数。可由组标

题左边的按钮对对应模块的显示状态进行切换。

● [Grouping] 复选框

显示 / 隐藏组标题的切换。

● [To clipboard] 按钮

把显示的内容复制到剪贴板上。

● [[Close] 按钮

关闭 [Detailed reception settings] 对话框。
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[Detailed transmission settings] 对话框

[Detailed transmission settings] 对话框是可变更大小的对话框。显示宽度不

足等的场合，可变更大小。

● Title bar
表示模块名。

● Transmission parameter name
表示送信的参数名。

● Receiving module name (No.)
表示收信侧模块接收数据的写入目标的参数名。

● Receiving bit/number
表示引入收信侧模块接收到的数据的用户定义数值、用户定义位。此处引入

的数据写入由「Reception parameter name」所示的参数中。

● Reception parameter name
表示收信侧模块接收数据的写入目标的参数名。

● Group title 
表示由送信源模块单位把数据组化、送信源模块名及收信数据数。可由组标

题左边的按钮对对应模块的显示状态进行切换。

● [Grouping]复选框

显示 / 隐藏组标题的切换。
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● [To clipboard] 按钮

把显示的内容复制到剪贴板上。

● [Close] 按钮 
关闭 [Detailed transmission settings] 对话框。

 使用上的注意事项
  对应的模块不存在（读入的数据中不存在对象模块等）的场合，将在相应

的项目上显示警告。把鼠标放在警告显示的图标上时会显示警告内容。
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■ 逻辑运算窗口的显示

把逻辑运算的设定内容用一览方式显示的功能。

① 选择 [Logical Operation] 参数库。

② 选择 [Project] 窗口菜单工具的 [Edit] → [Logical Operation defined 
window displayed]。

③ [Logical Operation] 窗口上显示逻辑运算的设定内容。
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■ 折线图窗口的显示

显示折线表的设定内容的功能。

① 选择 [Linearization table] 参数库。

② 选择 [Project] 窗口菜单工具的 [View] → [Display line graph]。

③ [Broken line graph] 窗口上显示折线的设定内容。
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■ 设定多回路协调控制的方法

从项目树选择管理员模块的 [Coop ctrl(set by group)]。

点击内容区域的组设定一览上显示的 [Set/Edit] 按钮。

显示执行协调控制的详细设定画面，进行设定。

详见

管理员模块 NX-S11/12/21 使用说明书 功能说明篇 CP-SP-1324C。
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■ 数据检查

[Project] 窗口上在项目打开的状态下，从菜单栏选择 [Edit] → [Data check]
后，检查项目中登录的全模块的参数的设定范围。

数据检查的结果没有问题的场合，显示如下。

结果有问题的场合，显示如下的 [Data check] 信息框。

 参 考
•设定范围通常是在输入时进行检查，但由于上限、下限的变更、小数点位

置的变更及其它的设定的设定范围有变化的场合，将进行范围检查。 在错

误显示中，各行上输出的信息组如下。

No. 说　明

1 映射信息的模块的 IP 地址

2 模块的名称

3 参数设定值的类别名

4 参数设定值的库名

5 参数设定值的项目名

6 错误信息
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6 - 4 映　射

■ 概　要

把由工作组构成的模块与实际的模块相互关联称为映射。

映射信息为模块通讯设定。

映射信息是由 [Project] 窗口的项目树的 [Mapping] 执行设定。

当使用的模块存在的场合，经由实际模块构成扫描功能获取模块构成或实际

模块的通讯设定并可自动设定映射信息。

模块通讯设定由 [Actual module configuration] 窗口定义及向模块写入。

当使用的模块不存在的场合，通过该映射，可预先作为映射信息进行模块通

讯的设定。

■ 映射的制作

映射可经由项目的制作或经由实际模块构成扫描功能制作，通常不需要本项

作业。

要删除映射新建的场合 , 按以下操作。

① 在 [project] 窗口的项目树中，选择制作映射信息的工作组的 [Mapping]。
请确认 [List] 画面上映射信息为空，选择 [Add]。
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■ 映射信息的编辑 
由实际模块构成扫描功能获取模块构成或实际模块通讯设定的场合，可自动

设定映射信息，所以不需要本项说明的作业。

离线制作项目的场合，虽可制作映射，但映射信息为未设定的状态。

要编辑映射信息时请按如下步骤执行。

① 在 [Project] 窗口的项目树中选择工作组的 [Mapping]。请确认 [List] 画面

上显示有映射信息，点击 [Edit] 按钮。

② 显示 [Individual Mapping] 画面。
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③ 设定 IP 地址、节点 ID。可点击文本框直接输入。另外，点击 [Automatic 
numbering] 按钮，在 [Automatic module numbering] 对话框中设定起始

IP 地址、节点 ID， 点击 [OK] 按钮后，可进行连续编号的设定。

 参 考
•工作组 ID是当多个工作组在同一网络中存在的场合，用于识别用。

■ 通讯设定的编辑、管理

模块的 IP 地址、节点地址以外的通讯设定由映射显示的 [Set communication]
设定。

可设定的内容如下。

设　定 设定的画面

分　类 设定名 内　容 一览
(6-42页 )

个别映射 
(6-43页 )

模块基本
设定

全模块中设定下一个值 禁止地址自动添加编号功能对全模块 
执行的场合，复选。

○ －

禁止地址自动添加编号 去除地址自动添加功能的对象 ○ ○

IP设定 子网掩码 IP的子网掩码 ○ －

缺省网关 IP的缺省网关 ○ －

端口设定 全模块中设定下一个值 端口设定的内容要适用于全模块的场合，
复选。

○ －

专用通讯端口编号 不可变更 ○ ○

MODBUS/TCP端口编号 MODBUS/TCP功能的端口编号 ○ ○

CPL/TCP端口编号 CPL/TCP通讯功能端口编号 ○ ○

RS-485
详细设定

全模块中设定下一个值 RS-485设定的变更适用于全模块的场
合，复选。

○ －

RS-485机器地址 上位通讯 (RS-485)使用的机器地址 － ○

RS-485协议 上位通讯 (RS-485)的协议选择 ○ ○

RS-485传送速度 上位通讯 (RS-485)使用的传送速度 ○ ○

RS-485位长 上位通讯 (RS-485)使用的位长 ○ ○

RS-485校验有无 上位通讯 (RS-485)有无使用校验 ○ ○

RS-485停止位 上位通讯 (RS-485)使用的停止位 ○ ○

RS-485最小应答时间 上位通讯 (RS-485)使用的最小应答时间 ○ ○
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● 进行工作组共通的通讯设定的场合

以下对步骤进行说明。

① 在 [project] 窗口的项目树上，选择编辑映射信息工作组的 [Mapping]。
在 [List] 画面确认工作组构成为空，点击 [Set communication] 按钮。

② 显示 [Communication settings (all)] 对话框。

请设定必要的项目，点击 [OK] 按钮。
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● 对模块个別进行通讯设定的场合

按以下的步骤进行说明。

① 在 [Project] 窗口的项目树上选择编辑映射信息的工作组的 [Mapping]。
请确认 [List] 画面上工作组构成为空，点击 [Edit] 按钮。

②  在 [Individual Mapping]画面上当模块行处于选择的状态下，请点击 [Set 
communication] 按钮。
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③ 显示 [Communication settings (module)] 对话框。

请设定必要的项目点击 [OK] 按钮。

■ 用编辑的映射信息与实际模块的对应 
在无使用模块的情况下把模块通讯设定 (IP 地址 / 节点地址、通讯设定等 ) 作
为映射信息进行设定的场合，在模块使用时需要那映射信息写入实际模块中。 
以下对步骤进行说明。

① 显示写入的映射信息。

请在 [List] 画面上确认显示有映射信息，点击 [Edit] 按钮，使 [Individual 
Mapping] 画面显示。

请点击 [Individual Mapping] 画面的 [Acquisition of actual module 
configuration] 按钮。

② [Actual module configuration] 窗口被启动。

请执行实际模块构成扫描。

③ 由实际模块构成扫描确认实际的模块及错误后，关闭 [Actual module 
configuration] 窗口返回 [Individual Mapping] 画面。
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 参 考
•  有关错误信息，请参阅 

■ 信息一览 (5-16页 )。

④ 内容区域的 [Actual module configuration] 上显示由实际模块构成扫描功

能获取的实际模块构成信息。

* 请选择串。

⑤   通过把映射信息的模块 ( 映像图 ) 拖放到实际模块构成的模块映像图上，

映射信息与实际模块构成信息对应。对应 ( 映射 ) 后，实际模块构成上显

示的模块 ( 映像图 ) 的颜色从灰色变为黑色。

 
拖放
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 使用上的注意事项

•  模块基础型号 (模块类型 )不符的场合不能拖放。这种场合，需要在模

块构成显示上变更模块类型或变更实际的模块。在项目的模块型号中，

点击模块构成画面，确认制品型号的行。在实际的模块中，点击实际模

块构成画面的模块，确认制品型号的行。

 参 考
• 有多个工作组的场合，请根据需要对全部的工作组进行同样的操作。

•  用 [Shift]+点击 选择多个模块，通过拖放可对多个模块总括对应 (映
射 )。

•  本项的作业只是编程器上的对应。(不向实际模块进行写入。) 
写入实际模块的场合，通过 [Actual module configuration]窗口对实际

模块通讯设定进行写入作业。
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6  -  5 参数的写入

向模块写入参数可选择从工作组总括写入或按模块个别写入之一的方法。

 使用上的注意事项
•  满足如下条件的场合，当参数写入结束后，模块将被复位 (再启动 )。请确

认运转状况后作业。

• 对NX-D15/25，ROM版本1.xx的场合

• 管理员模块或管理员模块管理下的模块的场合 

• 把由管理员模块管理的调节器模块取消由管理员模块管理的场合

• 对NX-D25/35，当扫描周期参数的设定与模块中设定的值与项目的值不

同时。

对不满足上记条件的模块 (NX-D15/25 ROM 版本2.00与上记条件不符的场

合及数字 /脉冲输入模块 )，在参数写入中，模块的机器运行模式变为 IDLE
模式。

NX-D15/25/35的ROM版本，在SLP-NX的项目树上选择执行参数读出的对

象模块，在「其它」类别的「仪表信息」 库中作为「F/W ROM 版本1」 参数，按

「2.00」的形式显示。这种场合，ROM版本为Ver2.00。

■ 工作组总括写入

是工作组单位的参数的写入方法。

是工作组单位的总括参数写入是经由以太通讯的写入。( 不对应经由 USB 编

程器电缆的写入 )。
请事先进行通讯路由或网络配置的设定。

① 在 [Project] 窗口的项目树上选择执行总括参数写入的工作组。

通过以下操作方法之一，可向工作组所属模块中进行总括参数写入。 

•选择工作组显示的内容区域 [Operation list] 的 [3:Parameter writing] 

•选择 [Project] 窗口菜单工具的 [Online] → [Write Parameters]

•点击 [Project] 窗口树的  图标 
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② 显示 [Confirmation of parameter write] 信息框，点击 [Yes] 按钮后写入参

数。

③ 在参数写入中，显示 [Progress] 对话框。

④ 写入正常结束后，显示 [Parameter sending complete] 信息框，点击 [OK]
按钮结束。

异常结束的场合，显示错误信息。

请根据错误状况进行相应处理后，再次写入参数。
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■ 单一模块的写入

是按模块为单位的参数的写入方法。

向单一模块的参数写入是经由以太通讯或经由 USB 编程器电缆之一的方法

进行写入。请事先设定通讯路由或网络配置 ( 以太通讯的场合 )。

 使用上的注意事项
•  USB编程器电缆经由的设定时需要事先安装USB驱动，请参阅 

1-4 USB编程器电缆设备驱动的安装 (1-12页 )。

•  仅当项目为单个模块构成时才能用USB编程器电缆的通讯路由进行设定。

多个模块构成的项目的场合，不可使用USB编程器电缆。

•  使用模块间数据传送功能的场合，项目需要由多个模块构成。为了使模块

相互间执行数据交换，模块间数据传送功能需要设定执行该功能的设定信

息。 
如果作为单一模块进行参数的读出、其后再执行写入的话，则模块间数据

传送功能会产生意图不明的动作，请勿这样执行。

①   在 [Project]窗口的项目树上选择执行参数写入的模块，按以下方法之一进

行操作，可把参数写入模块中。

• 选择工作组显示的内容区域 [Operation list]的 [3:Parameter writing] 

• 选择 [Project]窗口菜单工具的 [Online] → [Write Parameters] 

•   选择 [Project]窗口工具栏的  (经由以太通讯场合 )或  (经由USB
编程器电缆的场合 )图标

②   以后的操作与 ■工作组总括写入相同，请参阅 
6-47 页。
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 使用上的注意事项
根据写入对象模块的选择或组合，会显示以下的警告。

 不能写入的型号

在型号对话框上需要变更时实际的型号。

  单一选择已经设定了模块间数据传送的模块试图写入的场合。

请选择工作组、再次执行写入。

  单一选择多回路控制使用的模块试图写入的场合

请选择工作组、再次执行写入。
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 模块版本不同

实际模块的模块版本比项目中保存的模块版本旧。需要进行版本一致的操

作，请参阅 6-8 模块版本处理　(6-60 页 )。
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6 - 6 模块动作的监视

■ 概　要

模块动作的监视由 [Universal Monitor]窗口执行。详见

7章 综合监视。

 使用上的注意事项
•  综合监视的参数的变更是对模块的变更。编程器的项目数据不会变更。需

要反映到项目数据中的场合，请执行参数的读出。

■ 操作方法

在此简要地对这一系列作业方法进行说明。

①   在 [Project] 窗口的项目树上选择工作组，执行工作组显示。以下操作

之一可启动综合监视。

• 选择内容区域 [Operation list] 的 [4:Monitor] 

• 选择 [Project] 窗口菜单工具栏的 [Online] → [Monitor]

• 选择 [Project] 窗口工具条的  图标

≫显示综合监视启动的对话框。
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② 启动处理结束后，显示 [Universal Monitor] 窗口。

③   从 [Universal Monitor] 窗口菜单工具选择 [Monitor] → [Start] 后，状态栏

的通讯状态从 [Wait] 变为 [OK]，开始监视动作。

• 监视开始操作
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•监视开始后

( 通过 [Module configuration] 窗口的监视树的模块构成选择了监视模块的

场合 )

④ 要变更某个模块的参数或动作状态时，通过 [Universal Monitor] 窗口

的监视树选择对象模块，显示数值监视的设定选项卡，双击数值格上要变

更的目标，通过显示的 [Writing online] 对话框变更值，点击 [OK] 按钮后

即变更。
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⑤ 要停止监视动作时，可选择 [Universal Monitor] 窗口菜单工具栏的

[Monitor] → [Stop]。

⑥ 要停止监视动作时，显示是否输出 CSV 格式的趋势日志文件的 [Universal 
monitor information] 信息框。

需要趋势日志文件的场合，请点击 [Yes] 按钮。

 参 考
 • 也可点击 [No]按钮制作CSV格式的趋势日志文件。

①   [Universal Monitor] 窗口菜单工具栏的 [File] → [Log file conversion]。 
≫显示 [Open log file] 对话框。

②   请选择要输出 CSV 格式的趋势日志文件，点击 [Open] 按钮。 
≫显示 [Save As] 对话框。

③   请点击 [Save] 按钮。 
≫�显示CSV格式的趋势日志文件被制作的 [Universal monitor information]

信息框。

④   点击 [Yes] 按钮后，浏览器被启动。

 



6-56

第 6 章　参数的设定

⑦ 要关闭综合监视时，请选择 [Universal Monitor] 窗口菜单工具栏的 [File] 
→ [Exit]。
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6  -  7 参数的读出

■ 概　要 
从模块中读出参数的方法可选择工作组总括读出或模块个别读出之一。

■ 工作组总括读出

是读出以工作组为单位的参数的方法。

总括读出以工作组为单位的参数是经由以太通讯实现的。( 不可经由 USB 编

程器电缆读出。)
请事先设定通讯路由或网络日志文件。

① 在 [Project] 窗口的项目树上选择要总括读出的工作组。可用下述之一的

操作，总括读出工作组所属模块的参数。

• 选择工作组显示的内容区域 [Operation list] 的 [5:Parameter reading] 

• 选择 [Project] 窗口菜单工具的 [Online] → [Read Parameters] 

• 选择 [Project] 窗口工具栏的  图标 

② 显示 [Confirmation of parameter reading] 信息框，点击 [Yes] 按钮后读出

参

数。
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③ 在参数读出中显示下述的 [Progress] 对话框。

④ 正常读出结束后，显示 [Parameters received] 信息框，请点击 [OK] 按钮。

异常结束的场合，在信息框上显示错误信息。

请根据错误状况进行相应的处理后，再次执行参数的读出。
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■ 从单一模块读出

是读出以模块为单位的参数的方法。

从单一模块读出参数读出是经由以太网或经由 USB 编程器电缆之一的方法

进行读出。请事先进行通讯路由或网络日志文件 ( 以太网络的场合 ) 的设定。

 使用上的注意事项
•  经由USB编程器电缆进行设定时，需事先进行USB驱动的安装，请参阅

1-4 USB编程器电缆设备驱动的安装 (1-12页 )。

•  仅当项目为1个模块构成时才可经由USB编程器电缆的通讯路由进设定。

多个模块构成的项目的场合，不可使用USB编程器电缆。

•  使用模块间数据传送功能的场合，项目需要由多个模块构成。为了使模块

相互间执行数据交换，模块间数据传送功能需要设定执行该功能的设定信

息。  
如果作为单一模块进行参数的读出、其后再执行写入的话，则模块间数据 
传送功能会产生意图不明的动作，请勿这样执行。

①   在 [Project] 窗口的项目树上选择执行参数读出的模块，按以下方法之一

操作，可从模块读出参数。

• 选择内容区域的 [Operation list] 的 [5:Parameter reading]

• 选择 [Project] 窗口菜单工具的 [Online] → [Read Parameters]
•  选择 [Project] 窗口树的 ( 经由以太通讯的场合 ) 或 ( 经由 USB
编程器电缆的场合 ) 图标。

②   以后的操作与 ■ 工作组总括读出相同。 
请参阅 6-57页。
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6 - 8 模块版本的管理

NX 模块中有管理参数兼容性的模块版本。

在此对 SLP-NX 作为项目保存的模块版本与参数读写对象的实际机器的模块版本的关系及操作方法进行说

明。

编程器与模块的模块版本的关系

编程器离线制作的项目是按编程器识别到的最新的模块版本制作。另外，模

块单独具有各自的模块版本。参数写入时的动作如下。

  实际模块的模块版本比项目中保存的模块版本新或相同的场合，可向模块

写入。编程器不支持实际模块的模块版本的场合，则向模块写入时会显示

[Parameter initialization module selection] 的对话框。

  实际模块的模块版本比项目中保存的模块版本旧的场合，向模块写入时会

产生错误。与模块可通讯的环境的场合，使用模块版本对照功能可变更项

目的模块版本。模块不存在的场合，可通过 [Module model number setting 
(controller)] 对话框的 [Change version] 按钮事先变更模块版本。

执行参数读出时，项目中保存的模块版本是实际模块的模块版本。

当变更了项目的模块版本后执行数据检查或参数写入时，则转换为该模块版

本对应的参数的集合。

■模块版本对照

①   请选择 [Project] 窗口的 [Online] → [Compare module versions]。



6-61

第 6 章　参数的设定

②   从画面左侧的工作组一览选择工作组。 
≫   显示工作组的模块一览、创建的模块的名称、型号、IP 地址、项目的

模块版本。此时，由于未从模块获取信息，所以实际模块的模块版本、

差异、不支持栏处显示「Not retrieved」或空白。

③   把对照对象模块的对象复选框置为勾选状态，点击 [Online retrieval] 按钮。

通过 [Select all] 按钮、[Deselect all] 按钮，可选择对象列的全部或解除

全部选择状态。

≫�对象模块获取模块版本信息，把信息反映到「Actual module ver.」、
「Difference」、「Not supported」的列上。
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 参 考
  「Difference」 列当项目Ver与实际模块Ver有差异的场合，显示写入

可能 /不可能。编程器不支持的模块版本的场合，如以下画面所示，

将在 「Not supported」 列处显示 「*」 标记。

④  把从实际模块获取的模块版本反映到项目版本中的场合，点击 [Apply to 
Project ver.] 按钮。

≫�模块版本相关的信息反映到项目中。
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 参 考
  在 [Compare module versions]对话框上执行了 [Apply to Project ver.]
的场合，通过最初在数据检查或参数写入时执行数据检查处理，可适

用于实际的参数的增减。

  对编程器不支持的模块版本执行了 [Apply to Project ver.]的场合，将

显示以下的信息。

另外，反映到项目中后，[Compare module versions] 对话框变为以下的

显示。
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■ [Change version]对话框

实际机器的模块不存在的状态等时，可事先从 [Change version] 对话框变更

项目的模块版本。

①   通过模块一览使对象的模块的行在选择的状态下，点击 [Set model number]
按钮。

≫ 显示 [Module model number setting] 对话框。

② 点击 [Change version] 按钮。

≫   可变更的模块版本显示在清单中，选择并点击 [OK] 按钮、点击 [Module 
model number setting] 对话框的 [OK] 按钮后，项目中保存的模块版本被

变更。

 参 考
•  用 [Change module version]对话框变更了模块版本的场合，通过执行■数

据检查　(6-38页 )可适用于项目中保存的实际参数的增减。

 使用上的注意事项
  通过 [Module configuration]画面的 [Initialize]按钮执行初始化时，项目的模

块版本变更为编程器识别到的最新模块版本。
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 使用上的注意事项
 读出编程器不支持的模块版本的模块时，会显示以下警告。

  对编程器不支持的模块版本执行参数写入时，毎次都会显示以下警告对话框。

≫可把编程器未识别的参数追加进行初始化。不需初始化的模块的背景变为

黑色。判断为需要初始化的不支持的模块版本将显示 [Initialization target]
复选框、显示全部初始化对象的状态的对话框。点击个别选择 /解除选择

[Initialization target]复选框或点击 [Select all]按钮或 [Deselect all]按钮、选

择 [Initialization target]的模块。点击 [Continue]按钮后，将对初始化对象

模块进行初始化、同时开始写入参数。未带复选框的模块或背景为黑色的

不需初始化的模块，将不初始化而执行参数的写入。

 使用上的注意事项
  只要有1个初始化对象的模块存在，则参数写入需要花费的时间最多为2分

钟左右。
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■ 概　要

对把项目作为文件保存的方法进行说明。

■ 操作方法

① 项目文件的保存方法可用如下方法之一。

• 选择 [Project] 窗口菜单工具的 [File] → [Save]

• 选择 [Project] 窗口菜单工具的 [File] → [Save as]
• 点击 [Project] 窗口工具栏的  图标

②   新保存及另存为的场合，显示 [Save project] 对话框。请设定保存内容 ( 名
称、场所 )、点击 [OK] 按钮。

③ 保存正常结束后，显示 [Save project] 信息框，请点击 [OK] 按钮。

6 - 9 项目的保存
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 使用上的注意事项
 项目名中不能含以下的文字。

.（半角句号）

:（冒号）

"（引用符）

<>（不等号）

｜（纵线）

/（斜杠）

¥（元符号）

?（问号）

*（星号）

 参 考
•  项目文件由文件夹 (多个文件 )构成。需要把项目文件向其它场所移动等时，

请对文件夹进行操作。
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■ 概　要

保存的项目可再次用编程器打开。

■ 操作方法

① 打开项目文件时可采取如下的方法之一。

• 选择 [Project] 窗口菜单工具的 [File] → [Open]
• 点击 [Project] 窗口工具栏的  图标

② 项目已经打开的场合，显示 [Confirmation of opening] 信息框。

关闭已打开的项目的场合，请点击 [Yes] 按钮。

不关闭打开的项目的场合，请点击 [No] 按钮。

 参 考
•  当③以后的作业被取消的场合，即使点击 [Yes]按钮继续作业，打开

的项目也返回被打开状态。

6 - 10 打开项目
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③   显示 [Open] 对话框。 
前次保存的项目存在的场合，该项目作为初始值被指定。 
如果前次保存的项目完好，则直接点击 [Open] 按钮，要打开其它项目的

场合 , 请指定该项目点击 [Open] 按钮。 
要终止的场合，请点击 [Cancel] 按钮。

④   项目文件的读出完成后，显示 [Reading projects] 信息框，点击 [OK] 按钮

后，显示工作组。
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■ 概　要 
可把项目中登录的所有模块的参数设定 ( 含 IP 地址等信息 )CSV 格式的文件

输出。

■ 操作方法 
① 请选择 [Project] 窗口的菜单工具的 [File] → [CSVoutput]。

② [Save as] 对话框中指定 [Location]、[File name]，选择 [Save]。输出

CSV 格式的文件。

各行输出的信息组如下。

No. 信息组名 说　明

1 IPAddress 映射信息的模块的 IP 地址

2 WorkgroupID 映射信息的模块的工作组 ID
3 WorkgroupName 工作组的名称

4 ModuleName 模块的名称

5 ModuleType 模块的型号

6 NodeID 映射信息的模块的节点 ID
7 FolderName 参数的类别名

8 BankName 参数的库名

9 Name 参数的项目名

10 Number 同一参数的连号

11 DataType 参数的数据型

12 RAM Address 由上位通讯访问时的 RAM 用地址

13 EEPROM Address 由上位通讯访问时的 EEPROM 用地址

14 Value 设定值

15 DefaultValue 初始值

16 Diff 与初始值的差异 用 [ ＊ ] 符号输出

6 - 11 输出 CSV 文件
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 使用上的注意事项
  请在项目名、位号名等文字列中只输入 SHIFT JIS 的文字列。 
例如，输入 UNICODE 等 SHIFT JIS 的文字列以外的文字时，CSV 输出功

能等会产生乱码。

 参 考
•  CSV文件输出的输出参数与显示级别对应。有关显示级别，请参阅 

6-3 参数的编辑 (6-16页 )及各模块的使用说明书。



MEMO
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7  -  1 监视功能概要

在本机的状态监视、参数变更等试运行作业时或运转后确认动作时使用综合监视。

 使用上的注意事项
•  综合监视不具有按24小时动作的通用的数据记录功能。 

在试运行调整等场合，请临时用于监视。 
请勿把综合监视的功能用于长期数据收集或连续的警報监视等。 
由于综合监视不是以长期动作为目的的应用软件，综合监视的长期运停止

数据收集或综合监视长期运行的PC的高负荷会对其它应用软件产生影响以

及引起硬盘剩余容量不足等可能性。 
在综合监视的监视动作中，请注意PC的电源选项设定不要为停止状态或备

用状态。另外，即使不执行连续动作的场合，也请在确认硬盘的剩余容量后，

适当移动日志文件以确保硬盘有足够的剩余容量。

■ 综合监视的流程

综合监视的启动 
7-2页 

综合监视窗口 
7-3页 
· 监视的简单操作 
· 各种窗口 
· 监视的执行 

各种设定 
7-28页 
· 设定用对话框 
 
 
用户监视 
7-33页 
· 监视对象的定制 

离线 
7-42页  
· 已收集的趋势日志的 
 再现及分析  

趋势备忘录 
7-40页 
· 向趋势曲线的 
 备忘录登录/一览 
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7 - 2 综合监视的启动

综合监视请按下述步骤之一启动。

• 在 [Project] 窗口的工作组显示上，从内容区域的 [Operation list] 选择 [4:Monitor] 

• 在 [Project] 窗口菜单栏上，选择 [Online] → [Monitor]

• 点击 [Project] 窗口工具栏上的  图标

下图是选择 [Project] 窗口菜单栏的 [Online] → [Monitor] 后的显示例。 

启动综合监视后，显示如下的窗口。

 参 考
•  综合监视的显示级别在综合监视启动时动作。要变更综合监视的参数显示

级别的场合，执行显示级别的变更 (6-3 参数的编辑 6-16页 )，请先关闭综

合监视后再重新启动。综合监视打开的情况下，即使模块构成发生变更，

变更的内容也不会再综合监视上反映出来。模块构成变更时（6-2 模块构成

的定义 6-11页），请先关闭综合监视后再重新启动。

•  关闭 [Universal Monitor]窗口时，会记忆各窗口的位置，在下次启动时，

各窗口会在同一位置显示。
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7  -  3 综合监视窗口

[Universal Monitor] 窗口画面的构成如下。

[Universal Monitor] 窗口上显示的各窗口名称及功能如下。

窗口可在悬浮窗口与固定窗口间切换。

● [Monitor tree]窗口

与 [Numeric monitor] 窗口联动，显示监视对象模块或组的一览并选择。

● [Trend monitor]窗口

各监视对象的数据用实时图显示。

● [Trend group]窗口

[Trend monitor] 窗口的曲线的显示 / 不显示、颜色、显示最新的数据值。

● [Bit display monitor]窗口

显示由监视树选择的模块的位显示对象参数。

● [Alarm monitor]窗口

报警的状态在格内显示，报警发生时会自动显示在前面。

另外，把鼠标的光标置于 [Alarm monitor] 选项卡上时，[Alarm monitor] 窗
口会显示在前面。

● [Numeric monitor]窗口

监视树所选择的模块及回路的参数在格内显示、置为可变更。点击 [Numeric 
monitor]选项卡后，显示 [Numeric monitor]窗口。

 

数值监视[监视]选项卡 
数值监视[设定]选项卡  

[位显示监视]  [监视树] [趋势监视]  [趋势组]  

标题栏 
菜单栏 
工具栏 

[报警监视]选项卡  

类别 
个别单位 

状态栏 

[十字线数据]选项卡  数值监视及十字线数据 
[数值监视]选项卡  
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 使用上的注意事项

•  选择 [Numeric monitor]窗口 [Setting]选项卡后，显示可变更的格。用

[Monitor] 选项卡不能进行变更。另外，某些参数不能变更。详见 
各模块的使用说明书。

● [Crossline data]窗口

点击 [Crossline data] 选项卡时显示。显示 [Trend monitor] 窗口上的十字线

光标的值。监视停止中时也可使用。

■ 菜单构成一览

菜单 子菜单1 子菜单2 内　容 备　注

File Log file Open log file 读出日志文件 (CSV格式 )、显示趋势监视 仅监视停止中时有效

Open log file 
[Multi-time mode]

读出多个日志文件 (CSV格式 )，如果存在同 
一数据类型的场合，则组化。

Log file 
conversion

－ 文件选择后，选择输出格式
详见 ■日志文件转换 (7-43页 )

Custom data 
processing

Import 从文件选择对话框选择用户数据文件 (XML格
式 )，追加到用户项目中。

Export 把现在用户监视中登录的项目写入用户数据 
文件 (XML格式 )中

Copy graph to 
clipboard

－ 把趋势监视的绘图区域复制到剪贴板

Start control 
profile

－ 不支持 －

Exit － 关闭综合监视 仅监视停止中时有效

Monitor Start － 开始监视 仅监视停止中时有效

Stop － 停止监视 (不清除曲线 ) 
监视停止后显示 [Universal monitor information]
对话框，显示趋势日志的CSV文件输出是否执
行。

在监视 「Start」 处理前，
曲线不会清除

Settings Edit monitoring 
data

－ 详见  7-7 用户监视 (7-33页 ) 仅监视停止中时有效

Communication 
destination

－ 详见  ■ 通讯目标 (7-28页 )

Monitor settings － 详见  ■ 监视设定 (7-28页 )

Trend color 
settings

－ 详见  ■ 趋势监视色设定 (7-30页 )

Options － 详见  ■ 选项 (7-31页 )

Record View trend memo － 详见  7-8 趋势备忘录 (7-40页 ) －

Trend memo 
registration

－ 详见  7-8 趋势备忘录 (7-40页 ) －
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菜单 子菜单1 子菜单2 内　容 备　注

Window Fixed-position 
window

－ 可设定各窗口可否悬浮显示 检查形式设定ON/OFF

Return to standard 
position

－ 各窗口的显示位置返回标准位置 仅窗口固定菜单为OFF的
场合才有效

View Monitor tree 显示 [Monitor tree]窗口 已经显示的场合置为激活
状态Trend monitor 显示 [Trend monitor]窗口

Crossline data 显示 [Crossline data]窗口

Trend group 显示 [Trend group]窗口

Numeric monitor 显示 [Numeric monitor]窗口

Alarm monitor 显示 [Alarm monitor]窗口

Bit display 
monitor

显示 [Bit display monitor]窗口

Logical operation 
monitor

显示 [Logical operation definition]窗口 

Favorite Add to favorites 登录现在的窗口构成 －

Organize 
favorites 

变更或删除收藏夹中登录的窗口构成的名
称

－

Help Show help － － 不显示任何内容

About (version info) － 显示 [Version]对话框 －

 使用上的注意事项

•  用户数据处理的导入时，确认是否节点编号、IP地址、型号为一致。

如果不一致的场合，导入时会显示警告。 
选择 [Setting]→ [Edit monitoring data]，请确认用户监视的内容。 
详见 

7-7 用户监视 (7-33页 )。
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■ 窗口构成的操作

[Universal Monitor] 窗口由上下左右配置的多个窗口构成。

通过拖放这些窗口，可变更尺及悬浮、固定窗口。

● 窗口的固定化

通过操作 [Universal Monitor] 窗口菜单栏的 [Window] → [Fixed-position 
window]，将固定所有的窗口位置，禁止悬浮。

有勾选时 : 固定窗口。

● 返回标准窗口的位置

通过操作 [Universal Monitor] 窗口菜单栏的 [Window] → [Return to standard 
position]，所有窗口的位置将返回标准位置。

 使用上的注意事项

•  [Return to standard position]仅在没有勾选 [Fixed-position window]的
状态下才有效。

● 各窗口的再显示

操作 [Universal Monitor] 窗口菜单栏的 [Window] → [View]，所选择的窗口

显示在前面。

● 窗口位置的记忆

关闭 [Universal Monitor] 窗口时，会记忆各窗口的位置，在下次启动时，各

窗口在相同的位置处显示。

● 关闭各窗口

要关闭窗口时，请点击各窗口标题栏的  图标。
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7  -  4 监视的开始、停止

■ 开始监视

① 在 [Universal Monitor] 窗口菜单栏上选择 [Monitor] → [Start]。
≫开始监视。

② 选择 [Monitor tree] 的 [Module]。
≫显示 [Numeric monitor]、[Bit display monitor]。

 使用上的注意事项

•  在监视开始中，请勿对模块构成进行编辑或删除。要变更模块构成

的场合，请先关闭 [Universal Monitor]窗口，向模块写入后再次启动

[Universal Monitor]。

•  多个模块存在的环境下，用USB编程器电缆进行综合监视的场合，当

监视开始后，请勿变更USB编程器电缆与模块的连接 ,可重新启动

SLP或重 新打开项目。

■ 停止监视

① 请选择 [Universal Monitor] 窗口菜单栏的 [Monitor] → [Exit]。
≫显示 [Universal monitor information] 信息。

 参 考
•  即使选择 [No]按钮的场合 ,也停止监视。 
要重新启动监视的场合，请按 ■ 开始监视 的步骤执行。

•  即使选择 [No]按钮的场合，也可按以下的步骤，从后开始制作CSV
格式的趋势日志文件。

① 选择 [Universal Monitor]窗口菜单栏的 [File] → [Log file conversion]。

②   在显示的 [Open log file]对话框中选择要输出的CSV格式的趋势

日志文件。

③ 请选择 [Open]按钮。

④ 在 [Save As]对话框选择 [Save]按钮。
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②   要输出趋势日志文件的场合，请点击 [Yes] 按钮。 
≫�趋势日志文件 (CSV 格式 ) 制作完成，可用资源管理器打开保存的文件，

显示确认 [Universal monitor information] 信息框。

③   用资源管理器确认趋势日志文件的 CSV 格式文件时，请点击 [Yes] 按钮。 
≫用资源管理器显示输出的趋势日志文件 (CSV 格式 )。
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7  -  5 个别窗口的说明

■ 监视树窗口

监视树窗口如下。

● 显示项目 
 树状图上从左开始的顺序的显示如下。

 • [Data sampling switchover] 复选框

项目、工作组、模块的场合，显示 [Data sampling switchover] 复选框。未

作为收集对象的模块不进行数据收集，趋势曲线、趋势组、数值监视、位

显示监视、报警监视的显示不会更新。

 •项目、工作组的勾选状态

 图标 : 从项目或工作组内的所有模块进行数据收集

 图标 : 不从项目或工作组内的所有模块进行数据收集 

  图标 :从项目或工作组内的模块收集 /不收集数据混合存在的状态。

项目、工作组的复选变更只有收集 / 不收集 2 种选择。切换 收集状态时

点击图标部分。

 •模块的勾选状态

 图标 : 从模块收集数据

 图标 : 不从模块收集数据

切换收集状态时点击图标部分。

↗
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•模块通讯状态图标

根据与模块的通讯状态、模块状态，显示模块通讯状态的图标。

通过图标也可识别由管理员模块控制的模块。

通讯状态 模块状态
管理员模块管理下

不管理 管理

通讯待机 －

通讯切断 －

－ IDLE模式 (闪烁 ) (闪烁 )

－ RUN模式

－ 轻故障

－ 轻故障 /IDLE模式

－ 重故障

－ 初始化中

● 构　成

由 [Default] 选项卡及 [Custom] 选项卡构成。

 • [Default] 选项卡

根据工作组构成、各类别及各类别的个别单位显示。

 • [Custom] 选项卡

登录用户监视功能 (7-7 用户监视 7-33 页 ) 时，在 [Custom] 选项卡上显

示信息。

● 与数值监视窗口、位显示监视窗口的联动

选择各模块或各模块的类别后，[Numeric monitor] 窗口及 [Bit display monitor]
窗口会联动显示。
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● 右键菜单

菜单项目 功　能 备　注

Copy data 复制监视树的结构 －

Paste data 复制的结构粘贴到对应的结构中
仅当在 [Monitor tree]窗口上选择
了 [Custom]选项卡时才有效

－

Register to trend monitor 选择的树登录到趋势监视中 仅当在 [Monitor tree]窗口上选择 [Custom]
选项卡时才有效

Move to the relevant 
module

移动到在管理员模块的控制组中
选择的组所属的模块

仅当在 [Monitor tree]窗口上右键管理员模
块时才有效

Back to cooperative 
control

从登陆控制组的模块返回到管理
员模块

仅当在 [Monitor tree]窗口上根据 [Move to 
the relevant module]菜单移动时才有效

Set date and time 设定管理员模块的日期时间 仅当在 [Monitor tree]窗口上右键管理员模
块时才有效

Flash ROM backup and 
restore

把管理员模块的参数备份到闪存
ROM中、显示恢复对话框

仅当在 [Monitor tree]窗口上右键管理员模
块时才有效
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■ 数值监视窗口

在 [Numeric monitor] 窗口上，把选择了监视树的类别或各类别的个别单位

时的关联数据显示在格中。

例 ) 在调节器模块的监视树上选择模块时

● 显示数据

根据各类别备有显示的数据的样本，该数据由 [Monitor tree] 窗口的 [Default]
选项卡显示。

该样本中没有必要的数据的场合，请参阅

7-7 用户监视 (7-33 页 )，构建用户数据，用 [Custom] 选项卡显示。

● 右键菜单

菜单项目 功　能 备　注

Copy items 复制单元数据 选择行、列的标题时无效

Add copied items 把由 [Copy items]复制的数据追加
到数值监视 (用户的场合 )列的末
尾处

由监视树选择 [Custom]选项卡
仅当选择数值监视的列标题时才有效

History of PID parameter 
change*

确认变更后的PID的设定参数 －

Move to the relevant 
module

监视树及数值监视的显示切换成
协调控制的各控制组所属的调节
器模块

仅当选择协调控制的控制组的列时才有效

Back to cooperative 
control

监视树及数值监视的显示切换成
原来的协调控制的控制组

仅当由 [Move to the relevant module]菜
单切换显示后才有效

* PID 参数变更履历仅是对调节器模块时的功能。

● 设定选项卡、监视选项卡

[Numeric monitor] 窗口分为 [Setting] 选项卡与 [Monitor] 选项卡。

对 [Setting] 选项卡，只有在监视开始中才向模块写入可写的数据。

对 [Monitor] 选项卡，即使是向模块可写入的数据，在监视开始中数据也只

能作参考。
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● 数值格显示

对 [Numeric monitor] 窗口的各选项卡，由 [Monitor tree] 窗口所选择的类别

或对各类别的个别单位，其显示形式如下。

• 选择类别的场合

选择的类别的共通数据一览、各类别的个别单位的数据一览在 [Numeric 
monitor] 窗口上显示。

点击数值格的单元的场合，项目名用提示条显示。

•选择各类别的个别单位的场合

选择的各类别的个别单位的数据一览显示在 [Numeric monitor] 窗口上。

例 ) 在监视树上选择调节器模块的回路

● 值的编辑

监视开始的场合，在 [Numeric monitor] 窗口上，用 [Setting] 选项卡选

择

•点击格的单元时

或

•按 [Enter] 时
可在显示的 [Writing online] 对话框中进行值的设定。

点击 [Writing online] 对话框的 [OK] 按钮后，输入的值写入模块中。

点击 [ 取消 ] 按钮后，输入的值不会反映到 [Writing online] 对话框中。

另外，根据对象的值的数据类型，[Writing online] 对话框显示下述 2 种

内容之一。
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•根据数值输入的变更

在 [Writing online] 对话框的编辑框中输入数值，点击 [OK] 按钮，在对话框

被关闭时向模块写入值。

点击 [Cancel] 按钮的场合，不反映输入的值。

在点击 [OK] 按钮时对编辑过的值的上下限值进行检查，有超出范围的数据

的场合，输入值保持上次确定过得值不变。

• 由选择项的变更

[Writing online] 对话框中显示选择项的清单框。

从清单框选择一种，点击 [OK] 按钮。在关闭对话框时向模块写入值。

点击 [Cancel] 按钮的场合，不反映输入的值。

● 行单位的值编辑

点击行标题后，同一行上的数据处于被选择状态。

另外，双击行标题的场合，显示与选择的行数据对应的 [Writing online] 对话

框，被编辑的值反映到所选择的全部数据上。

在编辑框的场合下及单选按钮的场合下，[Writing online] 对话框上显示的初

始值都显示最左边的项目的值。

例 )   多个回路显示的状态下，双击「Setting value(LSP)」的单元进行设定时，

可变更对象回路的全部的「Setting value(LSP)」。
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● 向趋势组窗口的未设定组进行数据登录

在 [Monitor tree] 窗口上选择类别或各类别的个别单位后，在数值监视上将

显示对应的数据。在数值监视的单元、列标题、行标题之一被选择的状态下，

从 [Numeric monitor] 窗口向 [Trend group] 窗口未设定组进行拖放的场合，

登录所选择范围的数据的趋势组将被制作。

在趋势组的类别名中，当选择列标题时设定为项目名、当选择行标题时设定

为列名、当选择单元时设定为模块名。

 使用上的注意事项

•本操作仅在监视停止中才可使用。

● 向趋势组窗口的既存组中的数据登录

在 [Monitor tree] 窗口上选择类别或各类别的个别单位后，在数值监视上将

显示对应的数据。在数值监视的单元、列标题、行标题之一被选择的状态下，

从 [Numeric monitor] 窗口向 [Trend group] 窗口既存组进行拖放的场合，在

目标的组数据中追加要拖放的数据。

这种场合下当选择列标题、行标题时，所选择的全部的列数据、行数据将被

追加。

 使用上的注意事项

• 本操作仅在监视停止中才可使用。

● PID参数变更履历 (调节器模块的场合 )
在 [Numeric monitor] 窗口的列标题被选择的状态下用右键后，显示 [History 
of PID parameter change]。
选择 [History of PID parameter change] 菜单后，显示 [History of PID parameter 
change list] 对话框。
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■ 趋势监视窗口

[Trend monitor] 窗口显示如下。

趋势监视可最多同时显示 8 组的曲线。把光标放置在曲线区域上时，[Trend 
group] 窗口的名称用高亮度显示。

• 曲线显示区域的滚动

在左右的纵轴上或曲线区域进行拖放 ( 纵轴上 = 鼠标左右键、曲线区域 =
鼠标右键 ) 操作，可滚动曲线绘图区域。

纵軸方向的场合是对趋势组单位、含横軸方向的场合是对组全体的滚动功

能。

可用于监视开始时的曲线绘图中及监视停止后的曲线显示。

※综合监视可在 [Offline] 时使用。

要返回初始状态 ( 监视中的最新曲线 ) 的场合，与后述的 • 缩放的解除方

法相同。

 参 考

 •  监视开始中仅滚动纵軸的场合，曲线绘图将继续。 
横軸的场合，滚动到未来区域时，在显示区域右侧上曲线到达前会

持续绘图，当到达后绘图将停止。另外，滚动到过去区域的场合，

其曲线显示上曲线绘图将停止，数据收集继续进行。

例 ) 用鼠标指定曲线左侧的纵軸。
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• 缩放

按住鼠标左键并保持，在曲线区域上从画面左上开始到右下处拖动鼠标绘

出长方形的图后，所操作的趋势组的曲线会放大显示。

解除缩放显示的场合，与指定时相反，用鼠标从右下到左上拖放绘出长方

形的图。

监视开始后的曲线绘图中或监视停止后显示的曲线都可用缩放功能。

※综合监视 [Offline] 也可使用。

执行缩放的场合，曲线绘图将停止。

※执行含未来区域的缩放的场合，在显示区域右侧上，曲线到达前曲线

绘图将继续，但到达后绘图将停止，数据收集继续。

• 十字线光标

把光标放在曲线区域上时，纵軸上显示的线称为十字线光标。可与

[Crossline data] 窗口协同使用。是组全体可使用的功能。

※[Crossline data] 窗口是以组为单位。

• 光标移动时 :   十字线光标与曲线重合的点的数据显示在 [Crossline 
data] 窗口上。

• 双击时 :   十字线光标的起点被确定。( 变为粗线显示。) 用鼠标

移动十字光标后，显示 [Crossline data] 窗口上确定的

起点数据及与十字线重合的点的终点数据。 
※起点确定时再次单击十字线后，作为终点被固定。

再次点击后解除终点的固定。起点的解除用双击。

• 显示时间 :   趋势监视上的时间按绝对时间、相对时间显示，在监视

周期内更新时间。显示时间可通过菜单的 [Settings] → 
[Options] 进行绝对时间 / 相对时间的切换。

 使用上的注意事项

• 曲线区域上显示有曲线数据时可使用。

•  本操作仅在监视停止中才可使用。 
综合监视 [Offline]也可使用。

有关 [Crossline data] 窗口的显示内容，请参阅

■ 十字线数据窗口 (7-23 页 )。
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• 绝对时间 :   显示现在的时间。横軸的显示格式按 
「MM/dd hh:mm:ss.fff」的形式。

•相对时间 :   把监视开始时间作为 0 的显示。横軸的显示格式按 
「hh:mm:ss.fff」的形式。趋势曲线的显示在 0:00:00 ～ 23:59:59
的范围显示，经过 24 小时后时间显示被复位为 0:00:00。

● 选择显示时间幅 (曲线的X軸 )
选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Monitor settings]。
显示 [Monitor settings] 对话框。

[Trend graph settings] 的 [Display time length] 可选择的显示宽请从 1min、
2min、10min、1h、12h、24h、自动的 7 种类中选择。

另外，通过 [Universal Monitor] 窗口工具栏的  也可设定。

 参 考
• 在监视开始中也可变更工具栏的显示时间幅的设定。

• 显示幅设定被记录，下次启动综合监视时作为初始设定。

 使用上的注意事项

•  在监视动作中，不可通过 [Universal Monitor]窗口菜单栏的 [Settings] 
→ [Monitor settings]操作对显示时间幅进行变更。
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● 趋势上下限值 (曲线的Y軸 )设定为任意的值

请选择 [Universal Monitor] 窗口菜单栏 [Settings] → [Monitor settings]。
显示 [Monitor settings] 对话框。

通过 [Trend graph settings] 的 [High and low limits]，设定为自动或固定 ( 范
围输入设定 )。

 参 考
• 对象为全趋势组及左軸、右軸。

•  对 [Trend group]窗口的 [Y axis high and low limits settings]也按相同

的方法设定。该操作分别对趋势组单位及左軸、右軸进行设定。

 使用上的注意事项

• 本操作仅在监视停止中才可使用。

● 显示数据的自动清除处理

请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Monitor settings]。
固定样本数 (10000 件 ) 的数据显示后，将自动清除曲线显示。

有关设定范围，请参阅 
■ 限制数一览 (9-2 页 )。

 使用上的注意事项

• 本操作仅在监视停止中才可使用。

● 缩小、放大

请由 [Universal Monitor] 窗口工具栏选择图标。

 图标 : 放大

 图标 : 缩小

点击 1 次后放大、缩小的比例为 25%。

监视开始 / 停止中均可使用。

※综合监视 [Offline] 也可使用。

● 手动横向滚动

请由 [Universal Monitor] 窗口工具栏选择图标。

 图标 : 返回开始时间

 图标 : 前进到最新时间

/  图标 : 按 1/2 画面滚动

/   图标 : 按 1/4 画面滚动

监视开始 / 停止中均可使用。

※综合监视 [Offline] 也可使用。
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■ 趋势组窗口

[Trend group] 窗口对登录的数据进行组化，可对去 [Trend monitor] 窗口的

显示及收集状态进行操作。

项目按清单形式显示。

组中可最多登录 32 个数据。

登录的趋势组在 [Trend monitor] 窗口上可最多同时显示 8 组。

要显示趋势组中登录的数据时，请点击左端的 图标或点击组名。

● 显示项目

项目按从左侧开始的顺序显示如下。

• [Data sampling switchover] 复选框

可切换由趋势监视的数据收集的状态。有两种状态，各状态的含义如下。

图标 : 作为趋势组收集的对象

图标 : 不作为趋势组收集的对象

点击图标部分可切换收集状态。

• [Graph update switchover] 复选框

切换曲线的显示 / 不显示状态。可分 3 段进行复选。各复选项的含义如下。

• 组的勾选状态

 图标 : 组中登录的数据全部置为显示状态

 图标 : 组中登录的数据部置为非显示状态

 图标 : 组中登录的数据位显示 / 不显示混合状态

另外，组全体的复选变更只有显示 / 不显示的 2 段切换。点击图标部分

可进行显示状态的切换。

• 各数据的勾选状态

 图标 : 对象数据显示在曲线上

 图标 : 对象数据不显示在曲线上

点击图标部分可进行显示状态的切换。
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• 项目名

显示组的名称或数据的名称。

名称比显示幅长的场合，把鼠标的光标放在名称上时，用提示条显示名称

全体。

由用户登录的趋势组的场合，在监视停止中可变更项目名。

< 组名称的场合 >
右键菜单的 [Data name change]，显示 [Data name change] 对话框并

可进行变更。

< 数据名称的场合 >
双击单元或右键菜单的 [Data name change]，显示 [Data name change]
对话框并可进行变更。

• 曲线绘图颜色

显示对应曲线的线的颜色。

双击曲线颜色单元后，显示 [Trend graph settings] 对话框，可变更对应

曲线的线的颜色、样式、显示軸。

• 最新数据值

实时显示对应数据的最新值。

值不可变更。

● 功 能
请选择 [Universal Monitor] 窗口菜单栏的 [Monitor] → [Start]。
趋势组的最新数据值及趋势曲线被实时更新。

选择菜单的 [Monitor] → [Exit] 后，监视被停止，趋势曲线、最新数据值的更

新也被停止。

直到再次选择监视开始前，趋势曲线、最新数据值不会被清除。

监视周期可变更为任意的值。经由以太通讯的场合，缺省值为 400msec、经

由 USB 编程器电缆的场合为 2000msec。

趋势组根据各组名的曲线显示复选框为 ON 的个数分割自动趋势曲线。

纵方向的分割数最大为 8 个。

分割的曲线按从上面的区域开始的顺序，与趋势组的数据相关联。

在监视停止中时，趋势组可通过拖放标题项目可替换显示项目的顺序。

通过把数值监视、位显示监视的定义拖放到趋势组中，可进行监视对象数据

的追加。

 使用上的注意事项
•  [Trend group]窗口与 [Numeric monitor]窗口的数据收集各自独立进行，所

以同一数据的值的显示有不同的情况。
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● 趋势组的右键菜单

菜单项目 功　能 备　注

Full-screen display 只有选择的组才在 [Trend monitor]窗口全体上显
示
全体显示的组的标题为黄色

－

Y axis high and low limits 
settings

显示Y軸上下限值的设定对话框
设定所选择的组的Y軸的上下限值
详见 [Y axis high and low limits settings]对话
框 (下述 )

－

Digital trend switchover 所选择的组可切换成数字趋势设定
设定时所选择组的标题为蓝色显示

仅监视停止中时有效

Trend graph settings 显示线色、样式、显示軸的设定对话框
设定组中登录的数据的各信息
详见  [Trend graph settings]对话框 (下述 )

－

Data name change 显示数据名称的变更对话框
设定选择的数据的名称
详见 [Data name change]对话框 (下页 )

仅监视停止中时有效

Remove from trend 
monitor.

仅当选择了组时才有效，把所选择的组从趋势监
视中删除 (缺省登录的组不能删除 )

Remove individual data 只有当选择了数据时才有效，删除选择的数据

• [Y axis high and low limit settings] 对话框

设定对应组的 Y 軸的上下限值。

• [Trend graph settings] 对话框

设定对应数据的曲线的颜色、样式、显示軸。
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• [Data name change] 对话框

设定对应数据的名称。

请点击 [OK] 按钮。

 参 考
•  点击 [Return to default]按钮后，输入不同的名称时按钮有效，可返回

对话框启动时的名称。

■ 十字线数据窗口

十字线数据的显示如下。

● 显示项目

• 数据名

显示移动 [Trend monitor] 窗口的光标时或双击处对应的趋势组的数据名。

• 起点值 X、起点值 Y
显示移动 [Trend monitor] 窗口的光标时或双击处对应的趋势组的起点时

间及起点的值。

• 终点值 X、终点值 Y
显示 [Trend monitor] 窗口的起点被确定的状态下移动光标时或点击处对

应的趋势组的终点时间及终点的值。

 参 考
• 数据不存在的场合，显示为 [ － ]。

•  Y 軸的差分值 
显示起点值 Y、终点值 Y 的差。

•  倾斜 
显示从起点值 (X、Y) 到终点值 (X、Y) 的倾斜。

● 功 能
仅在监视停止中十字线功能才有效。

在趋势曲线上移动光标时，趋势曲线的区域上绘出垂直的线，从 X 軸值显示

各 Y 值。

在趋势曲线上显示从双击处到鼠标移动点或点击点为止的 2 点间的坐标的差

分值 / 倾斜。
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■ 位显示监视窗口

[Bit display monitor] 窗口如下。

例 ) 调节器模块的场合

当 [Monitor tree] 窗口选择类别的场合，在 [Bit display monitor] 窗口上显示

位显示用的内容。

从 [Bit display monitor] 窗口上选择位数据并拖放到 [Trend group] 窗口上，

可登录到 [Trend monitor] 窗口中。

向 [Trend monitor] 窗口中登录时，显示是否设定到数字趋势中的确认信息。

监视开始中双击各数据行后，显示 [Bit display monitor -- online writing] 对话

框，可变更值。

• [Bit display monitor -- online writing] 对话框

监视开始中双击各数据行后，显示 [Bit display monitor -- online writing]
对话框。

选择可选项之一，点击 [OK] 按钮，在关闭对话框时向模块中写入值。

点击 [Cancel] 按钮的场合，输入的值不被反映。
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■ 逻辑运算监视窗口

在 [Logical operation monitor] 上可对逻辑运算的设定内容及输入分配或逻辑

运算结果进行确认。条件成立的运算在对应处用红色表示。

以下之一的操作可显示 [Logical operation monitor] 窗口。

  选择 [Universal Monitor] 窗口菜单的 [Window] → [View] → [Logical operation 
monitor]。

  选择 [Universal Monitor] 窗口工具栏的 。

任一种操作都不显示 [Logical operation monitor] 窗口的场合，则在标准位置

处显示 [Logical operation monitor] 窗口。

 参 考
 初始状态下不显示 [Logical operation] 窗口。

  当从监视树选择了支持逻辑运算功能的模块时，[Logical operation 
monitor] 窗口才有效。例如，在监视树上选择工作组、不支持逻辑运

算的模块版本的场合，则只显示窗口而不显示内容。

■ 报警监视窗口

[Alarm monitor] 窗口的显示如下。

当报警发生时，[Alarm monitor] 窗口显示在前面。

报警周期设定为监视周期的整数倍。缺省值为 5200msec。变更周期时，请

通过 [Universal Monitor] 窗口菜单栏的 [Settings] → [Monitor settings] 的
[Monitor settings] 对话框进行变更。
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 参 考
• 未发生报警时，显示 [Alarm monitor]选项卡的状态。 
有关 [Alarm monitor]选项卡的显示，请参阅 

7-3 综合监视窗口 (7-3页 )。

■ 状态栏

[Universal Monitor] 窗口的状态栏中显示如下的信息。

● 监视时刻显示

在状态栏的左端处，以「YYYY/MM/DD hh:mm:ss.msec」的格式显示根据

监视周期进行的数据收集时的最新时间。

中划线后的显示是前次执行数据收集的时间与现在的时间的差，单位为

msec。
显示例 )

● 监视通讯状态显示

状态栏的右端处显示通讯状态。

显示的内容有如下的 3 种。

[Wait] : 监视停止中

[OK] : 监视开始中

[Break] : 监视开始中发生通讯异常、应答被切断时

显示例 )

● 缩放状态显示

状态栏的右端处显示趋势监视的缩放状态。

[ZoomIn] 的显示的动作如下。

•趋势监视内用鼠标拖放时的缩放时

•右键趋势组的标题 选择 [End full-screen display] 时
•工具栏的  放大图标选择时

显示例 )

[ZoomOut] 的显示的动作如下。

•工具栏的  缩小图标选择时

显示例 )

显示 [FullScreen] 时的动作如下。

 当从 [Trend group] 窗口的右键菜单选择 [End full-screen display] 时。

 从 [Trend group] 的 1 个组呈缩放状态返回全体显示的显示状态时

通过 FullScreen 状态的显示，放大或缩小状态的显示将优先。

显示例 )
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■ 版本信息

要显示综合监视的版本时，请选择 [Universal Monitor] 窗口菜单栏的 [Help] 
→ [About Version information]。
≫显示如下的综合监视的版本信息。
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7 - 6 各种设定

■ 通讯目标

①   请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Communication 
destination]。
≫显示 [Communication destination] 对话框。

② 显示的内容如下。

• [Server]
显示设定的 IP 地址及端口编号。

•  [Module]
从 [Module] 组件框选择要编辑对象的模块，确认 IP 地址、端口编号、

节点地址。

③ 确认完成后，请点击 [OK] 按钮。

■ 监视设定

① 请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Monitor settings]。
≫显示 [Monitor settings] 对话框。

② 显示的内容如下。

• [Monitoring cycle]
监视数据收集的周期按 msec 单位设定。

初始值根据通讯对象模块的台数如下所示。

( 以太通讯的场合 )
1 台 ： 0.4s 小于 16 台 ： 2s
小于 4 台 ： 1s 小于 31 台 ： 4s

( 编程器插口通讯的场合 )
2s
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• [Graph update freq]
对监视周期，设定经过几个周期后按 1 次的比例进行更新。初始值为每

「1」个周期。

• [Alarm cycle]
报警信息的收集周期以 msec 为单位进行设定。

初始值为「5000」msec。

• [High and low limits]
设定曲线区域上显示的数据的上下限值。

选择固定的场合，在设定的值的范围内，趋势曲线的 Y 軸被固定。

初始值为「Automatic」。

• [Display time length]
设定曲线区域上显示的数据的时间幅。

与组合框选择的值对应，决定趋势曲线上显示的 X 軸。

初始值为「1min」。

• [Display time format]
选择趋势曲线的 X 軸的显示时间的格式。

初始值为「M/d HH:mm:ss.f」。

• [Fixed Sample]
指定一个曲线区域上保持的数据数。

初始值为「10000」。

③ 设定完成后请点击 [OK] 按钮。

 使用上的注意事项
•  根据 PC 的负荷、模块台数、监视的数据收集及趋势日志的写入等负荷情况，

有时会显示如下的信息。

当显示本信息的场合，请采取。

• 重新设定监视周期

• 取消监视树或趋势组的复选项、减少监视对象的模块台数

等措施使监视变为可动作的状态。
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■ 趋势监视色设定

① 请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Trend color 
settings]。
≫显示 [Trend monitor color settings] 对话框。

② 显示的内容如下。

• [Line color]
选择曲线的线的颜色。

点击对象后显示 [Color settings] 对话框。

• [Line type]
选择曲线的线的种类。

线的种类有实线、虚线、点划线、实线 ( 粗 )、虚线 ( 粗 )、点划线 ( 粗 )
的 6 种类。

• [Display axis]
显示曲线的线的显示軸。

可选择的軸为左軸、右軸的 2 种类。

 参 考
•  要把32色全部返回缺省设定颜色时，请点击 [Return to default]按钮。

初始的线种的 [1 ～ 16]选项卡为实线、[17 ～ 32]选项卡为虚线。 
初始的显示軸的 [1 ～ 16]选项卡为左軸、[17 ～ 32]选项卡为右軸。

③ 设定完成后请点击 [OK] 按钮。
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■ 选项

① 请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → [Options]。
≫显示 [Options] 对话框。

② 显示的内容如下。

• [Trend time display settings]
设定趋势监视曲线的 X 軸是用绝对时间显示还是用监视开始后的相对时

间显示。

• [Trend log settings]
设定趋势日志文件的关键名称及输出目标文件夹。

• 指定输出目标文件夹的路径

① 直接输入的场合

输入的文件夹作为输出目标文件夹。

※输入的文件夹不存在的场合，则以输入的名称制作文件夹。

 参 考
•  输入 「Log」 的场合，以编程器的安装文件夹上的且Log作为输出

目标被设定。

② 点击 [Browse] 按钮选择文件夹的场合

在选择的场所中设定输出目标。

 使用上的注意事项

	�请勿把输出目标文件夹设为网络上的文件夹。根据有时通讯的状

态，有可能不能正常写入的情况。

• [Font settings]
设定 [ 综合监视 ] 窗口上显示的字体。文字大小固定。

• [Character code settings]
显示写入或读出时的文字代码。

③ 设定完成后请点击 [OK] 按钮。

≫趋势监视所收集的数据作为日志写入外部文件。

文件名为 [core name]_[time stamp].[file extension]。
时间标签按「YYYYMMDDhhmmss」的形式。

日志文件中写入的数据可在以后通过 [Offline] 读出并按曲线显示。
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■ 其它的设定

可保存及调出 [Universal Monitor] 窗口上各窗口的停驻状态。

● 窗口的固定

请选择 [Universal Monitor] 窗口菜单栏的 [Window] → [Fixed-position 
window]。综合监视内的各窗口的停驻状态、位置、大小被固定化。

即使把处于悬浮状态的窗口在综合监视窗口进行移动，画面位置也被固定。

要解除窗口固定时，可再次选择 [Universal Monitor] 窗口菜单栏的 [Window] 
→ [Fixed-position window]。

● 窗口返回标准位置

请选择 [Universal Monitor] 窗口菜单栏的 [Window] → [Return to standard 
position]。综合监视内的各窗口的停驻状态、位置、大小将返回标准状态。

● 保存现在窗口的状态

请选择 [Universal Monitor] 窗口菜单栏的 [Window] → [Favorite] → [Add to 
favorites]。显示 [Add to favorites] 对话框，用指定的名称保存窗口的位置、

大小、停驻状态。初始的名称为「Favorite」。
保存在编程器的安装文件夹内。

● 整理收藏夹中登录的项目

请选择 [Universal Monitor] 窗口菜单栏的 [Window] → [Favorite] → 
[Organize favorites]。
按一览方式显示登录的项目 , 可进行整理 ( 名称的变更或删除 )。

● 调出收藏夹中登录的窗口的停驻状态

请操作 [Universal Monitor] 窗口菜单栏的 [Window] → [Favorite]，选择要调

出窗口设定的名称。

显示保存的窗口的状态。
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7 - 7 用户监视

用户监视功能在定制监视项目时使用。在此对用户监视的编辑方法及综合监视对应的操作进行说明。

[Monitor tree] 窗口的 [Custom] 选项卡作为用户监视，在对数值监视等监视时可选择登录的项目。另外，

[Monitor tree] 窗口的 [Default] 选项卡与使用中的模块的型号及台数对应，自动的被登录到标准项目 ( 样本 )
中。同时，作为用户监视可登录的项目因显示级别的设定而异。

■ 用户监视编辑对话框

在编辑用户监视时，请选择 [Universal Monitor] 窗口菜单栏的 [Settings] → 
[Edit monitoring data]。
≫显示如下的 [Custom monitor editing] 对话框

 使用上的注意事项
•  用户监视中登录的内容用于离线 (7-9 离线 7-42页 )的场合，请作为趋势 (趋
势组 )进行登录。即使登录在数值监视用的设定中或监视中，离线也不能使

用。

● 监视数据树

用 [Universal Monitor] 窗口的 [Monitor tree] 窗口可显示树的构成。

● 监视数据树用按钮

可对监视数据树的用户层级进行编辑。

按钮 图标 功　能

Add category 新建类别 
对用监视数据树，仅当选择了用户层级时才有效

Add group 新建组 
对监视数据树用户，仅当选择了用户层级时才有效，在选择
的类别层级中追加组

Copy 选择的类别或组的层级及监视对象的设定全部被复制。仅当
类别或组被选择时才有效

Paste 粘贴复制的类别或组的信息

Delete 删除监视数据树选择的类别或组

Digital trend 类别或组中登录的项目作为数字趋势设定

 

编辑数据 

监视数据树 

监视数据树用按钮 

层级显示
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● 监视数据树用右键菜单

菜单 子菜单 功　能 备　注

New Category 新建类别 
对用监视数据树，仅当选择了用户层级时才有效

－

Group 新建组 
对监视数据树用户，仅当选择了用户层级时才有效，
在选择的类别层级中追加组

－

Copy － 选择的类别或组的层级及监视对象的设定全部被复
制。仅当类别或组被选择时才有效

－

Paste － 粘贴复制的类别或组的信息
对监视数据树用户，仅当选择了用户层级时才有效

－

Change name － 变更选择中的类别或组的名称。通过选择，名称进
入编辑状态。输入要变更的名称后按Enter键，名称
被变更。编辑状态下按ESC键后名称不会变更，返
回编辑前的状态。

－

Delete － 删除监视数据树选择的类别或组 －

Trend monitor settings － 切换趋势监视上显示 /不显示的复选项。趋势监视上
显示的处于设定状态的树项目的图标被变更， 
背景色用蓝色突出显示。

－

Digital trend 类别或组中登录的项目设定为数字趋势及解除设定。菜单上有复选的状
态为设定状态

View/Hide － [Universal Monitor]窗口的 [Monitor tree]窗口上把类
别或组进行显示 /不显示的切换。 
不显示 (右键菜单的 「View/Hide」 的左边 
去除复选状态 )的场合，监视数据树上对应的层级不
会显示。

－

Register trends by row － 对监视数据树，右键类别时有效，显示 「Trend 
registration by column」 对话框，进行趋势组的登录。

还请参考   「Trend 
registration by 
column」 对话框向
的项
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● 编辑数据

通过选择类别的项目 ( 设定、监视、趋势 ) 才有效。

类别的各项目按以下登录。

	�设定	

登录在 [Numeric monitor] 窗口的 [Setting] 选项卡中，登录的数据在监视

开始中向模块写入。

	�监视 
登录在 [Numeric monitor] 窗口的 [Monitor] 选项卡中，在监视开始中可参

照登录的数据。

	�趋势 
登录在 [Trend group] 窗口中，不能作为 [Trend monitor] 窗口的显示对象。

可追加的数据数的上限对设定、监视为不超过 64 个、对趋势为不超过 32 个。

编辑设定内容时，在选择类别的项目 ( 设定、监视、趋势 ) 的状态下点击 [Select 
data] 按钮或复制其他类别已经存在的项目并登录。

请根据 ■ 数据选择对话框 (7-37 页 ) 的方法进行数据的追加、删除、复制或

通过选择 [Custom monitor editing] 对话框的编辑数据格的行标题、用右键

菜单或用快捷按钮进行编辑。

● 层级显示

在监视数据树上所选择节点的层级。

● 编辑数据用右键菜单

菜单 功　能 备　注

Copy row 复制选择的一行或多行 选择行标题时有效

Cut row 剪切选择的一行或多行 选择行标题时有效

Insert copied row 把复制的行数据插入所选择的行 仅当复制或剪切的行数据
存在时才有效

Delete row 删除选择的一行或多行 选择行标题时有效

Copy column data 复制选择的单元的数据 列数据或单一单元被选择
时有效

Paste column data 粘贴复制的列数据 列数据或单一单元被选择
时有效
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● 编辑数据用快捷按钮

显示与编辑数据的右键菜单执行相同处理的快捷按钮。

从左开始

•复制  按钮

•剪切  按钮

•粘贴  按钮

•删除  按钮

这些按钮仅当选择行标题时才有效。

● 数据选择按钮

监视数据树上仅当选择类别的项目 ( 设定、监视、趋势 ) 时才有效。

作为用户数据对象的监视用参数在用户编辑的新追加清单上显示。

根据显示级别的设定，[Custom monitor editing] 对话框上显示的范围不同。

请点击 [Select data] 按钮。

≫显示 [Select data] 对话框。请参阅

■ 数据选择对话框 (7-37 页 )。

● [OK]按钮

点击后将确定之前编辑的项目及数据，关闭 [Custom monitor editing] 对话框。

● [Cancel]按钮

点击后取消之前编辑的项目及数据，关闭 [Custom monitor editing] 对话框。
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■ 数据选择对话框

用户监视编辑对话框的监视数据树上选择类别的项目 ( 设定、监视、趋势 )，
通过点击 [Select Data] 按钮，调出 [Select Data] 对话框。

由 [Select Data] 对话框设定的项目，针对 [Custom monitor editing] 对话框

的选择项目，作为要新登录的监视显示项目的候补被设定。

 使用上的注意事项
•  由 [Select Data]对话框设定的项目作为显示候补，在 [Custom monitor editing]

对话框上点击 [OK按钮 ]时确定显示项目。

• [Tree monitor]
从数据库中检索的数据以树形式显示。

• [Data search list]
显示树监视选择的层级中的全部数据。

• [Registered data list]
显示 [Custom monitor editing]对话框的监视数据树上所选择的项目中登录

的数据一览。

• [Search]
用指定 ([完全一致 ]复选框、[输入用文本框 ])的条件可对数据清单进行检索。

• [Perfect match]复选框

: 数据清单内的数据与文本框的文本完全一致的数据才显示。

: 数据清单内的数据中含有文本框的文本时显示数据。

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

检索数据清单 完全一致 输入用文本框

检索 

树监视

数据删除 

数据追加

数据移动 

登录数据清单
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• [Text box for input]
输入工作组、类别、类型、属性的文字列。

• [Add data]按钮

用检索数据清单把选择的数据追加到登录数据清单中。

• [Delete data]按钮

把登录数据清单所选择的数据从登录数据清单中删除。

• [Move data]按钮

把登录数据清单指定的数据往上、下进行移动。

可选择多个数据。

• [OK]按钮

把登录数据清单上的项目追加到 [Custom monitor editing]对话框的监视

数据树上选择的项目中，关闭对话框。

• [Cancel]按钮

中断处理，关闭对话框。
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■ 趋势列登录对话框

在 [Custom monitor editing] 对话框的监视数据树上用右键类别后，[Register 
trends by row] 菜单变为有效。选择 [Register trends by row] 菜单后，显示

[Trend registration by column] 对话框，对应树层级的数值监视的设定选项卡

上登录的项目可作为趋势组登录。

请选择项目名的行标题，点击 [OK] 按钮。

≫监视数据树中作为趋势组的候补被登录。
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7 - 8 趋势备忘录

■ 概　要

趋势备忘录可记录用户写的任意的注释、PID 参数的变更履历。

趋势备忘录数据与趋势日志文件相被关联保存。

( 与 PID 日志相同，把文件名写入趋势备忘录中 )
趋势备忘录的记录通过 [Universal Monitor] 窗口菜单栏的 [Record] 或在

[Trend monitor] 窗口上右键菜单执行。

■ 登录趋势备忘录

要登录趋势备忘录时，可选择 [Trend] 窗口上右键菜单的 [Trend memo 
registration] 或 [Universal Monitor] 窗口 菜单栏的 [Record] → [Trend memo 
registration]。
显示 [Register Trend Memo] 对话框。

 使用上的注意事项
•  趋势备忘录的登录只有在监视中且收到最初的趋势数据后才有效。另外，

从 [Universal Monitor]窗口菜单登录趋势日志的场合，趋势曲线X軸的最新

值 (绝对时间 )为登录时间。 
从 [Trend monitor]窗口的右键菜单开始登录的场合，鼠标位置的时间为登

录时间。

■ 显示趋势备忘录

要显示趋势备忘录时，请选择 [Universal Monitor] 窗口菜单栏的 [Record] 
→ [Trend memo List] 或在 [Trend monitor] 窗口上右键菜单的 [Trend memo 
List]。
≫显示 [Trend memo list] 对话框。

• [Delete selected items] 按钮

从趋势备忘录中删除单一或多个选择的行信息。

• [Pushpin] 按钮

在图钉被按下状态 的场合 ,[Trend memo list] 对话框总在 [Universal 
Monitor] 窗口的前面显示。

• [Close] 按钮

关闭 [Trend memo list] 对话框。

 
[关闭]按钮

[删除选择的项目]按钮 [图钉]按钮     
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■ PID参数的变更履历

以数值监视的列为单位选择回路，请从右键菜单选择 [History of PID parameter 
change]。
≫显示 [History of PID parameter change ] 对话框。

PID 参数变更履历信息只显示与选择数据相关的数据。

• [Confirmation] 按钮

可确认选择时间的 PID 参数的值。

• [Close] 按钮

关闭 [History of PID parameter change ] 对话框。
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7 - 9 离　线

■ 离线的概要

通过离线功能，记录的过去的趋势曲线或数值数据可重新显示。多个过去时

间的曲线可同时显示。

PID 日志是在 [Numeric monitor] 窗口上显示的对象的数据 ( 设定、监视 ) 按
时间序列保存的日志文件。

趋势数据与 PID 日志按组 / 类别单位被关联。

读出的 PID 日志在综合监视 [Offline] 窗口的 [Numeric monitor] 窗口上显示。

与在线的场合相同，显示由 [Monitor tree] 窗口选择的类别对应的日志。

 参 考
• 离线功能不能向模块执行写入。

•  对离线功能，数值监视是显示监视停止时记录的值，十字线数据是显示趋

势曲线上绘出垂线时的值。

日志文件的写入及读出与文件的关系如下。

·写日志文件 

生成日志文件 
记录开始时的PID值 

趋势日志文件

记录停止时的 PID 值 
PID日志文件名与趋势 
日志文件名相同 

·读日志文件 

趋势日志文件

 
PID日志文件

 

打开日志文件 

 
PID日志文件

 

趋势停止 
 

趋势开始 
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■ 日志文件转换

趋势监视收集的数据作为趋势日志保存在文件中。SLP-NXVer 3 以后标准选

择的输出文件是名称为 slog 的压缩文件作为监视结果。保存的趋势日志文

件可转换成别的文件形式。

要转换趋势日志文件时，选择综合监视菜单 [File] → [Log file conversion]。

①   显示 [Open] 对话框，选择以下的输入文件形式及文件名。

 加密的日志文件 (*.slog) 
 日志文件 (*.tlog)

 参 考
 日志文件 (*.tlog) 形式是 SLP-NX Ver2 之前标准选择的文件形式，为

了保持兼容性按输入文件形式保留。

②   点击 [Open] 按钮后显示 [Save As] 对话框，选择以下的输出文件形式及

文件名。

绝对时间 (*.csv) 
绝对时间 (*.xml) 
相对时间 (*.csv) 
相对时间 (*.xml) 
可移植日志文件 (*.plog)
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③ 趋势日志目录中指定的目录中选择的文件被输出。

以下的日志文件可在综合监视 [Offline] 窗口上打开。

日志文件 (*.tlog)
加密日志文件 (*.slog)
可移植日志文件 (*.plog)

可移植日志文件 (*.plog) 形式是从监视开始到监视结束为止的趋势日志，是

把 PID 变更履历、趋势备忘录整合为 1 个文件保存的形式，可用于数据的传

送接收。

■ 综合监视离线窗口的显示

各窗口的名称如下。

• [Monitor tree] 窗口

• [Trend monitor] 窗口

• [Trend group] 窗口

• [Numeric monitor] 窗口

• [Crossline data] 窗口

• [Bit display monitor] 窗口

 参 考
•  名称、功能与 7-3 综合监视窗口 (7-3页 )相同。 
详见 7-3页。

 
[监视树]窗口

 
[趋势监视]窗口

 
[趋势组]窗口

 
[位显示]窗口 

  菜单 
工具栏 

类别 
个别显示

状态栏 
[十字线数据]选项卡 [数值监视]窗口  

[数值监视]选项卡
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■ 各窗口的停驻功能

各窗口的停驻功能与在线用的 [Universal Monitor]窗口相同。详见 7-6页。

停驻功能通过菜单的 [Window] 及操作鼠标进行设定。

■ 状态栏

状态栏显示如下的信息。

• 监视时间显示

显示 [Offline]。

• 通讯状态显示

离线时不能通讯。状态栏的右端处显示 [Wait]。

• Zoom 状态显示

缩放的状态与在线时的显示相同。
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离线时的菜单构成如下。

菜单 子菜单1 子菜单2 内　容 备　注

File Log file － [Open log file]、选择 [Open log file 
[multitime mode]] 

－

Log file conversion － 总无效 －

Copy graph to 
clipboard

－ 把趋势监视中显示的曲线复制到剪贴板
上

－

Start control profile － 不支持 －

Exit － 关闭综合监视 [Offline]窗口 －

Monitor － － 总无效 －

Settings Edit monitoring data － 总无效 －

Communication 
destination 

－ 总无效 －

Monitor settings － 设定趋势监视上显示的趋势时间
详见 ■监视设定对话框 (7-48页 )

－

rend color settings － 设定趋势曲线使用的线种类及缺省颜色
详见 ■趋势监视色设定 (7-30页 )

－

Options － 总无效 －

Record View trend memo － 显示趋势日志一览对话框
详见 7-8 趋势日志 (7-40页 )

－

Trend memo 
registration

－ 总无效 －

Window Fixed-position 
window

－ 禁止窗口的悬浮移动 用复选方式设定ON/
OFF

Return to standard 
position

－ 各窗口的显示位置返回标准位置 [Fixed-position window]
为OFF时才有效

View Monitor tree 显示 [Monitor tree]画面 窗口已经显示的场合，
激活画面Trend monitor 显示 [Trend monitor]画面

Crossline Data 显示 [Crossline data]画面

Trend Group 显示 [Trend group]画面

Numeric monitor 显示 [Numeric monitor]画面

Alarm monitor 总无效

Logical operation 
monitor

显示 [Bit display monitor]画面

Favorite － 总无效 －

Help Show help － － 不显示任何内容

About (version info) － 显示 [Version]对话框 －
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■ 读出趋势日志

利用离线功能可把不同时间收集的数据显示在同一趋势组上。

选择 [Universal Monitor] 窗口菜单栏的 [File] → [Log file] → [Open log file]
或选择 [File] → [Log file] → [Open log file[Multi-point mode]]。
读出趋势日志后在综合监视 [Offline] 窗口上显示，去趋势组及 [Trend] 窗口

显示对应日志的数据。

综合监视 [Offline] 窗口的趋势组中可与其它离线组的数据重合。

复制数据的场合，曲线的线上设定的数据也直接被复制。

综合监视 [Offline] 窗口的趋势组中，不可从数值监视、位显示监视进行数据

的追加。

另外，综合监视 [Offline] 窗口不能执行监视。

 参 考
  选择 [Universal Monitor]窗口菜单的 [File] → [Log File] → [Open log file]，
打开可移植日志文件 (*.plog)后，有显示以下的信息的情况。

当超过监视设定的固定采样数进行趋势收集、分割成多个趋势日志文件

的场合，显示该信息。

■ 数值监视的显示

可确认记录的参数的值。

不能对数值监视上显示的值进行编辑，也不能通过向趋势组拖放的方式进行

登录或向模块进行写入。
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■ 监视设定对话框

离线功能显示的趋势曲线的显示设定可变更。

① 请选择 [Universal Monitor] 窗口菜单栏的 [setting] → [Monitor setting]。
≫显示 [Monitor setting] 对话框。

② 显示的内容如下。

• [Trend time setting]
设定趋势曲线的 X 軸是按绝对时间显示或是按从监视开始的相对时

间显示。

初始值为「Absolute time」。
• [Display time format]
选择趋势监视曲线的 X 軸的显示时间的形式。

初始值是当 [Trend time setting] 为绝对时间时按「M/d HH:mm:ss.f」、
[Trend time setting] 为相对时间时按「H:m:s.fff」形式。

• [Display time length]
设定曲线区域上显示的数据的时间幅。

与组合框选择的值对应决定趋势曲线上显示的 X 軸。

初始值为「Automatic」。
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■ 趋势组的显示

• 通过拖放，各参数可按组为单位移动。

移动对象的数据与移动目标相关联。

• 时间軸的重合处理

X 軸的时间可变更为任意值，可与軸重合。

趋势组的右键菜单后，显示 [Time axis superposition settings] 对话框。

根据日志读出的模式，X 軸的值为绝对时间或相对时间，其形式也不同。

可实时对值进行操作并可进行比较。

绝对时间的场合 : 选择的起始的时间用输入的时间显示。

相对时间的场合 : 选择的起始时间用输入的时间加上偏移方向显示。

绝对时间收集的趋势与相对时间收集的趋势都是把收集的记录开始时点作为

[Trend monitor] 窗口的开始点显示。

打开趋势日志后，通过偏移时间与偏移方向的设定，曲线按指定的时间幅移

动。

移动目标

拖

放
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趋势曲线的重合例

• PID 值在数值监视上的显示

右键趋势组标准备有的组的项目，选择显示的子菜单的 [Display PID 
value on numeric monitor]。在监视树上把对应回路设定为选择状态，在

数值监视上显示对应回路的值。

■ 位显示监视的显示

离线时不显示位显示监视的内容。

■ 十字线数据的显示

点击 [Crossline data] 选项卡后，显示 [Crossline data] 窗口。在趋势监视上

显示十字线光标处的值。

可进行悬浮 / 停驻的切换。

详见在线用的

■ 十字线数据窗口 (7-23 页 )。
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■ 特　长

PID仿真器是应用了独自的仿真技术、SLP-NX专业版专用的PID调整支持功

能。PID仿真器具有以下的特长。

  简单操作即可创建对象模型 
通过模型创建向导只需简单的操作即可创建控制对象模型。

  支持PID调整的直观的用户接口 
只需鼠标操作即可用PID仿真器进行PID调整。通过鼠标的移动可把控制

结果的曲线进行缩放，可直观地确认PID调整的效果。

  确认Just-FiTTER等功能的效果 
可在本公司独自的控制算法Just-FiTTER等各种功能的效果的实际运行使

用前进行确认。

 参 考
控制对象模型是把加热或冷却、流量或压力的变化等装置 (控制对象 )的物理

现象用数学表达式表示。

第 8 章 PID 仿真器
8 - 1 PID 仿真器的概要



8-2

第 8 章 PID 仿真器

 使用上的注意事项
  要使用PID仿真器时，需要安装USB密码狗驱动程序。 
关于驱动程序的安装方法，请参阅 

 1-5　USB密码狗驱动程序的安装　(1-17页 )。

  PID仿真器是NX-D25/35用的功能。NX-D15不能使用。

  根据装置特性，PID仿真器的PID控制仿真的结果与实际的控制结果有不一

致的情况 (具有非常强的非线性特性的装置或串级控制的主侧回路等 )。

  PID仿真器不支持串级控制、加热冷却控制的调整。

 参 考
  「非常强的非线性特性」 是指过程值 (PV)与操作量 (MV)的相关性不是

直线的含义。具有非常强的非线性特性的控制对象的例有药液混合时

伴有自发热的温度控制、pH控制时的中和点附近的pH控制等。
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■ 用PID仿真器进行调整的步骤

用 PID 仿真器进行的 PID 参数的调整请按以下步骤执行。

 使用上的注意事项

  受控制对象模型创建用趋势数据中包含的测量误差或干扰等的影响，

有不能获得与仿真结果一致的结果的情况。此时，请在对测量误差或

干扰采取措施的基础上，重复本步骤的执行。

画面例 调整的步骤 参照的章

从装置收集运行中的过程值(PV)、 
操作量(MV)的趋势数据。

第 7 章　综合监视
8 - 6　趋势数据收集方法

启动PID仿真器、从收集到的趋势
数据创建控制对象模型。

8 - 2　PID仿真器的启动
8 - 5　控制模型创建 

通过PID控制仿真计算出PID值。 8 - 3　PID仿真器的画面
8 - 4　方便的功能

根据实际的装置算出的PID值确认
控制结果。

第7章　综合监视
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PID 仿真器可按以下的方法启动。

● 直接启动

从 Windows 的开始菜单选择 [SLP] → [PID Simulator]。采用本方法启动时

有以下的限制。

  不能从综合监视未经数据文件直接读取趋势数据

  不能与调节器模块本体进行参数的读取 / 写入

● 从综合监视启动

综合监视的监视树的 「Module configuration」 的调节器模块名或在回路名上

右键点击、从菜单选择 [Start PID simulator]。

从综合监视启动的场合，除文件中保存的趋势数据外，还可利用由综合监视

收集的趋势数据。趋势数据收集方法及数据文件的创建方法请参阅 
8-6趋势数据收集方法　(8-23页 )。

根据右键点击的场所，模型创建可利用的趋势数据数有差异。在监视树的调

节器模块名上右键点击启动的场合可使用全组的趋势数据，在组名上右键点

击启动的场合可使用该组的趋势数据。

 使用上的注意事项

 只能在监视停止中才能启动 PID 仿真器。

 也可从综合监视的离线窗口启动。

   启动 PID 仿真器的场合，请把「USB 密码狗」可靠地插在所使用的

PC 上。未找到「USB 密码狗」的场合，将显示以下的错误。

8 - 2 PID 仿真器的启动
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■ 启动画面

启动PID仿真器时会显示 [Welcome to the PID Simulator]对话框。在此选择

控制对象模型的创建方法。点击 [Cancel]按钮关闭对话框后，即关闭PID仿

真器。

控制对象模型的创建方法有以下的3种。

● 从数据文件 (*.pdn)创建模型

读入专用的数据文件 (*.pdn)启动模型创建向导。与从菜单选择 [File]→ [Model 
from a data file...]相同。另外，趋势数据收集方法及数据文件的创建方法请

参阅  8-6趋势数据收集方法　(8-23页 )、控制对象模型的创建方法请参阅

 8-5控制对象模型创建　(8-18页 )。

● 从模型文件 (*.pmn)读入模型

读入保存了模型数据或仿真信息的模型文件 (*.pmn)开始PID控制仿真。通

过读入模型文件，可重新开始前次的仿真作业。与从菜单选择 [File]→ [Read 
model from data file...]相同。

● 从趋势数据创建模型

不经由数据文件而是直接读入由综合监视收集的数据启动模型创建向导。仅

当综合监视收集到恰当的趋势数据后从综合监视启动PID仿真器时，该项目

才有效。另外，趋势数据收集方法及数据文件的创建方法请参阅   8-6趋
势数据收集方法　(8-23页 )、控制对象模型的创建方法请参阅  8-5控制对

象模型创建　(8-18页 )。
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对 PID 仿真器的画面构成进行说明。

■ 菜单栏及工具栏

菜单项目及工具栏按钮的构成如下表所示。

菜单 按钮 子菜单 内容 快捷键

File Create model from 
data file..

打开数据文件 (*.pdn)、创建
控制对象模型

[CTRL]＋ [M]

Read model from 
model file

读入模型文件 (*.pmn) [CTRL]＋ [L]

Save model 既有模型文件的覆盖保存 [CTRL]＋ [S]

Save model as... 指定模型文件的名称并保存

Save simulation 
data... 

把仿真曲线中显示中的趋势
数据 (PV)保存在CSV中

Copy graph to 
clipboard

把仿真曲线的图像复制到剪
贴板上

Convert PDN to CSV 把数据文件 (*.pdn)转换成
CSV并保存

Quit 关闭PID仿真器 [CTRL]＋ [Q]

菜单栏 工具栏 仿真曲线

PID 滑块 参数选项卡

8 - 3 PID 仿真器的画面
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菜单 按钮 子菜单 内容 快捷键

View Toolbar 工具栏的显示 /隐藏的切换

Show PID Slider PID滑块的显示 /隐藏的切
换

Simulation Auto-tuning... 执行自整定 [CTRL]＋ [T]

Options Add current 
parameters to a 
memo... 

把现在使用的控制参数保
存在备忘录中

[CTRL]＋ [A]

Delete selected 
memo 

删除现在选择的备忘录

Rename selected 
memo...

变更现在选择的备忘录的
名称

Load/Save 
Parameters

把PID值等参数写入调节器 [CTRL]＋ [P]

Graph Auto-adjustment of 
PV axis

自动调整曲线的Y轴 (PV
轴 )

[CTRL]＋ [J]

Adjustment of 
Y-axis...

显示 [Adjustment of Y-axis]
对话框

[CTRL]＋ [Y]

Undo Zoom 解除曲线的缩放 [CTRL]＋ [U]

Properties... 显示变更曲线系列的颜色
的 [Properties]对话框

Help Version information... 显示PID仿真器的版本信息

以下的功能只能由工具栏使用

控制 内容

选择登录的备忘录
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■ 仿真曲线的功能

表示PID控制仿真的控制结果，有以下的功能。

● 缩放功能

把鼠标围住的范围放大显示。把光标移到要扩大范围的左上处，按下鼠标的

左键移动光标到右下处，要扩大范围的右下处松开鼠标的左键后即可放大。

要解除缩放时，可在曲线显示区域内的任意位置处，在点击鼠标左键的同时

把光标向左上移动，在适当的位置放开鼠标左键。

以下操作也可解除缩放。

 选菜单栏的 [Graph] → [Undo zoom]
 点击工具栏的  按钮

 从键盘按 [CTRL]＋ [U]键

● 设定值 /PV初始值变更功能

通过鼠标把仿真曲线上的设定值变更用滑块 /PV初始值变更用滑块进行上下

拖移，可变更设定值及PV初始值。
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 使用上的注意事项

  通过设定值变更用滑块 /PV 初始值变更用滑块变更值时，根据仿真曲

线的显示大小，有不能设定成希望的值 ( 例如，设定值 100 的下一个是

102) 的情况。这种场合，请从后述的参数选项卡进行变更。

  用缩放功能对曲线放大时，设定值变更用滑块 /PV 初始值变更用滑块

将被隐藏。

  仿真曲线与仿真期间的长度成比例，显示更新的时间也变成。请按实

用的长度使用仿真期间。

● 干扰设定功能

由参数选项卡选择 [Disturbance setting]选项卡后，仿真曲线上将显示以下的

干扰设定用的滑块，可变更干扰的形状。干扰发生时间变更用滑块可左右移

动、干扰的强度变更用滑块可上下移动。

 使用上的注意事项

  根据仿真曲线的显示大小，用该滑块有不能设定成希望的值 ( 例如，

干扰发生时间 100 的下一个是 102) 的情况。这种场合，请从后述的参

数选项卡进行变更。

  用缩放功能把曲线放大显示时，该滑块被隐藏。

设定值变更用滑块

PV初始值变更用滑块

干扰发生期间变更用滑块

干扰强度变更用滑块
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■ PID滑块

用鼠标操作变更 PID 值。

可用滑块范围最大值变更按钮变更滑块的范围。点击该按钮后，滑块范围的

最大值按阶段变大，超过上限时返回最小的设定范围。点击按钮的右侧的 [▼ ]
按钮时，将显示下图的菜单，可直接指定范围。

 参 考
  用箭头键也可变更用箭头键也可变更的值。[↑ ]、[→ ]键是増加、[↓ ]、

[← ]键是减少。另外，可同时按 [↑ ]、[↓ ]、[→ ]、[← ]键与 [SHIFT]键，

值的増减量变为10倍。

  当用 [↑ ]、[→ ]键增大PID值时，如果超过了现在设定的范围的上限值，

则自动设定为大1阶段的范围。当有 [↓ ]、[← ]键减小PID值时，如

果比前1阶段的范围的上限值小，则自动设定为前1阶段的范围。例

如，比例带的范围设定为0.1-200.0时，用 [↑ ]、[→ ]键变更后的值

比200.0大时，范围自动变更为0.1-500.0，当用 [↓ ]、[← ]键变更后

的值为100.0以下时，则范围自动变为0.1-100.0。

 使用上的注意事项

	 范围的上限值变更为比滑块的现在值小的范围时，滑块的现在值将被

强制设定为其上限值。例如，比例带设定为 150.0% 时，如果滑块的

范围变更为 0.1-100.0，则比例带将被强制变更为 100.0%。

变更了滑块的范围时，滑块的最小移动量 ( 滑块按 1 个单位移动时增减的值 )
也按下表自动变更。

滑块 滑块范围最大值变更按钮
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比例带 (P)
设定范围 0.1 ～ 100.0 0.1 ～ 200.0 0.1 ～ 500.0 0.1 ～ 1600.0

最小移动量 0.5 1.0 5.0 10.0
设定范围 0.1 ～ 3200.0
最小移动量 20.0

积分时间 (I)/微分时间 (D)(无控制参数小数点的场合 )
设定范围 0 ～ 100 0 ～ 200 0 ～ 500 0 ～ 1000

最小移动量 1 1 5 5
设定范围 0 ～ 2000 0 ～ 5000 0 ～ 16000 0 ～ 32000
最小移动量 10 25 100 200

积分时间 (I)/微分时间 (D)(控制参数小数点1位的场合 )
设定范围 0.0 ～ 100.0 0.0 ～ 200.0 0.0 ～ 500.0 0.0 ～ 1600.0

最小移动量 0.5 1.0 5.0 10.0
设定范围 0.0 ～ 3200.0
最小移动量 20.0

积分时间 (I)/微分时间 (D)(控制参数小数点2位的场合 )
设定范围 0.00 ～ 10.00 0.00 ～ 20.00 0.00 ～ 50.00 0.00 ～ 160.00

最小移动量 0.05 0.10 0.50 1.00
设定范围 0.00 ～ 320.00
最小移动量 20.0

■ 参数选项卡

用参数选项卡可变更各种参数的值。有 [Control]、[Other]、[Disturbance setting]
的3种选项卡。

● 控制选项卡

可设定PID值或设定值等与控制相关的参数。

● 其它选项卡

可设定与SP斜坡相关的参数及MV变化率限幅、仿真期间。
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● 干扰设定选项卡

可设定与干扰的仿真相关的参数。

 参 考
 变更参数的方法如下。

 从键盘直接输入数值

  通过 [→ ]、[← ]键进行数值变更 
使用 [→ ]、[← ]键时，值可按最小单位 (小数点1位的场合为0.1)增减。

在按 [SHIFT]键的同时按 [→ ]、[← ]键，值的增减量可按10倍变化。

 使用上的注意事项

 各参数的含义请参阅

计装网络模块NX调节器模块NX-D15/25/35使用说明书　功能

说明篇　CP-SP-1308C。

 PID仿真器不支持SP组、PID组。

  PID仿真器不支持手动复位值的变更。手动复位值使用执行趋势数据

收集时的调节器的值。
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■ 自整定

对控制对象模型执行自整定、自动计算出PID值。

  请点击  图标。 
选择 [Simulation] → [Auto-tuning... ]也可执行相同的处理。另外，也可按

[CTRL]＋ [T]键执行相同的处理。

≫显示 [Auto-tuning]对话框。

自整定与调节器本体相同，可选择以下3种。

0 : 通常 (标准的控制特性 ) 
1 : 即应 (迅速反应干扰的控制特性 ) 
2 : 稳定 (PV上下波动小的控制特性 )

显示 [Auto-tuning]对话框时，PID仿真器自动选择最佳方式并显示

「Recommended」。点击 [OK]按钮后执行自整定、变更PID值、更新仿真曲线。

■ 备忘录

参数选项卡 ( [Control]选项卡、[Other]选项卡、[Disturbance setting]选项卡 )
的全部的参数作为备忘录保存。备忘录可保存最多256个。

● 备忘录的追加

把备忘录追加到清单中。

  请点击  图标。 
选择菜单的 [Options]→ [Add current parameters to memo...]也可执行相同

的处理。另外，也可按 [CTRL]＋ [A]键执行相同的处理。

≫显示 [Add a memo]对话框。

请在备忘录上输入名称、点击 [OK]按钮。备忘录被追加。

8 - 4 方便的功能
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≫�设定的名称与既有的备忘录相同的场合，将显示 [Confirmation]信息。

请点击 [Yes]按钮。

 参 考
  要替换既有的备忘录的场合，可在 [Add a memo]对话框上从下拉菜

单中选择要替换的备忘录的名称。

● 备忘录的删除

请删除现在选择的备忘录。

  请点击  图标。 
选择菜单的 [Options] → [Delete selected memo]也可执行相同的处理。

≫显示 [Confirmation]对话框。

请点击 [Yes]按钮。

● 备忘录名的变更

变更现在选择的备忘录的名称。

   请选择菜单的 [Options] → [Rename selected memo...]。

≫显示 [Rename]对话框。

输入新的名称、点击 [OK]按钮。
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● 保存的备忘录的选择

从备忘录的一览选择备忘录、恢复参数。

从工具栏的下拉菜单中选择备忘录的名称。

■ 仿真曲线的设定

● PV轴的自动调整

自动调整仿真曲线的PV轴 (左Y轴 )的上限值、下限值以便更容易查看过程

值的曲线。

  请点击  图标。 
选择菜单的 [Graph] → [Auto-adjustment of PV Axis]也执行相同的处理。

另外，也可按 [CTRL]＋ [J]键执行相同的处理。

● Y轴的调整

设定仿真曲线的 PV 轴 ( 左 Y 轴 )、MV 轴 ( 右 Y 轴 ) 的显示范围。

  请点击  图标。 
选择菜单的 [Graph] → [Adjustment of Y axes] 也执行相同的处理。另外，

按 [CTRL]＋ [Y]键也执行相同的处理。

≫显示 [Y axis adjustment]对话框。

请输入各轴显示的最大值 /最小值、点击 [OK]按钮。

按 [Default]按钮后，PV轴、MV轴的最大值、最小值设定为初始值。各初始

值是PV轴的最小值为PV量程的下限值、最大值为PV量程的上限值、MV轴

的最小值为操作量的设定下限 (-10%)、最大值为操作量的设定上限 (110％ )。
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● 系列的颜色的变更

变更仿真曲线的系列的颜色。

 请选择菜单的 [Graph] → [Properties]。

≫显示 [Properties]对话框。

点击各系列名右侧的按钮后显示 [Color]对话框。

在此决定颜色，点击 [Properties]对话框的 [OK]按钮后，仿真曲线的系列

的颜色被变更。点击 [Properties]对话框的的 [Default]按钮后，各系列的颜

色被设定为初始值。
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■ 参数读出 /写入

从调节器读出或向调节器写入PID值等参数。

  请点击  图标。 
选择菜单的 [Options] → [Parameters read/write ]也执行同样的处理。另外，

按 [CTRL]＋ [P]键也执行同样的处理。

≫显示 [Parameter read/write]对话框。

选择PID组点击 [< Write]按钮后，PID仿真器的方格的参数写入到NX的方格

中。点击 [Read >]按钮后，NX的方格的参数写入到PID仿真器的方格中。点

击 [OK]按钮后，NX的方格中写入的参数向调节器送信、PID仿真器的方格

中写入的参数读入到PID仿真器中。参数可写入任意组的任意的PID组中。 
「PID group」 组合框可变更PID组、 「Loop Number」 组合框可变更回路编号。

 使用上的注意事项

  PID仿真器侧及NX侧的微分时间积分时间小数点位置不同的场合，不

可进行写入 /读出。

  直接启动PID仿真器的场合不可使用本功能。关于启动方法，请参阅 
 8-2 PID仿真器的启动　(8-4页 )。

 使用本功能前，请确认PC与调节器模块的连接。

  综合监视停止中不可执行设定的参数的写入。要求执行写入时请先启

动综合监视。

 设定值 (SP)或斜坡的设定不可读出 /写入。

PID组选择组合框 回路号选择组合框

         NX的方格 PID仿真的方格



8-18

第 8 章 PID 仿真器

对使用从控制对象收集的操作量 (MV) 及过程值 (PV) 的趋势数据创建 PID 控制仿真使用的控制对象模型的

方法进行说明。趋势数据的收集方法请参阅

 8-6 趋势数据收集方法　(8-23 页 )。

■ 模型创建向导

PID仿真器通过「Model creation wizard」，可仅进行简单的操作即可创建控

制对象模型。

● 启动方法

模型创建向导有以下3种启动方法

  在 [Welcome to the PID simulator]对话框上选择 [Model from a data file 
(*.pdn)]

  在 [Welcome to the PID simulator]对话框上选择 [Model from trend data]
  选择菜单的 [File] → [Create model from data file]

在 [Welcome to the PID simulator]对话框上选择 [Model from trend data]启
动的场合，是从综合监视直接读取趋势数据启动模型创建向导。其它的方法

是读取数据文件，所以显示 [Open data file]对话框。

输入pdn文件的名称、点击 [Open]按钮后，启动模型创建向导。

 参 考
  关于 [Welcome to the PID simulator]对话框，请参阅 

 8-2 PID仿真器的启动　(8-4页 )。

8 - 5 控制对象模型创建



8-19

第 8 章 PID 仿真器

● 启动画面

模型创建向导启动后显示以下的画面。

在该画面上，可对回路的选择、趋势数据的确认、参数进行确认。对趋势数

据确认曲线可进行显示区域的缩放或移动。缩放 /移动方法与主窗口的仿真

曲线相同。

详细内容请参阅

 8-3 PID仿真器的画面　(8-6页 )。缩放的解除也可通过点击 [Undo zoom]
按钮或按 [CTRL]＋ [U]键执行。

趋势数据或参数的确认完成后请点击 [Next]按钮。

● 模型创建数据选择画面

在该画面上选择从趋势数据创建模型时要使用的范围。

趋势数据的选择方法有2种，一种是在范围选择用文本框中输入范围，另一

种是通过鼠标用趋势数据选择曲线直接指定范围。

趋 势 数 据 检 查 曲 线 回路号选择组合框

缩放 (数据选择) 取消按钮  模型参数显示方格

趋势数据选择曲线

范围选择文本框 缩放 (数据选择) 取消按钮
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● 范围选择用文本框

在范围选择用文本框中输入作为范围始点的时间、终点的时间，可选择趋势

数据的范围。

● 趋势数据选择曲线

在要选择的范围的左端处点击鼠标的左键后，将显示表示范围左端的直线。

在该状态下把鼠标向右方向移动后，将显示表示范围右端的直线，把该直线

移动到范围的右端并松开左键。

要解除选择时，在曲线上的任意的点处按鼠标左键并保持按下状态，向左方

向移动并在适当的位置松开鼠标的左键。也可点击 [Undo zoom]按钮或按 [CTRL]
＋ [U]键解除选择。

趋势数据的选择完成后请点击 [Next]按钮。

 使用上的注意事项

  选择趋势数据时，最初的10个请在过程值 (PV)、操作量 (MV)均稳定

在一定值的状态下选择。

详细内容请参阅 
 8-6　趋势数据收集方法　(8-23页 )。
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● 模型创建画面

画面显示后，自动开始创建模型。

点击 [Executing...]对话框的 [Cancel]按钮后，可中断模型创建。

 使用上的注意事项

  未完成一次模型创建的场合，当取消模型创建时，[Completed]按钮无

效。这种场合请点击 [Create new model]按钮、完成模型创建。

● 模型创建完成画面

模型创建完成后，显示以下画面。可在该画面上确认创建的控制对象模型。

模型检查曲线 模型创建开始按钮

"取消缩放" 按钮模型分支显示区域 模型参数显示方格
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● 模型确认曲线

显示从数据文件读入的过程值及操作量的趋势数据以及当输入操作量时的控

制对象模型的输出。曲线可在任意的场所进行缩放。缩放 /解除缩放的方法

与主窗口的仿真曲线相同。

详细内容请参阅

 8-3　PID仿真器的画面　(8-6页)。另外，缩放的解除可点击 [Undo zoom]
按钮的或按 [CTRL]＋ [U]键。

● 模型乘离率显示区域

表示模型乖离度（表示过程值的趋势数据与模型输出的趋势数据有多大误差

的值）。该值越小，控制对象模型约能重现装置的特性。乖离度大致按以下

分类。

 0 ～ 0.25 恰当的模型

 0.25 ～ 1.00 稍微不完全的模型

 1.00 ～ 不完全的模型

不完全的模型的场合，PID控制仿真的结果与实际机器的控制结果有可能差

别大。

 使用上的注意事项

  模型乖離度只是大约值，并不能保证控制对象模型的正确性或PID控

制仿真的结果的正确性。

● 模型参数表示方格

表示控制对象模型的参数。该控制对象模型用传递函数表述如下。

● 模型创建按钮

可执行模型创建。在模型创建中断的场合或把现在的模型参数作为初始值再

次创建模型的场合使用。

G (s) =
Kp · e –Lp · s

(1+T1· s) (1+T2· s)

Kp : Gain
T1 : Primary time constant
T2

: Secondary time constant
Lp : Dead time
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■ 概　要

要创建控制对象模型时，需要以下的操作量及过程值的趋势数据。

 按设定值变更的步应答

 按操作量变更的步应答

在此对收集按设定值变更的步应答动作时的趋势数据的步骤进行说明。趋势

数据收集的步骤如下。

 步骤1　决定初始过程值及设定值

 步骤2　使过程值、操作量稳定

 步骤3　开始趋势数据收集

 步骤4　开始步应答

 步骤5　结束趋势数据收集

 步骤6　保存收集的趋势数据

趋势数据收集中使用SLP-NX的综合监视。综合监视的详细的使用方法请参

阅 
 第7章　综合监视。

  使用上的注意事项

  请按趋势数据收集的步骤慎重执行。如果趋势数据收集不正确，则有

可能不能取得与仿真的控制结果相同的结果。

  SLP-NX的综合监视超过了由趋势数据数指定的个数 (既定值10000
个、采样周期1秒时为10000秒 )时，则创建别的文件、开始新的趋势

数据收集。这种场合，旧文件中保存的趋势数据不能作为PID仿真器

用的数据文件保存，敬请注意。

8 - 6 趋势数据的收集方法
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■ 步骤1　决定初始过程值及设定值

如下图所示，收集的趋势数据中必须包含过程值及操作量在一定值附近稳定

的状态以及包含随设定值变更的步应答动作。

为收集这样的趋势数据而需做的准备工作是决定满足以下条件的初始过程值

(稳定的状态的过程值 )及步应答设定值。

● 步应答设定值

当步应答设定值没有限制的场合，请设置为实际运行时使用的值。

  使用上的注意事项

  模型创建用的趋势数据的设定值与实际运行时的设定值不同时，有不

能获取与PID控制仿真相同结果的情况。

● 初始过程值

请使初始过程值满足以下的条件。

  连续输出操作量比0.0%大的值、使用能够稳定的初始过程值。

  过程值为温度的场合，请使用比环境温度高的初始过程值。

 装置 为逆动作 (加热动作 )的场合 
初始过程值≦步应答设定值

正动 作 (冷却动作 )的场合 
初始过程值≧步应答设定值。

SP PV MV

步应答SP

初始 PV
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 初始过程 值与步应答设定值之差不能过小、

｜步应答设定值－初始过程值｜

≧ (PV量程的5%)
  请按此大约值决定初始过程值。例如，步应答设定值200、PV量程 -200 ～ +400
的场合，请把初始过程值置为比170小的值。

  传感器或操作端有不感带 (传感器或操作端正常时不动作的范围 )的场合，

设定不让过程值或操作量进入该范围的初始过程值。

■ 步骤2　使过程值、操作量稳定

在由步骤1决定的初始过程值附近使过程值及操作量稳定。

● 稳定的状态的大约值

稳定的状态是指过程值与操作量的偏差进入某个范围以内。如下图所示，稳

定的大约值是把操作量的偏差控制在10%以下、过程值的偏差控制在PV量

程的1%以下 (PV量程 -200 ～ +400时为6以下 )。

以下的趋势数据不恰当。

 过程值、操作量都有大的偏差

 过程值几乎为一定值、仅操作量有大的偏差 (10%以上 )

PV (与SP匹配)

MV

1% ≧ 

10%≧  
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过程值、操作量都有大的偏差

过程值几乎是一定值，仅操作量有偏差。

● 为了使过程值及操作量稳定

过程值及操作量不稳定的场合，请尝试以下方法。

 把比例带变大 (现在值的2倍～ 3倍 )。

 把积分时间变大 (现在值的2倍～ 3倍 )。

 以上两者都处理。

仍不能稳定的场合，请把回路模式切换成MANUAL模式使其稳定。如过程

值及操作量按下图所示变化时，请把此时的操作量设定为操作量变化的上限

及下限的中心附近的值。

PV

MV

PV (与SP匹配)
MV
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  使用上的注意事项

  请把回路模式切换成MANUAL模式后起到过程值变为稳定为止的时间

设定足够长。

  通过把回路模式切换成MANUAL模式，即使过程值与初始过程值不同，

也不会产生问题，但当不满足步骤1的初始过程值的条件的场合，请变

更操作量。

■ 步骤3　开始趋势数据收集

过程值及操作量稳定后，选择综合监视的菜单的 [Monitor] → [Start] ，开始

趋势数据的收集。监视开始后，在步应答开始前请收集10个以上如下图所示

的过程值及操作量处于稳定状态时的数据 (如果采样周期为1秒，则10秒钟 )。

PV

MV

 
手动模式的
     MV

10个以上 稳定的数据
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■ 步骤4　开始步应答

稳定的过程值及操作量的趋势数据收集到10点以上后，开始步应答。步应

答的开始方法因现在的模式而异。

● AUTO模式的场合

1. 根据需要变更PID值。

2. 把调节器的设定值变更为步应答设定值。

● MANUAL模式的场合

1. 根据需要变更PID值。

2.   把调节器的设定值变更成与现在的过程值相同的值。例如，现在的过程值

为60.5℃时，把调节器的设定值变更为60.5。

3. 从MANUAL模式变更为AUTO模式。

4. 把调节器的设定值变更为步应答设定值。

 参 考
	 上述操作时，从变更PID值后起到变更设定值的期间，过程值有不稳

定的情况，如果步骤3已经完成则不会产生问题。

  使用上的注意事项

  有需要解决问题的PID值的场合，请使用该PID值执行步应答。
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■ 步骤5　结束趋势数据收集

步应答结束后关闭趋势数据收集。结束的时间点因步应答的结果而异。

● 有超调的场合

如下图所示，按从设定值变更时起到过程值到达设定值为止的时间的3倍左

右进行收集后结束。

● 有振荡的场合

与由超调时相同，按从设定值变更时起到过程值到达设定值为止的时间的3
倍左右进行收集后结束。
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● 达到设定值慢的场合

如下图所示，按从设定值变更时起到过程值开始向设定值变化时的过程值的

切线与设定值的交点的时间的3倍左右收集后结束。

■ 步骤6　保存收集的趋势数据

收集的趋势数据按PID仿真器专用的数据文件形式保存。从综合监视的监视

树的 「Module configuration」，在执行仿真的调节器模块或在回路上打开右

键菜单。

选择 [Save to a data file]后，打开 [Save As] 对话框。
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在此输入文件名、点击 [Save]按钮、保存数据文件。

■ 步骤的归纳

下表是趋势数据收集方法的步骤3 ～ 6的归纳。

趋势数据收集步骤
综合监视 / 数值监视的操作

AUTO 模式 MANUAL 模式

趋势数据收集开始
综合监视开始 综合监视开始

正在收集10个稳定数据 SP = 现在的过程值

如有需要变更PID值.

开始步应答
如有需要变更PID值

SP = 步应答设定值
MANUAL →  AUTO
SP = 步应答设定值

步应答中

趋势数据收集结束
综合监视停止
数据的保存

综合监视停止

数据的保存
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■ PID控制仿真错误信息

分　类 信　息 内　容 处理方法

功能错误 自整定失败 自整定失败、不能计算
PID值

请手动调整PID值

不能追加到备忘录中 超过了备忘录的最大保
存个数

请删除不要的备忘录

内部处理错误 由于内存不足而处理失
败

本体内存不足 请关闭未使用的应用，
增大内存空余容量

■ 数据文件错误

分　类 信　息 内　容 处理方法

数据保存错误 数据需要20个以上 为创建pdn文件而未收
集足够个数的趋势数据

请收集20个以上的趋
势数据

未收集操作量 (MV)或
过程值 (PV)的数据

收集的趋势数据中不含
操作量或过程值的趋势
数据

请收集操作量及过程值
两者的趋势数据

数据读入错误 趋势数据的内容全部是
相同的值

过程值或操作量的趋势
数据全部相同

关于趋势数据收集，请
参阅 8-6 趋势数据
收集 方法　(8-23页 )

8 - 7 错误信息
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■ PC的电源管理

[PC Power Management]( 省电功能 ) 如果设定有 [Turn Off Monitor] 时，则

综合监视时有可能产生异常动作。

监视中请勿设定 [Turn Off Monitor]。
另外，也不要把硬盘设为休止状态或待机状态。

■ 红外线设备

PC 中安装有红外线设备，设定 [Use Infrared Communication] 时，综合监

视有可能会产生异常动作。

监视中请勿设定 [Use Infrared Communication]。

■ 实际模块构成扫描使用时的限制

执行实际模块构成扫描时，NX 的模块与 NX 以外的外部机器不经过通讯

BOX 连接的场合，则每隔 2msec 向其外部网络中发送诊断帧 ( 以太组播帧 )，
约持续 6 秒钟的发送时间。

如果外部网络上存在本机以外的不能处理这种频率的帧的场合，请务必在

其间设置通讯 BOX。

■ 实际模块构成扫描使用时的限制 (IP地址 )
用编程器以外的手段对模块设定了不正确的地址的场合，则实际模块构成

扫描可不能执行的情况。

请用串口连接每单个模块，再次进行实际模块构成扫描及 IP 地址设定。

■ Windows防火墙

尽管与网络连接正确而不能进行实际模块构成扫描的场合，可能是 Windows
防火墙中没有正确登录编程器。

这种情况下，在 Windows 画面上选择 [Control Panel] → [Security Center] 
→ [Windows Firewall]，点击 [Windows Firewall] 对话框的 [Exceptions] 选
项卡，从 [Add Program] 按钮登录编程器的安装文件夹下的 [ICServer.exe]
文件名。

■ 字体

( 版本 2 之前的制限事项 )
Windows XP 的环境下，项目保存的路径显示上路径的区分符有显示 [¥] 或 [\]
的情况。

这种场合请把安装编程器的 PC 与互联网连接，选择 [Start] → [All Program] 
→ [SLP] → [Meiryo download]，下载 Meiryo 字体并安装。

即使不安装 Meiryo 字体也不会影响其它的动作。

第 9 章 使用上的限制事项及注意事项
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■ 禁止使用压缩文件夹

请勿使用 Windows 的压缩文件夹。可能会引起编程器的动作异常。

■ 限制数一览

数　据 单　位 限制数

项目名、映射名 文字数 20 个文字以内

子系统名、节点名、串名 字节数 16 字节以内

注释 文字数 255 文字

串 ID、子系统 ID、节点 ID 范围 1 ～ 65535

项目模块数 台数 31 台以下

工作组模块数 台数 31 台以下

同时趋势监视数据数 数据数 256 以下

1 日志文件、绘图样本数 ( 固定样 
本数 )

样本数 100 ～ 60000 以下 *1

监视周期 毫秒 400msec 以上 *2

最小通讯间隔 毫秒 0 ～ 1000 *3

超时 毫秒 10 ～ 10000 *3

再送次数 次数 0 ～ 10 *3

曲线更新周期 监视周期的 N 倍 1 以上

报警周期 毫秒 监视周期以上

用户监视登录数 数据数 每 1 格 64 个

用户趋势登录数 数据数 每 1 组 32 个

趋势监视同时显示数 趋势组数 8 组

每工作组的管理员模块数 台数 1 台

*1 :   达到上限值后，日志文件移到别的文件，曲线显示被清除。根据 PC 的

负荷及模块台数等环境条件，有达不到限制数上限的情况。

*2 :   根据 PC 负荷及模块台数等环境条件，有不能按监视周期的设定进行收

集的情况。

根据模块台数，推荐以下的监视周期的设定。

推荐值 :
（以太通讯的场合）

1 台 : 400msec
2 ～ 4 台 : 1sec
5 台～ 16 台 : 2sec
17 台～ : 4sec

（编程器插口通讯的场合）

2000msec

*3 : 编程器通讯 ( 以太、串行 ) 相关的设定值。

( 参数读写的超时值 以太 : 50sec、串行 : 40sec 固定 )



9-3

第 9 章 使用上的限制及注意事項

■ 禁止停止SQL Server的服务

编程器动作中需要 SQL Server(SQLEXPRESS) 服务处于动作状态。请勿停

止 SQLServer(SQLEXPRESS) 的服务。

安装后在 PC 启动时会自动开始，请勿改变本设定。

■ 故障状态的模块在综合监视下的监视

正常状态的模块与故障状态 ( 与编程器不能通讯的状态 ) 的模块混合存在的

场合，通过 [Universal Monitor] 窗口的 [Trend group] 窗口的设定，把故障

状态的模块设定为不作为数据收集的对象。不能通讯的状态下如果有收集对

象存在时会产生超时等待，会对正常模块的通讯 ( 监视 ) 产生影响。但是，

[Universal Monitor] 窗口的状态栏上，通讯状态会交替显示为「In Progress」
与「Interrupted」。

■ 与防病毒软件的并存

PC 中安装了具有个人防火墙等功能的安全软件时，编程器的以太通讯将被

限制，有可能不能对模块的参数进行读出 / 写入及用综合监视不能进行监视。

使用编程器的场合，如果不把 Windows 的防火墙功能置为无效或停止安全

软件的动作，则可能会发生不可预测的错误。

另外，把防火墙功能置为无效或把停止安全软件运行后，PC 有感染病毒

的风险。

请在判断风险的基础上，由客户负责实施。

本公司对这种设定变更造成的损失不负责任。

■ 串连接的环形通讯用通讯BOX
通过编程器的实际模块构成扫描，串连接的环形通讯用通讯 BOX 显示在

[Module configuration] 画面上。

串连接的环形通讯以外的通讯 BOX 或终端适配器、通讯适配器不能在

[Module configuration] 画面上显示。

■ 使用保存的项目的实际模块通讯设定时的写入错误

获取模块构成信息的项目读入实机具有的 MAC 地址信息。有多套同一构成

模块存在的场合，当要写入实际模块通讯设定的场合或由于模块故障而进行

模块更换的场合，请执行 [Actual module configuration] 窗口的实际模块构

成扫描。
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■ 在PC中存在多个具有管理者权限的用户 ID的场合

在 PC 中存在多个具有管理者权限 (Administrators 组 ) 的用户 ID 的场合，

在登录 PC 时，切换管理者权限的用户 ID，执行编程器后有显示错误的情况。

错误信息例：新建失败 (1)
打开系统数据库失败 (401)
连接数据库失败 (411)

多个具有管理者权限的用户 ID 存在的场合，请固定登录 PC 的管理者权限

的用户 ID 后再使用编程器。

■ PC中存在多个同一类型的网络接口卡的场合

( 版本 2 之前的制限事项 )
当 PC 中装有多个同一类型的网络接口卡的场合或网络接口卡有多个端口的

场合，不能使用编程器。

■ SLP-NX启动中禁止网络设定变更

在 SLP-NX 启动期间，请勿变更 IP 地址等的 PC 的网络设定。

■ 禁止向SLP-NX日志文件夹制作文件

通过 SLP-NX 的操作，在 SLP-NX 安装文件夹中日志文件夹被作成。

作成后经过 7 天，由 SLP-NX 删除日志文件夹。

自动删除处理有出错的情况，请勿在 SLP-NX 日志文件夹中手动制作成文件。

■ 安装目标文件夹的访问权

作为安装目标选择的文件夹的访问权不恰当的场合，SLP-NX 安装程序事先

进行检查，提示不要安装在其它文件夹中。

■ 模块间数据传送功能或多回路协调控制使用中变更模块的 IP地址等

当模块间数据传送功能、多回路协调控制设定在模块中后，需要变更 IP 地址、

节点 ID、工作组 ID、串 ID 的通讯设定的场合，要注意以下的注意事項。

模块间数据传送功能、多回路协调控制制作有与 IP 地址、节点 ID、工作组

ID、串 ID 联动的内部的参数。

通讯设定写入模块中后，请务必实施参数的写入。

使用模块间数据传送功能、多回路协调控制功能的场合，当 IP 地址、节点

ID、工作组 ID、串 ID 变更后，请继续把通讯设定向模块写入、把参数向模

块写入。参数写入前执行参数读出时，模块间数据传送功能、多回路协调功

能的设定信息会发生不整合，有产生意图不明的动作的情况。
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发生不整合的场合，协调控制在参当数写入时会显示「The corresponding 
module does not exist in the project database」、在监视时会显示「Cannot 
monitor Control Group 1 because there is inconsistent information in the 
control group settings of cooperative control」的信息。模块间数据传送的

数据检查、参数写入时会显示「The destination module cannot be found for 
a communication setting. Do you want to clear the setting?」的信息。显示

这些信息的场合，请重新进行协调控制、模块间数据传送的设定、再次向模

块中写入参数。

根据需要，变更通讯设定前读出模块的设定。

■ 模块更换等时的注意点

由于模块故障等更换了模块后的写入时，可能会出现通讯故障。

这是由于PC具有的MAC地址与 IP地址的对应有数分钟不更新造成的。更

换模块的场合，请放置数分钟时间后在执行。

另外，更换了模块的场合，请执行实际模块构成扫描，把实际模块的通讯及

各种参数设定成与更换前相同的状态。

■ 综合监视的小数点位置

综合监视上显示调节器模块ROM版本为1.xx的值时，数值数据固定为小数

点以下2位。

调节器模块ROM版本为2.00以后的场合，数值数据按小数点位置的设定显

示。

■ 多回路协调控制使用的调节器模块的回路数变更

请勿变更多回路协调控制所使用的调节器模块的回路数。

需要变更回路数的场合，变更回路数后请对多回路协调控制的控制组构成重

新设定，对管理员模块及调节器模块执行参数的写入。

■ 默认网关的设定相关的注意事项

网络配置设定请勿把默认网关设定为2个以上的网络接口卡。任一网络接口

卡设定为 「Obtain an IP address automatically」(Windows的标准设定 )的
场合，请勿把其它网络接口卡设定为默认网关。



9-6

第 9 章 使用上的限制及注意事項

■ 与网络切换软件的共享

如果PC中安装了具有 IP地址设定的保存 切换等功能的网络切换软件，则

会限制通过编程器进行地址的设定变更，有不能读出模块的参数、不能向模

块写入参数的情况。使用编程器的场合，如果不临时关闭网络切换软件，则

有可能会发生不可预测的错误。

■ Windows 7的文字大小的设定相关的注意事项

通过Windows 7的控制面板设定显示的场合，当选择中或大字体时，根据要

显示的画面，有不能正常显示的情况 (右端或下端在中途被切断 )。这种场合，

请设定为 「小 - 100％」 后使用编程器。

■ 有关使用多根USB编程器电缆

多根USB编程器电缆连接的场合，在画面上不能判断连接对象的USB电缆。

多根USB编程器电缆连接的编程器不能启动的场合，需要注意采取切换连

接等措施。

■ 专业版 (PID仿真器 )安装在同一PC中

SLP-NX(以后称为通常版 )与SLP-NX专业版 (以后称为专业版 )不能安装

在同一PC中。要把专业版安装到已经安装了通常版的PC中的场合或把普

通版安装到已经安装了专业版的PC中的场合，请先通过 [Add or Remove 
Programs]卸载后在安装。
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项目  把模块的参数设定等编程器使用的单位称为项目。

工作组  把编程器使用的模块的集合称为工作组，设定唯一的编号作为工作组 ID。

是模块的逻辑集合。

串  物理的链路上连接的模块的集合称为串，设定唯一的编号作为串 ID。

经过通讯 BOX 可分割为多个串。

实际模块通讯设定  对实际存在的模块进行 IP 地址等以太通讯设定或 RS-485 通讯设定，称

为通讯设定。

通过 [Actual module configuration] 窗口，执行模块通讯设定的扫描、写

入模块。

映射  把由工作组构成的模块与实际的模块相对应称为映射。

节点 ID  使用模块间数据传送功能时的模块的识别符。

参数  模块动作所必要的设定项目称为参数。

节点地址  工作组 ID 与节点 ID 组合后的 ID 称为节点地址。

项目文件 

* 型号只读出参数

 

参数  
基本 

输入输出 
SP 
事件
PID 
功能
其它 

通讯相关设定 
IP地址 
节点ID 
串ID 

(工作组ID) 
通讯设定(RS-485等)

模块定义
型号*、名称 

模块 
※调节器模块的场合 

参数 
基本 

输入输出
SP 
事件 
PID 
功能 
其它 

参数  
监视关联 
标准位/数值 

AUTO/MANUAL 
RUN/READY 

等 

实际模块通讯设定 
IP地址、节点ID、串ID 

(工作组ID)、通讯设定(RS-485等)

启动(启动对映射信息的综合监视)

实际模块构成窗口

SLP-NX 项目窗口 

趋势/数值/位显示/报警监视 

综合监视窗口 

模块定义 
型号、名称 

模块定义 
型号、名称 

写入 

打开 

实际模块 
构成扫描 

参数 
写入 

参数 
读出 

监视开始 

映射信息 
IP地址 
节点ID 
(串ID) 
工作组ID 

通信设定(RS-485等)

用户 

映射 扫描后 
覆盖 

保存 

附　录
附  -  1 用语解说
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附 - 2 ROM 版本履历

对 ROM 版本变更而追加的功能及规格变更的内容进行说明。

■  版本2.00(对应开始 : 2010年8月 )
● 追加的功能

内　容

NX-DX1/DX2支持的追加

NX-S11/S12/S21支持的追加

逻辑运算窗口的追加

折线图窗口的追加

综合监视的监视树窗口上 [Data sampling switchover]复选的追加

综合监视的监视树窗口上 [module communication status]图标的追加

由综合监视对管理员模块的日期时间设定变更功能追加

由综合监视对管理员模块的闪存ROM备份、恢复功能的追加

● 规格变更

内　容

变更为：NX-D15/D25的ROM版本为2.00以后的场合仅在必要时才通过参数写入进行复位动作

SQL Server 2008 Express变更为SQL Server 2008 Express SP1

■  版本3.00(对应开始 : 2011年12月 )
● 追加的功能

内　容

Windows 7对应

PID仿真器的追加

支持NX-D35的追加

NX-DY1/DY2支持的追加

模块间数据传送一览窗口的追加

模块版本处理的追加 (读取、写入、版本对照对话框的追加、从 [版本变更 ]对话框的在线变更 )
综合监视上追加逻辑运算监视窗口

● 规格变更

内　容

SQL Server 2008 Express SP1变更为SQL Server 2008 Express SP3

NX-D15/D25/DX1/DX2/S21的功能扩展对应

■  版本4.00(对应开始 : 2013年6月 )
● 追加的功能

内　容

支持NX-S01的追加

● 规格变更

内　容

NX-D15/D25/D35/S11/S12/S21的功能扩展对应
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附 录

附 - 3 模块版本与编程器的支持

各模块的模块版本与编程器支持的最新模块版本的关系如下。

NX-D15/D25 NX-D35 NX-DX1/DX2 NX-DY1/DY2 NX-S11/12/21

SLP-NX 版本1 1_0_0 不对应 不对应 不对应 不对应

SLP-NX 版本2 1_0_1 不对应 2_0_0 不对应 1_0_0

SLP-NX 版本3 1_0_3 1_0_3 2_0_1 1_0_0 1_0_2

SLP-NX 版本4 1_0_4 1_0_4 2_0_1 1_0_0 1_0_3

模块版本 1_0_0
1_0_1
1_0_2
1_0_3
1_0_4 *

1_0_3
1_0_4 *

2_0_0
2_0_1

1_0_0 1_0_0
1_0_1
1_0_2
1_0_3 *

*预定近期版本更新
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改订履历

印刷年月 资料编号 种　类 改订页 改订内容

11-05 CP-UM-5636C 初　版

14-03 第 2 版

5-7
1-4
1-10
1-12
5-3
5-6
5-7
5-20
6-6
6-8
6-9

6-14
6-46
7-2
7-31
9-4

附 -2
附 -3

根据机器追加（D35），功能追加的全面改订
变更公司名
有关环形异常时的动作使用上的注意事项的追加
使用上的注意事项的说明追加，删除
使用上的注意事项删除
①的说明变更
删除检测断线错误
●模块名称的参考追加
使用上的注意事项的说明追加
No21 的画面和说明删除
使用上的注意事项的说明追加
< 使用显示的已登录的配置的场合 > 的说明变更
< 新建配置的场合 >，< 不新建配置的场合 > 的说
明变更
参考的说明追加
使用上的注意事项的说明追加
参考的说明追加
使用上的注意事项的追加
■模块间数据传送功能或者多回路协调控制使用中
模块 IP 地址等的变更的说明变更
■版本 4.00 追加
版本 4.00 追加，模块版本变更



感谢您平素对本公司产品的惠爱。
参考综合产品目录订购本公司产品（系统机器、现场仪表、控制阀、控制设备）时，当报价表、合同、产品目录、规格书、
使用说明书等没有提及特别说明事项时，本公司将依照如下内容处理。请务必在确认以下内容后进行订货。

1．保修期与保修范围
1.1 保修期
本公司产品的保修期为购买后或者产品交付到指定地点后 1 年的期限。
但是，有偿修理产品的保修期为交付到指定地点后 3 个月的期限（保修期内，保修对象是有偿修理的部分，没有修
理的其他部分不作为保修对象。）
1.2 保修范围
在上述保修期内因本公司的责任引起所购产品故障的情况下，由本公司负责免费对故障产品进行维修或更换，客户
可以在购买处进行更换或要求修理。
但故障是由以下原因引起时，则不属于保修对象范围。

1.  由于客户处理或使用不当造成的故障。（不遵守产品目录、规格书、使用说明书等中记载的使用条件、环境、
注意事项等）

2. 非本公司产品原因造成的故障。
3.  非本公司或本公司委托人员进行的改装或修理造成的故障。
4. 因在本产品使用目的以外使用而造成的故障。
5. 限于产品交付当时的科学水平无法预测的故障。
6. 由于天灾、灾害、第三方的行为等造成的不属于本公司责任范围的故障。

另外，此处提及的保修仅指对本公司产品本身的保修，对于由本公司产品的故障而引发的损害，恕本公司不承担任
何赔偿责任。

2．适用性确认
对于本公司产品是否适用于客户的设备 •装置，请客户按照注意以下几点自己予以确认其适用性。

1. 客户的设备 •装置的适用限制、规格和法规。
2. 本资料中记载的应用实例仅作参考之用，请确认了设备 •装置的功能和安全性后再进行使用。
3. 本公司产品的可靠性、安全性是否适用于客户的设备 •装置要求的可靠性和安全性。

本公司致力于提高产品的质量与可靠性，但无法避免零部件 •设备通常会按一定概率发生的故障。
为了避免因本公司产品的原因造成客户的设备 •装置发生人身事故、火灾事故，使客户蒙受重大损失等，请
对设备 •装置实施误操作防止设计

(※1)、失效安全设计
(※2)

、火势蔓延防止设计等的安全设计，进行符合这些
可靠性和安全性的可行性研究。并且、能适用于故障避免

(※3)
、容错功能

(※4)
等所要求的可靠性。

※1. 误操作防止 (Fool Proof) 设计 : 人即便误操作也能保证安全的设计
※2. 失效安全 (Fail Safe) 设计 : 机械即便故障也能保证安全的设计
※3. 故障避免 (Fault Avoidance) : 使用高靠性的部件使得机械本身不发生故障的制作
※4. 容错功能 (Fault Tolerance) : 利用冗余技术

3．关于用途的注意事项、限制条件
除了部分适合产品 ( 原子能用限位开关 ) 外，请勿在原子能管理区域 ( 射线管理区域 ) 使用本产品。
请勿在医疗设备上使用。
由于是工业用产品。一般用户不要进行直接安装 •施工 •使用等。但部分产品可与面向一般用户的产品组装使用。
有这样要求的场合、请首先与本公司销售人员联系。
另外，将本产品用于以下场合时，请事先与本公司销售员商谈，确认产品目录、规格书、使用说明书等技术资料中
写明的详细规格和使用上的注意事项。
请客户自己负责对其设备 •装置进行误操作防止设计、失效安全设计、火势蔓延防止设计、故障避免、容错功能和
其他保护 •安全回路的设计及设置，以确保本公司产品万一出现故障或不适用现象时的可靠性和安全性。

1. 在产品目录、规格书、使用说明书等技术资料中没有记载的条件、环境下使用时。
2. 特定用途上的使用。

■ 原子能 •射线相关设备
【在原子能管理区域外使用时】【原子能用限位开关使用时】

■ 宇宙设备／海底设备
■ 运输设备

【铁路 •航空 •船舶 •车辆设备等】
■ 防灾 •防犯设备
■ 燃烧设备
■ 电热设备
■ 娱乐设备
■ 与收费直接有关的设备／用途

3. 电力、煤气、自来水等的供给系统、大规模通讯系统、交通 •航空管制系统等对可靠性有很高要求的设备
4. 受政府部门或各行业限制的设备
5. 危及人身财产的设备 •装置
6. 其他类似上述 1 ～ 5 项的要求高度可靠性、安全性的设备 •装置

4．长期使用的注意事项
如果长期使用本公司产品，使用了电子元件的产品和开关可能会由于绝缘不良和接触电阻增大而发热等，从而会出
现发烟、起火、漏电等产品自身安全上的问题。
如果规格书和使用说明书中没有特别注明，虽然视客户的设备 •装置的使用条件和使用环境而定 , 但请勿使用 10 年
以上。

5．推荐的更换周期
本公司产品中使用的继电器和开关等机构部件因开闭次数，有一定的磨耗寿命。同时，电解电容等电子元件会因使
用环境和使用条件，经长年使用而老化。
本公司产品在使用时，受到规格书和使用说明书上记载的继电器等的开闭规定次数、客户的设备 •装置的设计安全、

产品订购注意事项



产品订购和使用时的注意事项

感谢您对本公司产品的惠爱。 在参考本资料订购和使用本公司的产品（现场仪表、控制阀、控制设备）过程中，如果报价表、
合同、产品目录、规格书、使用说明书等没有提及特别说明事项时，本公司将依照以下条件处理。

1. 质保期与保修范围
1.1 质保期

本公司产品的质保期为购买后或者产品交付到指定地点后 1 年半的期限。
1.2 保修范围

在上述质保期内因本公司的责任引起所购产品故障的情况下，由本公司负责免费对故障产品进行维修或更换，客
户 可以在购买的地方进行更换或要求修理。 
但故障是由以下原因引起时，则不属于保修对象范围。

① 由于客户处理或使用不当造成的故障。 
（不遵守产品目录、规格书、使用说明书等中记载的使用条件、环境、 注意事项等）

② 非本公司产品原因造成的故障。
③ 非本公司或本公司委托人员进行的改装或修理造成的故障。
④ 因在本产品使用目的以外使用而造成的故障。
⑤ 限于产品交付当时的科学水平无法预测的故障。
⑥ 由于天灾、灾害、第叁方的行为等造成的不属于本公司责任范围的故障。

另外，此处提及的保修仅指对本公司产品本身的保修，对于由本公司产品的故障而引发的损害，恕本公司不承担
任何赔偿责任。

2. 适用性确认
对于本公司产品是否适用于客户的设备 •装置，请客户按照以下几点自己予以确认其适用性。

① 客户的设备 •装置的适用限制、规格和法规。
② 本资料中记载的应用实例仅作参考之用，请确认了设备 •装置的功能和安全性后再进行使用。
③ 本公司产品的可靠性、安全性是否适用于客户的设备 •装置要求的可靠性和安全性。

本公司致力于提高产品的质量与可靠性，但无法避免零部件 •设备通常会按一定概率发生的故障。为了
避免因本公司产品的原因造成客户的设备 •装置发生人身事故、火灾事故，使客户蒙受重大损失等，请
对设备 •装置进行误操作防止设计、故障安全设计、火势蔓延防止设计、安全设计等，以符合可靠性和
安全性上的要求。

3. 关于用途的注意事项、限制条件
除了部分适合产品 ( 原子能用限位开关 ) 外，请勿在原子能管理区域 ( 射线管理区域 ) 使用本产品。
请勿在医疗设备上使用。
另外，将本产品用于以下场合时，请事先与本公司销售员商谈，确认产品目录、规格书、使用说明书等技术资料
中写明的详细规格和使用上的注意事项。 请客户自己负责对其设备 •装置进行误操作防止设计、故障安全设计、
火势蔓延对策设计和其他保护 •安全回路的设计及设置，以确保本公司产品万一出现故障或不适用现象时的可靠
性和安全性。

① 在产品目录、规格书、使用说明书等技术资料中没有记载的条件、环境下使用时。
② 在特定用途中使用。

＊ 原子能 •射线相关设备 
【在原子能管理区域外使用时】　【原子能用限位开关使用时】
＊ 宇宙设备／海底设备
＊ 运输设备 
【铁路 •航空 •船舶 •车辆设备等】
＊ 防灾 •防犯设备
＊ 燃烧设备
＊ 电热设备
＊ 娱乐设备

③ 电力、煤气、自来水等的供给系统、大规模通讯系统、交通、航空管制系统等对可靠性有很高要求的设备
④ 受政府部门或各行业限制的设备
⑤ 危及人身和财产的设备 •装置
⑥ 其他类似上述①～⑤项的要求高度可靠性、安全性的设备 •装置

4. 长期使用的注意事项
如果长期使用本公司产品，使用了电子元件的产品和开关可能会由于绝缘不良和接触电阻增大而发热，从而出现
发烟、起火、漏电等产品自身安全上的问题。如果规格书和使用说明书中没有特别注明，虽然视客户的设备 •装
置的使用条件和使用环境而定 , 但请勿使用 10 年以上。

5. 推荐的更换周期
本公司产品中使用的继电器和开关等机构部件因开闭次数，有一定的磨耗寿命。同时，电解电容等电子元件会因
使用环境和使用条件，经长年使用而老化。本公司产品在使用时，受到规格书和使 用说明书上记载的继电器等的
开闭规定次数、客户的设备 •装置的设计安全系数的设定、使用条件 •使用环境的影响，但如果规格书或使用说
明书上没有特别注明，请在 5 ～ 10 年中更换产品。 另一方面，现场仪表 ( 压力计、流量计、液面计、调节阀等 )
也会随零部件的老化而使用寿命有限。对于长年使用后会 老化 , 使用寿命有限的零部件，本公司设定了推荐的更
换周期。请根据此推荐周期进行零部件的更换。

6. 其他注意事项
在使用本公司产品时，为了确保其质量、可靠性、安全性，请在仔细阅读了本公司各产品目录、规格书、使用说
明书等技术资料中规定的规格 ( 条件 •环境等 )、注意事项、危险、警告、注意的记载内容的基础上，予以严格遵守。

系数的设定、使用条件 •使用环境的影响，但如果规格书或使用说明书上没有特别注明，请在 5 ～ 10 年中更换产品。
另一方面，系统机器、现场仪表 ( 压力计、流量计、液面计、调节阀等 ) 也会随零部件的老化而使用寿命有限。
对于长年使用后会老化 , 使用寿命有限的零部件，本公司设定了推荐的更换周期。请根据此推荐周期进行零部件的
更换。

6．其他注意事项
在使用本公司产品时，为了确保其质量、可靠性、安全性，请在充分理解了本公司各产品目录、规格书、使用说明书
等技术资料中规定的规格 ( 条件 •环境等 )、注意事项、危险 •警告 •注意的记载内容的基础上，予以严格遵守。

7．规格的变更
本资料中记载内容由于产品改良或其他各种原因，可能会不预先通告就进行变更，敬请谅解。
您需要进行产品洽询或确认规格时，请与本公司的分公司、分店及营业所或附近的销售店联系。

8．产品、零部件的供应停止
本公司可能在没有预告的情况下中止产品的生产，敬请谅解。
对于可以修理的产品，制造中止后，原则上 5 年内提供维修服务。但是，因修理零部件库存已用完等原因，恕不予
以修理。系统机器、现场仪表的更换零部件如果出现同样的情况也将不予以修理。

9．服务范围
本公司的产品价格不包含技术人员的派遣费等服务费用，以下情况将另行收费。

1. 安装、调整、指导及会同试运行。
2. 维护检查、调整及修理。
3. 技术指导及技术培训。
4. 按客户指定条件进行的产品特别试验或特别检查。

在原子能管理区域 ( 射线管理区域 ) 以及被炸放射能与原子能管理区域的水准相当的场所，恕不提供上述服务。

AAS-511A-014-03



本资料所记内容如有变更恕不另行通知

阿自倍尔自控工程（上海）有限公司

总　部  上海市徐汇区柳州路 928 号百丽国际广场 12F 
邮编：200235 
电话：021-50905580   传真 ：021-50909625

阿自倍尔株式会社
Advanced Automation Company

2014年   3月 中文第 2 版 日文第 4 版
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